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About Accounts 
An account tracks the money spent or earned by business activities, such as the following:  

 Paying Bills 

 Receiving Payments 

 Generating Payroll Checks 

 Purchasing Supplies 

 Paying Rent 

The system uses default accounts for specific types of transactions. Account numbers to use for 

transactions are often automatically assigned from code and parameters forms. 

Customer order and purchase order lines use account numbers defined on the Product Codes 

form. An item is assigned a product code, and each product code has account numbers associated 

with it. When an item is sold, it is entered on a customer order line item. When the voucher is 

entered, the system credits the inventory account (taken from the product code) with the proper 

amount. 

Account Number Setup 

The account number is the central location for domestic currency amounts. The account number 

spans the system. Use the Chart of Accounts form to maintains all amounts for all parts of the 

system. Accounts must be set up for each of the following account types: 

 Assets 

 Liabilities 

 Owner's Equity 

 Revenue 

 Expenses 

You can also set up accounts for the following account types: 

 Allocation 

 Statistical: You can only use Statistical Accounts within Financial Statements, the Chart of 

Accounts form and the Chart of Accounts Budget and Plan form, where they are maintained. 

 Analytical: This account type is available only if you have selected the Analytical Ledger option 

on the General Parameters form. 

For each account, you can also determine whether unit codes will be used. The Unit Code tabs 

display valid unit codes. There are also utilities to help you add, copy, and remove ranges of unit 

codes. 
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We recommend that you set up all accounts to be the same number of digits. For example, if you will 

have accounts up to 999999, then all accounts should have 6 digits. This makes it easier to run 

utilities with account ranges. If your account numbers are different lengths, for example, 600 to 999 

and 100000 to 999999, and you enter the range 600 to 999999 in a utility, it will not process all 

accounts.  You must run the utility for the range 600 - 999 and again for 100000 - 999999. 

NOTE: Accounts can be deleted; however, you cannot delete accounts with data posted to them. 

You also cannot delete accounts that are referenced on any parameters form (for example, 

Purchasing Parameters or Accounts Payable Parameters), or any account record if it has any 

associated Unit Codes (1 through 4). 

Control Accounts 

On the Chart of Accounts form, select the Control Account check box to identify the current 

account as a control account. For more information about how control accounts are used, see About 

Control Accounts. 

Currency Translation Methods 

The currency translation method that is defined for each account is used to calculate exchange rates 

at different points in time; for example, at the time of a transaction posting, the end of an accounting 

period, or the average exchange rate within a period. They can only be updated for financial entities 

that report to other financial entities. 

NOTE: To comply with FASB 52 or GAAP standards, you must set the currency translation method 

to Average for revenue and expense accounts and End for asset and liability accounts. 
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About Control Accounts 
A control account is a general ledger account with a balance that reflects the total balances of 

related subsidiary ledger accounts. For example, many companies specify control accounts for these 

areas:  

 Accounts Payable 

 Accounts Receivable 

 Inventory 

 WIP 

 Vouchers Payable 

 Taxes 

 Bank Accounts  

 Service Order Labor, Miscellaneous and Deposit Accounts 

 Service Contract Accounts 

The balances in these control accounts serve as a crosscheck (control) of the accuracy of the 

associated subsidiary records.  

Control accounts are defined on the Chart of Accounts form and are generally only used on setup 

and parameter forms.  

Control accounts require some basic security. Users should not be able to manually post transaction 

amounts to a control account, which might cause the control account to become out of balance. If 

you select Secure Control Accounts on the General Parameters form, control account numbers 

are not available on drop-down lists on transaction forms like Purchase Orders or Job Material 

Transactions, and the account numbers also cannot be manually entered on transaction forms. 

However, a user who is assigned the group authorization Allow JE to Ctrl Acct (Allow Journal Entries 

to Control Accounts) can specify a control account for a manual journal entry in the General journal 

or a user-defined journal in the Journal Entries, Import Journal Entries, or Journal Builder forms. 

This allows the correction of Distribution journal entries that were incorrectly assigned to control 

accounts. 
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A/R A/P Offset Overview 
This feature allows you to have a batch of selected AR invoices and AP vouchers offset each other. 

This can be done only if you have a customer that is also a vendor. 

The functionality involves these forms: 

 Accounts Payable Parameters 

 Vendors 

 AR/AP Payment Offset 

 A/R Payments 

 A/R Payment Distributions 

 A/P Payments 

 A/P Payment Distributions 
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Accounts Payable (A/P) 

Accounts Payable Setup 

To set up your Accounts Payable system: 

1 Define A/P account numbers in the Chart of Accounts form.  

The account numbers are needed for all vouchers, adjustments, and payments in Accounts 

Payable. The Chart of Accounts must contain all Accounts Payable-related account numbers 

before transaction distributions and posting can occur. 

2 Define standard accounts for vouchers payable, duty, freight, and so on, using the Purchasing 

Parameters form. 

3 Set up inventory adjustment and variance accounts using the Product Codes form.  

The system uses the inventory adjustment account number for PO receiving transactions. The 

variance accounts are the accounts to which you want to assign variance expenses for a group 

of items identified by a product code. 

4 In the Accounts Payable Parameters form:  

 Specify vendor prefixes.  

The vendor prefix is used for alphanumeric numbering of vendors. The prefix is automatically 

added to the beginning of default vendor numbers for new vendors. If the user overrides the 

default value, the prefix is not applied. 

 Set up aging parameters, used as the default day range and titles on the AP Aging Report.  

Negative numbers represent days until due (the voucher will be due in the future). Positive 

numbers represent days past due. The Aging Report can be based on invoice date, due 

date, or discount date. 

 Set up default accounts for system-generated distributions. 

5 Set up a bank code for each vendor using the Bank Reconciliations form.  

Bank codes are defined for each bank your company does business with. Each bank code 

requires a general ledger account number. Several bank codes may use the same general 

ledger cash account. 

6 Set up shipping codes using the Ship Via Codes form.  

Ship via codes are required for vendors and are used to reference a method of shipment on an 

order. 

7 Set up billing terms codes using the Billing Terms form.  
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The Billing Terms Code displays on the Vendors or Multi-Site Vendors form and identifies the 

default billing terms. The default value can be overridden on the order. Billing terms calculate the 

due date, discount date and discount percent (if applicable) when the user provides the invoice 

date. 

8 Set up payment hold reason codes in the Payment Hold Reasons form.  

These codes explain reasons why vendor payment may be held. 

Accounts Payable Steps 

Accounts Payable (A/P) is the process you use to pay vendors for services and goods contracted for 

and delivered. Accounts Payable is closely linked to the purchasing function, where you create and 

receive purchase orders, purchase requisitions, blanket purchase orders, and line releases. 

The following events are the basic steps for Accounts Payable. See the linked help topics for more 

information. 

 Entering a Vendor Record 

 Creating A/P Vouchers or Adjustments 

 Distributing A/P Vouchers and Adjustments 

 Creating Recurring Vouchers 

 Generating Recurring Vouchers 

 Distributing Recurring Vouchers 

 Authorizing Vouchers 

 Printing and Posting Vouchers 

 Distributing Vendor Payments Manually 

 Generating Automatic Payments 

 Using Quick Payment Application 

 Printing and Posting Checks 

 Creating Manual Checks 

 Using Vendor Payment Hold 

 Logging Vendor Communications 

 Posting to the A/P Ledger Distribution Journal 

 Deleting A/P Posted Payments 

 Voiding Posted Checks 

 Activating/Deactivating Posted Transactions 

 Accounts Payable Year End Procedure 

 Purging Voucher History 
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Creating a Debit Memo for an A/P Transaction 

Debit memos for A/P transactions that originated in purchasing must be made in purchasing. So, if 

you currently have a voucher in A/P Posted Transactions, follow these steps: 

1 Open the Purchase Order Receiving form. 

2 Find the PO number. 

3 To add the PO line item, click Add. The system displays the Add Receiving Line form. 

4 Select the DR Return check box. 

5 Enter a positive quantity in the Receive Qty field. 

6 Leave the Reject Qty field at 0 (zero). 

7 Select a Reason Code. 

8 To add the line item, click Add and then click OK. The system returns you to the Purchase 

Order Receiving form. 

9 Select the line item you added and then, to receive it, click Receive.  

The system creates these journal entries: 

Inventory CR 

Vou/Pay DR 

10 Open the Generate AP Transactions form. The transaction is an adjustment. 

11 Select the correct voucher number to create the debit memo. The adjustment is then posted to 

A/P Vouchers and Adjustments. 

12 Click Generate. 

13 Open the A/P Vouchers and Adjustments form and post the negative adjustment to the A/P 

Ledger Distribution Journal.  

The system creates these journal entries: 

Vou/Pay CR 

A/P DR 

The debit will show as an adjustment on the A/P Posted Transactions Detail form. You can then 

match the Vouchers Payable Report to the General Ledger Vouchers Payable Account. 

CAUTION: Never enter a negative voucher on the A/P Vouchers and Adjustments form to create 

a debit memo for Accounts Payable. A debit memo can be tied by the system back to a voucher, but 

a voucher cannot be tied back to another voucher (regardless if one is negative). 
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Deleting A/P Posted Transactions 

To void and delete A/P payments you have already posted, use the Delete A/P Posted 

Transactions utility. This utility deletes all fully paid vouchers for the selected vendors. 

1 Specify information in these fields:  

 Through Date: The current system date displays by default, but you can change it to the last 

date that a voucher's invoice date can be deleted. If a voucher has a due date that falls after 

this date, it will not be deleted, regardless of whether the voucher has been paid. 

 Starting and Ending Vendor: Select the range of vendors whose transactions you want to 

delete. To delete transactions for all vendors, leave both these fields blank. 

 Purge Non A/P Payments: To delete all non-A/P payments for the selected vendors, select 

this check box. 

 Preview/Commit: To view the results of running the utility without saving the results in the 

database, select Preview. To save the results in the database, select Commit. 

2 To start the process, click Process. 

Electronic Funds Transfer Output Files 

About EFT Output Filenames 

If the EFT format is ALLEFT or BBMEFT, the filename is incremented each time the post process is 

run, so the file is never overwritten. 

If the EFT format is ABAFILE, CNAB, CPA,  NACHA or SEPA, the filename format is EFT + day + 

month + year + hour + minutes + seconds + the file extension (.aba, .dat or .xml), so the file is never 

overwritten. 

Format 

The format of the EFT output file depends on the value of the Accounts Payable Parameters EFT 

Format field. See the following topics for information about the file formats: 

 ABAFILE Format 

 ALLEFT Format 

 BBMEFT Format 

 CNAB Format 

 CPA Format 

 NACHA Format 

 SEPA Format 

 Zengin (JBA) EFT file 
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Generating DAS2 Declaration Forms 

To generate DAS2 declaration forms for applicable vendors:  

1 Open the Fiscal Reporting System Form Printing Report form. 

2 Specify this information:  

Display Report Header  

To display report headers on the report, select this check box. Report headers display on the first 

page of the report and list the parameters by which you generated the report.  

Current Year/Previous Year  

Select whether to print the report for the current or previous fiscal year.  

Fiscal Reporting System  

Select DAS2 for the starting and ending reporting systems.  

Vendor  

Specify the starting and ending vendors for which to run the report.  

3 To preview the report before printing, click Preview. Previews are processed as background 

tasks.  

4 To print the report, click Print.  

Report Content  

These are descriptions of derived fields on the report: 

NP: Nom and Prenom (Last name and First name)  

The value in the Contact field on the Vendors form is split based on the placement of the first “ “ 

(space) character. Everything before the space is considered the first name and placed in the 

Prenom field. Everything after the space is considered the last name and placed in the Nom 

field.  

No and Voie (Street number and Street name)  

The value in the Address [1] field on the Vendors form is split based on the placement of the first 

“ “ (space) character. Everything before the space is considered the street number and placed in 

the No field. Everything after the space is considered the street name and placed in the Voie 

field.  

Nat (Payment type), 4 – Montant (Amount), Nat (Payment type), and 5 – Montant (Amount)  

The payment types and amounts for boxes 4 and 5 come from invoices where the Fiscal 

Reporting System Type values of H, C, CO, R, JP, DA, DI, or AR have been specified. The 

transactions are summed by type.  

6 – Avantages en nature (Fringe benefits), V (Amount), and N (Code for the amount)  
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Box 6 shows the summed amount for all payments where the Fiscal Reporting System Type 

values of N – A, N – L, N – N, N – T, or N – V have been specified.  

7 – Indemnitès et remboursements (Reimbursements), I (Amount), and M (Code for the 

amount)  

Box 7 shows the summed amount for all payments where the Fiscal Reporting System Type 

values of M – F, M – P, or M – R are specified.  

8 – TVA nette sur droits d’auteur (VAT on copyrights)  

Box 8 shows the sum of the tax amount on payments where the Fiscal Reporting System Type 

value of DI (box 4 or 5 amount type) is specified.  

9 – Retenue à la source (domicile hors de France) (Withholding tax (place of residence 

outside of France)), M (Amount), and O (Code for the amount)  

Box 9 shows the sum of the tax amount on payments where the Fiscal Reporting System Type 

value of O – R or O – D is specified.  

Paying for Purchases with a Credit Card 

When you use a credit card to pay for a purchase from a vendor, you need to show the purchase 

under the Purchase Vendor. You also need to remit the payment to the Credit Card Vendor. 

To set up a credit card for this purpose, create a bank code for the credit card on the Bank 

Reconciliations form. On this form, the Cash Account for the credit card's bank code should be 

some type of clearing account. To activate the new bank code, add a bank reconciliation transaction 

Type for "Check." 

After you create the new bank code for the credit card, you can then do the following: 

1 Receive and create a voucher for the purchase order as you would for a regular purchase. 

2 Create a payment using the credit card's bank code for the vendors and vouchers. 

3 Print and post the checks. 

4 Add a manual voucher to the Credit Card vendor for the total amount. Use the same clearing 

account used by the credit card bank code for the distribution on this manual voucher. This way, 

the vendor's purchases YTD remain intact, and the payment is actually remitted to the Credit 

Card vendor. 

Posting Electronic Funds Transfer Transactions 

NOTE:Ensure that users who perform the Final Register and Post, or who print the Remittance 

Advice, have permission to write to the output directory for the EFT files. If you run either process 

successfully, and no file is created, check the permissions on the directory.  

To post electronic funds transfer (EFT) transactions and to create the EFT output file: 
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1 Before posting,select the A/P EFT Posting Report option on the A/P EFT Posting form.  

This option produces a list of the EFT payments that will be posted. The grid at the bottom of the 

form also displays the list of items that will be posted. Review these lists. 

2 After printing the report, to begin the posting process, select the Final Register and Post option.  

This step also creates the EFT payments output file, using information from fields on the Bank 

File Format form. The system: 

 Writes the file in the format specified by the EFT Format field. 

 Writes payment records to this file, which has an incrementally numbered filename 

(continuing from the number in the Last EFT File field). 

 Places the file in the directory specified in the EFT Directory field. 

 Creates the EFT Output File Report. This report logs all output EFT records. 

3 Optionally, select the Print Remittance Advice option and then click Process to print 

remittance advice,  

NOTE: If the EFT option for Remittance Advice is selected on the Accounts Payable Parameters 

form, you must also select Print Remittance Advice. 

To have the remittance advice statement processed for print, fax, or e-mail on a vendor-by-vendor 

basis, also select the Use Profile check box. 

When you post an EFT payment and distribution, a Bank Reconciliations record stores the 

payment. The system marks the record as Not Voided. 

Setting Up Electronic Funds Transfer for A/P 

Electronic funds transfer (EFT) is a common way to process automatic transfer of funds from a 

company's bank account to its vendors. Infor CloudSuite supports various output file formats for 

submission to third-party EFT transmission systems. 

1 On the Bank Codes form, specify information about the bank that you will use for EFT 

transactions. For SEPA format only, specify the business identifier code (BIC) and international 

bank account number (IBAN). 

2 On the Bank Addresses form, specify at least the bank number and the branch code for that 

bank. 

3 On the A/P EFT Posting form, specify the format. 

4 Use the Bank File Format and Bank Code Bank File Format forms to set up the EFT 

parameters for this information:  

 EFT format: ALLEFT, BBMEFT, ABAFILE, NACHA PPD, NACHA CCD, SEPA, CPA, CNAB, 

or ZENGIN File (JBA). 

 Bank code to use for EFT transactions 

 Directory where the EFT output files will be stored 

 User name and user number, which is needed only for the ABAFILE format 



Infor CloudSuite Industrial Financials User Guide 

26 

 Destination ID and Origination ID, which are needed only for the NACHA and CPA formats 

 Company ID, which is needed only for the NACHA format 

 Whether to use the default account. This is needed only for the CPA format. 

 Registration number, which is needed only for the CNAB format 

After EFT processing has begun, this tab also shows the last date an EFT file was created, and 

the name (number) of that file. 

5 In the Remittance Advice area to the right of the EFT parameters, indicate whether you want to 

print remittance advice after posting EFT transactions. 

6 On the Vendors or Multi-Site Vendors form, set up EFT information for the individual vendors. 

If the vendor's default payment type is EFT, specify this information, depending on the EFT 

format you use:  

 For ABAFILE, specify the bank account, the bank's EFT (sort) number, and the account 

name. 

 For ALLEFT and BBMEFT, specify the bank account and the bank's EFT (sort) number. 

 For CNAB, specify the bank's transit number, transit reference, EFT (sort) number, and the 

account name. 

 For CPA, specify the bank account, the bank's transit number, transit reference, EFT (sort) 

number, and the account name.  

 For NACHA PPD and NACHA CCD, specify the bank name, transit number, transit 

reference, and bank account. 

 For SEPA, specify the business identifier code (BIC) and international bank account number 

(IBAN). 

For posting steps, see Posting Electronic Funds Transfer Transactions. 

A/P Payments 

Creating a Manual Check 

1 On the A/P Payments form, select Actions > New. 

2 Specify information in these fields:  

 Vendor: Select the number of the vendor you are entering the manual check for. 

 Payment Type: To create a manual check, select Manual Check. 

 Reapplication: If the manual check payment is for a reapplication, select this check box. 

 Check Number: Enter the check number for the manual check you are issuing. 

 Check Seq: Enter the check sequence number, or accept the default of the next incremental 

number. The system uses this number to keep the distributions in numerical order. 

 Check Date: Enter the check date, or accept the default of today's date. 
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 Bank Code: This field displays the vendor's default bank code, but you can change it to the 

code of the bank from which the payment is being made (if applicable). 

 Notes: (Optional) Enter notes about the payment. 

 Reference: Enter the description that is to appear in the journals for this transaction, or 

accept the default, which is the APP followed by the vendor number. 

 Check Amt: Enter the amount of the check. 

3 To save the payment, select Actions > Save. 

4 Select Distributions. 

5 Select Actions > New, and distribute the payment. 

6 Print and post the check. 

Creating a Standard Draft 

1 On the A/P Payments form, select Actions > New. 

2 Specify information in these fields:  

 Vendor: Select the number of the vendor you are entering the standard draft for. 

 Payment Type: Select Standard Draft. 

 Check Seq: Accept the sequence number that displays. The system uses this number to 

keep the distributions in numerical order. 

 Check Date: Enter the draft date, or accept the default, which is today's date. 

 Draft Due: The default payment due date displays, but you can change it to a different date 

on which the draft is to be due. 

 Bank Code: The vendor's default bank code displays, but you can change it to the code of 

the bank from which the payment is being made (if applicable). 

 Notes: (Optional) Enter notes about the payment. 

 Reference: Enter a description which is to appear in the journals for this transaction, or 

accept the default, which is APP followed by the vendor number. 

3 To save the payment, select Actions > Save. 

4 Select Distributions. 

5 To distribute the payment, select Actions > New. 

6 On the General tab, in the Type field, select one of these options:  

 Voucher: Applies the payment to a particular voucher. Enter the voucher number in the 

Vch/Seq field. 

 Open: Applies the payment to the vendor, not to a specific voucher. 

7 Finish distributing the payment. 

8 Print and post the draft. 
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Distributing Vendor Payments Manually 

To distribute vendor payments manually: 

1 On the A/P Payment Distributions form, select Actions > New. 

2 In the Vendor field, select the vendor from the list of those with payments on file.  

The payment header information displays in the upper part of the form, and you cannot change 

it. 

3 On the General tab, fill in the required data:  

 Type: Select the distribution type: Voucher, Non A/P, Commission or Open. 

 Vch/Seq: If you are adding a voucher distribution, enter the number of the voucher 

referenced from the distribution. If you are entering any other type of distribution, enter its 

sequence number. The sequence number is used only to keep the distributions in numerical 

order. 

 Site: If the distribution type is Non A/P, Commission, or Open, select the site where the 

transaction resides. If the distribution type is Voucher, the site that contains the posted 

transaction against which the payment distribution is being applied displays for reference. 

 Invoice: If the distribution type is Non A/P, Commission, or Open, enter the number of the 

invoice you are applying the distribution against. For a Commission distribution type, you 

must enter an order entry invoice number with a commission type of Distribution; the sum of 

the commissions for that invoice and vendor displays in the Amount Paid field on the 

Accounts tab. 

 PO: If the distribution type is Non A/P, Commission, or Open, enter the PO number to which 

you want to record the payment. 

 1099 Reportable: If the payment distribution is 1099 taxable and should be included on the 

vendor's 1099 form, this check box should be selected. If the payment is not 1099 taxable, 

clear the check box. 

4 Select the Accounts tab, and then fill in data in the following fields:  

 Amount Paid: Enter the amount to apply to this payment. 

 Disc Taken: If the payment type is Voucher, enter the amount to be discounted from this 

payment. 

 [Tax Adjustment (1)]: If the payment type is Voucher, this field displays any Tax System 1 

adjustment for discounts. You can change this amount. 

 [Tax Adjustment (2)]: If the payment type is Voucher and a second tax system is defined, 

this field displays any Tax System 2 adjustment for discounts. You can change this amount. 

 Disc Account: If the payment type is:  

 Voucher, this field displays the discount account number from the Accounts Payable 

Parameters form. If the discount amount is not zero, you can select a different account 

for the discount amount, if applicable. 

 Non A/P, select the number of the General Ledger account that is to receive the 

distribution amount. This account offsets the cash account. 
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 Commission, this field displays the number of the General Ledger commission paid 

account from the Accounts Payable Parameters form, but you can select a different 

account to apply the payment to. 

 Open, this field displays the number of the General Ledger deposit account from the 

Accounts Payable Parameters form, but you can select a different account to apply the 

payment to. 

5 To save the distribution, select Actions > Save. 

NOTE: Distributions of type Non-A/P or Commission are not permitted for payments where the 

Payment Type is Standard Draft. 

Generating Automatic Payments 

To automatically generate A/P payments and distributions: 

1 Open the A/P Payment Generation form. 

2 Specify information in these fields:  

 Multi-Site Group ID: To generate payments for a different multi-site group, select that 

group's ID. 

 Payment Date: Enter the date to print on all the checks or drafts, or accept the default, 

which is today's date. 

 Payment Type: Select the check box of each payment type you want to generate payment 

for: Standard Check, Manual Check, Wire, Standard Draft, Incoming Draft, or EFT. 

 Aging Basis: Select the method to age the payments: Invoice, Due Date, or Disc Date. 

 Include Commissions Due: To process commissions for the commissions-due records of 

outside salespersons whose reference numbers are also valid vendor numbers, select this 

check box. The system summarizes the total commission-due amount into the check total for 

each vendor. To exclude commissions, clear this check box. 

 Delete Payment/Distributions: To have any existing payments be deleted before 

generating the new payments, select this check box. To preserve the existing payments, 

clear this check box. 

 Starting and Ending Bank Code: Enter the range of bank codes for which to produce 

payments. 

 Starting and Ending Vendor: Enter the range of vendors for which to produce payments. 

 Starting and Ending Age Date: Enter the first and last aging dates of the transactions to 

consider for payment. These dates also set the range for which payments and distributions 

can be deleted using the Delete Payment/Distributions check box. If the Invoice Date or 

Due Date falls within the date range specified in these fields, the voucher is selected for 

payment. 

NOTE: If you are generating standard checks and you have entered some existing payments, 

the check generation process affects the existing payments. We recommend that you post the 

existing payments before generating new payments. 

3 To generate the payments, click Process. 
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Paying Finance Charges 

To apply customer payments to finance charges using the A/R Payments form, do the following: 

1 Fill in the fields of the form and enter the total amount of the payment in the Amount field, 

although part of the money may be applied to other things than finance charges. 

2 To save the A/R Payments record, select Actions > Save. 

3 To open the A/R Payment Distributions form, click the Distributions button. 

4 On the General tab, in the Type field, select Finance Charge. 

5 In the Dist Amount field, enter the amount of the payment to be applied to finance charge.  

You can create separate distribution records for the remainder of the payment. 

6 To save the A/R Payment Distributions record, select Actions > Save. 

7 Open the A/R Payment Posting form. 

8 To post all customers, accept the default values. 

9 Click Process. 

Posting A/P Wire Transactions 

To post wire transactions, use the A/P Wire Posting form: 

1 Select field values that filter the transactions to post. You can  specify a range of vendor 

numbers, names and  pay dates, the type of payment, and the bank code. 

2 Specify the sort method. 

3 Before posting, select the A/P Wire Posting Report option. Click Process to print and review 

this report, which lists the wire payments to be posted.  

The grid at the bottom of the form also displays the list of items that will be posted. 

4 After you review the report, select Final Register and Post and click Process. 

5 Optionally, print the remittance advice:  

 select Print Remittance Advice.  

 To process the remittance advice output for print, fax, or e-mail on a vendor-by-vendor basis, 

select Use Profile. 

 Click Process. 

NOTE: If the Wire option for Remittance Advice is selected on the Accounts Payable 

Parameters form, you must select Print Remittance Advice. 

When you post a wire payment and distribution, a Bank Reconciliations record stores the payment. 

The system marks the record as Not Voided. 
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Reversing a Posted Wire Payment 

NOTE: If the voucher for the wire payment is generated but not processed, delete the wire payment 

record in the A/P Payments form instead of reversing it. 

To reverse a wire payment: 

1 Create a new wire payment and enter a negative value for the payment. 

2 Distribute the payment to the same wire number, bank code, vendor number, and voucher 

number. 

3 Perform the wire posting. 

During the posting process, the system marks the corresponding bank reconciliation as Voided. 

Posting A/P Cash Payments 

If a vendor accepts cash payments, you can pay with cash and post the cash payment to the ledger: 

1 Create a voucher for the vendor in the A/P Vouchers and Adjustments form. 

2 Generate the distribution and post the voucher in the A/P Voucher Posting form. 

3 Create a payment with a Payment Type of Cash and match the payment to the voucher with A/P 

Quick Payment Application. 

4 Use the A/P Check Printing/Posting form to post the payment:  

 Specify the vendor number. 

 Select Preliminary Check Register and click Process. 

 Click OK to confirm the Preliminary Check Register report. 

 Select Final Register and Post and click Process. (Skip the other steps.) 

 Verify that the payment was posted and click OK. 

Posting A/P Direct Debit Payments 

Automatic direct debit A/P payments are generated when a new BankStatement BOD is received 

into Infor CloudSuite from Infor Local.ly GEMS. 

1 When an A/P Payment record is created and not yet posted, the A/P button on the Bank 

Statements form is enabled for the record.  

2 Select the record and click A/P to open the A/P Payments form and review the payment 

information. The Payment Type should be set to Direct Debit. 

3 Save any changes. 

4 Create a voucher against the payment and handle it as you would handle any other A/P 

payment. 

5 In the A/P Wire Posting form, specify the Vendor range and a Pay Type of Direct Debit. 
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6 Follow the steps in Posting A/P Wire Transactions. 

After the payment is posted, the appropriate journals are updated. 

Posting to the A/P Distribution Journal 

The A/P Distribution Journal records purchase orders you have received and vouchered. Eventually, 

you need to post this journal to the General Ledger. 

CAUTION: After transactions are posted to the journal, you can no longer update them. You can add 

text to the line entries, but to adjust them you must use the A/P Vouchers and Adjustments form. 

You can view posted transactions in the A/P Distribution journal on the A/P Posted Transactions 

Detail form. Use the grid pane to select the transaction you want to view. The Type field identifies 

the type of transaction you are viewing: payment, voucher or adjustment. 

To view summary information about the displayed transaction, select Summary. The system 

displays the A/P Posted Transactions Summary form. 

Reconciling Bank Statements for Accounts Payable 

Prerequisites 

 Ensure that Infor CloudSuite is able to receive BankStatement BODs from Infor Local.ly GEMS. 

See the Infor CloudSuite Industrial Integration Guide for Infor Local.ly. 

 On the Accounts Payable Parameters form, set the EFT Format to SEPA. 

 On the Vendors or Multi-Site Vendors forms, set the Payment Type to EFT for vendors that 

can receive automatic A/P payments. Specify the banking information for the vendor. 

 In the Chart of Accounts form, set up an account for every vendor whose bank account uses a 

currency other than your domestic currency. Transactions to/from this account will be in the 

currency of the vendor bank account. This prevents currency exchange fluctuations from 

affecting automatic payments.  

 On the Bank Reconciliations form, set up information for the banks from which you will receive 

statements. The currency, BIC and IBAN codes must match the information in the messages that 

you receive from the banks.  

Viewing and Filtering Bank Transactions 

Bank statement records are display-only. You cannot make changes on this form; however, you can 

filter the records to view specific types of information. 

1 In the Bank Statement form, click the Filter-in-Place tool bar button to see the available bank 

statement records.  

Each bank statement record shows information relating to one customer or vendor bank identifier 

code (BIC) or to one employee account used for payments. 

2 Select a record.  
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The bank statement record header can contain information such as this: 

 The starting and ending balance for the account for the period  

 The period starting and ending dates  

 The currency that is used for all transactions in the statement 

The statement line detail shows debit and credit transactions and amounts, listed with the 

appropriate domain and family codes that describe the type of transaction. (Chinese transactions 

show positive and negative numbers rather than debit and credit.) 

The information is formatted dynamically. The grid column headings and content are set based 

on the format that is used by a particular bank. 

3 Use these filter fields to limit the types of information that are displayed for the current bank 

statement record:  

 Domain Code, Domain Family Code, and Domain Sub Family Code. These fields work 

together to limit the types of transactions that are shown. For example, a domain code of 

PMNT and a family code of IDDT represents an automated A/P payment. The codes are 

defined and described in the ISO Domain Codes, ISO Domain Family Codes, and ISO 

Domain Sub Family Codes forms.  

 Type (Customer, Vendor, Bank or Employee) and Code. These fields work together to 

limit the transaction lines to those for a specific customer, vendor, bank or employee. 

If you have filtered on account entry  transactions for a certain vendor number, you can only see 

the detail transactions that are allocated to that vendor. However, parts of the transaction 

amount might be allocated to another party, for taxes or commissions. In that case, the total 

amount of the transaction in the account entry section does not equal the sum of the filtered 

transactions in the account entry details section. 

Viewing Automatic A/P Payments 

When a BankStatement BOD is received into Infor CloudSuite, automatic payments are generated 

for any A/P transactions in the statement that have a domain family code of IDDT or ICDT.  

1 On the Bank Statements form, select a transaction line with the domain family code IDDT or 

ICDT. 

2 Click A/P to view the A/P payment transactions that were created for the current statement 

record. 

You can then process the A/P payments and then post them on the A/P Wire Posting form. 

Reconciling the Statement 

Manually reconcile the account statement records on the Bank Statement form with the 

transactions on the Bank Reconciliations form for this account. See Preparing a Bank 

Reconciliation. 

When the statement is completely reconciled, select the Process check box on the Bank 

Statements form. You can then use the Bank Statement Purge utility to purge the processed 

records. 
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Preparing a Bank Reconciliation 

The system maintains a transaction history of all activity against the bank checking accounts your 

company uses. You can view this information using the Bank Reconciliations form, and also 

prepare bank reconciliations by tracking what has been recorded by the bank. 

Overview 

Summary bank reconciliation records are automatically created when you process entries on these 

forms: 

 A/R Payment Posting for payment types: Check, Wire, and Adjustment only 

 A/R Adjustment Posting 

 A/R Wire Posting 

 Returned Checks  

Checks that are printed through Payroll and Accounts Payable are automatically recorded, along 

with checks that have been voided due to a reprint, enabling you to view and reconcile each check. 

To reflect miscellaneous charges, you must either manually add them through the grid on this form, 

or record them in the General Journal or a user-defined journal. 

NOTE: You cannot enter post-dated checks until they have been deposited. 

One of these sources is shown in the Ref Type field for automated bank reconciliation records: 

 A/P: The transaction is posted from A/P check or draft printing. 

 A/R: The transaction is posted from A/R check, adjustment, wire, or draft posting. 

 PR: The transaction is posted from payroll check printing. 

 BAL: The transaction is created during the bank reconciliation compression process. 

Steps 

To reconcile and then compress transactions: 

1 To reflect deposits and miscellaneous charges that are not automatically added (see above), you 

must either manually add them through the grid on the Bank Reconciliations form, or record 

them in the General Journal or a user-defined journal. 

2 When you receive a statement from the bank, for each reconciled transaction, select Reconciled 

on the Bank Reconciliations form. 

3 To process all transactions against the current General Ledger cash account, click Balance 

Compute. 

4 To delete transactions that have been reconciled, run the Bank Reconciliation - Compression 

utility:  

 (Optional) By default, the system compresses transactions through the current system date, 

but you can enter a different date that is earlier than the date of the last check record you 

want to compress. This sets the system to know what check number is next in the sequence. 

 In the Bank Code field, select the bank code of the bank account you want to compress. 
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 If you want the system to automatically increment date ranges and re-run reports and 

utilities, select the Increment Date check box. 

 To compress the selected bank code's reconciliation transactions, select Process. 

How VAT is Handled During Reconciliations 

For A/R transactions, after a payment by check is received for an invoice, you must manually enter 

the payment in the Bank Reconciliations form. You must enter and post customer checks 

individually. When each payment is reconciled with the bank statement, the system credits the VAT 

A/R Received account. 

For A/P transactions, after a processed check is reconciled with the bank, the system debits the VAT 

A/P Paid account. 

Preparing a Bank Reconciliation Using Transfer VAT 

This topic describes how to reconcile invoice and voucher payments when the Transfer VAT option 

is selected on the General tab of the Tax Systems form. 

Transfer VAT enables VAT recognition upon bank reconciliation. 

For more information on performing a bank reconciliation, see Bank Reconciliations and Preparing a 

Bank Reconciliation. 

To reconcile A/P checks with Transfer VAT selected: 

1 Open the Bank Reconciliations form. 

2 Select the appropriate Bank Code. 

3 Specify these values in these fields:  

 Type: Must be Check. 

 Transaction: Enter the individual check number. 

 Ref Type: Must be A/P. 

 Ref Num: Select the appropriate vendor number. 

4 After you are finished entering or updating transactions, click Balance Compute. 

5 When finished reconciling, select Actions > Save.  

To reconcile A/R deposits with Transfer VAT selected: 

1 Open the Bank Reconciliations form. 

2 Select the appropriate Bank Code. 

3 Specify these values in these fields: 

 Type: Must be Deposits. 

 Transaction: Enter the deposit number. 

 Ref Type: Must be A/R. 



Infor CloudSuite Industrial Financials User Guide 

36 

 Ref Num: Select the appropriate customer number. For summary bank reconciliation entries, 

this value is set to 0 by default. 

4 After you are finished entering or updating transactions, click Balance Compute. 

5 When finished reconciling, select Actions > Save. 

Printing and Posting Checks 

CAUTION 1: The A/P Payment Generation utility resets most of the fields of the existing payment 

records. To avoid this, always post your manual checks using the A/P Check Printing/Posting form 

before running the A/P Payment Generation utility. 

CAUTION 2: You can void checks using the A/P Check Printing/Posting form only before you print 

the final register. Once you print the final register and post the checks, you cannot void checks using 

this form. For more information, see Voiding Posted Checks. 

To print and post checks: 

1 On the A/P Check Printing/Posting form, select the process to use: 

 Preliminary Check Register: Sets up a preliminary check register. If no checks need to be 

printed, a message to that effect displays. When you select this option, the system validates 

the check information, prints the register, and then returns you to the A/P Check 

Printing/Posting form so that you can continue with or exit from the process.  

NOTE: You must print the preliminary register before you can print the checks. 

 Print A/P Checks: Prints the A/P checks from the preliminary register. 

 Void Check(s): Activates the options in the To Void group box so that you can void checks 

and then post them. Use this option if your checks printed incorrectly or were damaged. 

When you choose this option, the To Void group box is updated with information about the 

checks that are to be voided. When prompted, click OK to void the listed checks. 

 Print A/P Check Stubs: (Optional) Reprints the APCheckLaserStubs, 

APCheckSTD006Stubs, or APCheckANZStubs report for the checks in the collection, but 

leaves the check portion at the bottom blank. This option can only be selected after a Print 

A/P Checks or Void Checks option has been performed. Once the Final Register and Post 

has been performed, check stubs can no longer be printed.  

NOTE: Check stubs print only for standard checks. Manual checks do not print checks; 

therefore, they do not print check stubs.  

 Final Register and Post: Prints a check register, posts the checks to the A/P Distribution 

Journal, creates posted transactions, and updates the vendor records. General Ledger 

journal records are created for the payment records, and the posted transaction vouchers 

are created for the amount paid and discount taken. 

 Print Remittance Advice: If the Manual option for Remittance Advice is selected on the 

Accounts Payable Parameters form, you must also select this option. To have the 

remittance advice statement processed for print, fax, or e-mail on a vendor-by-vendor basis, 

also select the Use Profile check box. 
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2 Fill in the fields indicating the associated bank, check numbers, vendors, pay dates, and other 

information for the process. 

3 Click Process. 

If you exit from this form after printing or voiding checks but without running the Final Register and 

Post option, the system will void any records that are not already voided, and then automatically run 

the Final Register And Post option. 

Checks that you post from A/P contain the reference type A/P and a reference number 

corresponding to the vendor number of the A/P check. During posting, multi-currency gains and 

losses are recorded to the A/P ledger distribution journal (if applicable). 

NOTE: If a discount is taken, the Discount field prints by itself on the line immediately following its 

corresponding voucher information. This line will also print the side label Discount whenever the line 

prints. 

When you print and post checks, three vendor fields are updated: 

 Last Paid Date: Date of the last posted payment for that vendor 

 Discounts YTD: YTD amount of a discount taken for a voucher for a vendor 

 Payments YTD: YTD payments made to the vendor in the current year 

Printing Checks in Languages Other Than Your Domestic Language 

It is possible to modify the system so that you can print checks in a language other than your 

domestic language. To do so, you must modify the Source Code for the two stored procedures that 

handle A/P Check Translation: WordNumSp() and WordNumISp(), which are included with all Infor 

CloudSuite distributions. 

Printing Check Amounts 

Check amounts print as both words and numeric amounts. Two lines are available to display the 

amount in words. Check amounts are limited to print billions or less. If the currency code is MXN or 

MXV, the check amount prints in Spanish, regardless of the specified language code, and billions 

are represented as "thousands of millions." 

Printing Check Stubs 

After you print or void standard checks, you have the option to print copies of the check stubs. 

Remittance Advice 

If the Manual option for Remittance Advice is selected on the Accounts Payable Parameters 

form, you must also select Print Remittance Advice. 

To have the remittance advice statement processed for print, fax, or email on a vendor-by-vendor 

basis, also select the Use Profile check box. 

NOTE: If you select this option but no manual checks exist in the check batch, the remittance advice 

will be blank. 
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Printing and Posting A/P Drafts 

CAUTION: The A/P Payment Generation utility resets most of the fields of the existing payment 

records. To avoid this situation, always post your manual drafts using the A/P Draft 

Printing/Posting form before running the A/P Payment Generation utility. 

Printing and Posting Drafts 

To print and post drafts: 

1 Open the A/P Draft Printing/Posting form. 

2 Enter information in these fields:  

 Bank Code: Select the bank code for the drafts you want to post. 

 Starting Draft Number: Select the starting draft number. 

 Sort by: Indicate how you want to sort the report. 

 Display Distribution Detail: Indicate whether you want distribution information on the report 

 Vendor: Select the first and last vendor numbers you want to include in the printing or 

posting. 

 Due Date: Select the first and last due dates you want to include 

 Starting Name/Ending Name: Enter the first and last name you want to include. 

3 To print and review the report (before posting the drafts), select Print and then click Process. 

4 When you are ready to post the drafts, select Commit and then click Process. 

Posting Remitted Drafts 

To post remitted drafts and print a remittance statement: 

1 Open the A/P Posting Draft Remittance form. 

2 Enter the following information:  

 Starting and Ending Vendor Number: Select the first and last vendor numbers whose draft 

remittances you to post, or, to post draft remittances for all vendors, leave both fields blank. 

 Starting and Ending Draft Number: Select the first and last draft numbers you want to 

include. 

 Starting and Ending Due Date: Select the first and last due dates you want to include. 

 Bank Code: Select the bank code for the draft remittances you want to post. 

 Display Report Header: If you want to include report headers in the report, select this check 

box. 

The report header displays on the first page of the report, and lists the parameters by which you 

generated the report. 

3 To print and review the A/P Posting Draft Remittance Report, select Print and then click 

Process. To have the remittance advice statement processed for print, fax, or email on a 

vendor-by-vendor basis, also select the Use Profile check box. 



Accounts Payable (A/P) 

39 

4 When you are ready to post the draft remittances, select Commit and then click Process. 

Using A/P Quick Payment Application to Reapply Open Payments 

You can use the A/P Quick Payment Application form to reapply open payments in two ways. 

Option 1 

1 Enter the payment you want to reapply, and select its Reapplication check box.  

All the vendor's transactions display in the grid at the bottom of the form. Select the applicable 

transaction(s). If an open type distribution already exists for a payment, it displays as Open (Dist) 

to distinguish it from open transactions from A/P Posted Transactions. 

NOTES: Open payments from other sites (that is, sites other than the site of the payment) do not 

display in the grid.  

 

Open payments do not display in the grid for any payment that does not have a check number or 

draft number (Standard Checks and Standard Drafts). A check number or draft number is 

required for these payment types to automatically reapply an open payment for them when you 

click Apply. 

2 Select the vouchers to which you want to reapply the payment.  

NOTE: Transactions in the grid at the bottom of the form do not become available for selection 

until you save the payment in the upper part of the form. After selecting items in the grid, you 

must then click Apply to process them. Selecting a different payment without first selecting 

Apply will cancel any changes you made in the grid. 

3 Select Apply.  

The system automatically generates payment distributions for the selected vouchers. If you 

selected any open payments, they will first be applied to the selected vouchers and posted with 

the proper journal entries. In this case, journal entries will have the reference of APPR (payment 

reapplication). Otherwise, you must post the payment distributions as usual. 

Option 2 

1 Enter and save a payment. In the grid at the bottom of the form, both a voucher and an open 

payment display. 

2 To trigger the reapplication process, select the open payment and then click Apply.  

NOTE: If you select multiple vouchers and multiple open payments, the system automatically 

applies the open payments by type and due date. You cannot update the voucher number. 

3 Click Apply.  

The same process occurs for the reapplication as described in Option 1 above. The system then 

creates a payment distribution for any remaining items, and if an amount remains for the 

payment in the upper part of the form, creates an open payment distribution for it. 
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Using A/P Quick Payment Application to Enter and Apply Full and Partial 
Payments 

You can use the A/P Quick Payment Application form to enter full and partial payments, and 

automatically distribute them to open vouchers. You can also apply payments that were entered on 

the A/P Payments form. 

NOTE: Transactions in the grid are not available for selection until you enter and save a payment in 

the upper part of the form. After selecting the transactions, you must then click Apply to process 

them. Selecting a different payment without first clicking Apply will cancel any changes you made in 

the grid. Selecting Apply generates the appropriate payment distributions, and refreshes the grid 

display with the current data. 

1 Open the A/P Quick Payment Application form. 

2 Select Actions > New. 

3 Enter the payment data:  

 Vendor: Enter the vendor who is to receive the payment. 

 Type: This field displays the vendor's default payment type from the Vendors form, but you 

can select a different one from among the following:  

 Standard Check 

 Manual Check 

 Wire Payment 

 Standard Draft 

 Incoming Draft 

 Number: The check, wire, or draft number displays, depending on the payment type:  

 For a manual check, enter the check number. 

 For an incoming draft, enter the draft number. 

 For a wired payment, enter the wire number. 

Note that for standard checks and drafts, the system automatically updates this field when 

the check or draft is printed. 

 Seq: Enter the sequence number for this payment.  

The system uses this number only to keep the payments in numerical order. 

 Date: Enter the check, draft or wire date, or accept the default, which is today's date. 

 Bank Code: This field displays the vendor's default bank code, but you can change it to the 

bank code of the bank account from which the vendor is to be paid. 

 Vendor/Domestic Payment: Enter the check, wire, or draft amount for the current payment.  

The vendor's balance is reduced by this amount. The payment amount needs to be 

distributed against vouchers, commissions, and open or non-A/P payments. If the vendor is a 

foreign currency vendor, the payment amount displays in the vendor's currency. 
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For standard checks and drafts, you cannot update this field. Instead, the system displays 

the sum of all the payment distributions for the vendor. To change this amount, you must 

change the distributions using the A/P Payment Distributions form. 

 Exchange Rate: If you are using multiple currencies, this form displays the exchange rate 

between the domestic currency and the vendor's currency, but you can change it. For open 

payments, you must book a gain/loss transaction if the exchange rate on the payment is 

different than the exchange rate on the voucher or adjustment. The payment goes to A/P 

Posted Transactions with the same exchange rate as the open payment. The system does 

not revalue the voucher. 

 A/P Notes: Enter a description of the payment (up to 40 characters). 

 G/L Reference: Enter a description of the payment for reference. This description is posted 

to the General Ledger as part of the transaction posting. The default reference is APP, 

followed by the vendor number.  

The reference code must begin with AP; otherwise, the void utility cannot function. 

4 To save the payment, select Actions > Save.  

The system creates the payment record and then displays all open vouchers and payments for 

the vendor in the grid at the bottom of the form. 

5 In the grid at the bottom of the form, do one of the following:  

 Select the check box in the Select column for each voucher and payment (transaction line) 

that you want to apply the payment to. 

 To apply the action to all the displayed items, click Select All. 

6 To change an item's payment amount, click the grid scroll bar to display the Amt To Pay column, 

and then enter the amount to be applied. 

7 (Optional) For vouchers, you can enter a discount amount in the Discount column. 

8 To distribute the payment, click Apply.  

The Applied and Remaining fields in the upper part of the form show the updated amounts. You 

can then apply the payment when these amounts are equal. 

NOTE: If the payment is not standard check or a standard draft, and the applied amount is less than 

the remaining amount, the difference creates a new open payment distribution. If the applied amount 

is more that the remaining amount, an error message displays, and you will not be able to continue 

until you correct this error. 

Using the A/P Quick Payment Application to Enter and Distribute an Open 
Payment 

To enter a payment and distribute it as open, use the A/P Quick Payment Application form. You 

can also distribute open payments that have been entered using the A/P Payments form. 

CAUTION: Transactions in the grid at the bottom of the form do not become available for selection 

until you save the payment in the upper part of the form. After selecting items in the grid, you must 
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then click Apply to process them. Selecting a different payment without first click Apply will cancel 

any changes you made in the grid. 

1 Open the A/P Quick Payment Application form. 

2 Select Actions > New. 

3 Enter the payment data:  

 Vendor: Enter or select the vendor who is to receive the payment. 

 Type: This field displays the vendor's default payment type from the Vendors form, but you 

can select a different one from the following options:  

 Manual Check 

 Wire Payment 

 Incoming Draft 

 EFT 

NOTE: Because you must enter a check number in the Number field to distribute an open 

payment, do not select the Standard Check or Standard Draft option. 

 Number: To distribute an open payment, enter the check number.  

If the check number is blank, any open payments from A/P Posted Transactions do not 

display in the grid at the bottom of the form. 

 Seq: Enter the sequence number for this payment. This number is used only to keep the 

payments in numerical order. 

 Date: Enter the check, draft or wire date, or accept the default, which is today's date. 

 Bank Code: This field displays the vendor's default bank code, but you can change it to the 

bank code of the bank account from which the vendor is to be paid. 

 Vendor Payment/Domestic Payment: Enter the amount of this open payment. The 

payment amount cannot be negative, or an error message displays when you click Apply. 

 Exchange Rate: If you are using multiple currencies, this field displays the exchange rate 

between the domestic currency and the vendor's currency, but you can change it.  

For open payments, you must book a gain/loss transaction if the exchange rate on the 

payment is different than the exchange rate on the voucher or adjustment. The payment 

goes to A/P Posted Transactions with the same exchange rate as the open payment. The 

system does not revalue the voucher. 

 A/P Notes: Enter a description of the payment (up to 40 characters). 

 G/L Reference: Enter a description of the payment for reference. It is then posted to the 

General Ledger as part of the transaction posting. The default reference is APP, followed by 

the vendor number.  

NOTE: The reference code must begin with AP. Otherwise, the void utility does not function. 

4 To save the payment, select Actions > Save. The system creates the payment record, and then 

displays all open vouchers and payments for the vendor in the grid at the bottom of the form, but 

none are automatically selected. 
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5 Select the items you want to process, or, to distribute the entire payment amount as an open 

payment, leave them all unselected. 

6 Click Apply. The system creates the open payment distribution record and generates 

distributions records for any vouchers that are selected in the grid. Any remainder of the 

payment amount is applied as an Open type payment distribution. 

NOTE: Open type payment distributions display in the grid with a type of Open (Dist) to distinguish 

them from open payments displayed from the A/P Posted Transactions form. 

Voiding Checks Before They Are Posted 

Use the A/P Check Printing/Posting form to void checks before they are posted, that is, before you 

print the final register 

NOTE: If you exit from the A/P Check Printing/Posting form after printing or voiding checks but 

without running the Final Register and Post option, the system will void any records that are not 

already voided, and then automatically run the Final Register and Post option. 

Voiding Posted Checks 

After checks have been posted, you can void them using either the A/P Payments form or the Void 

A/P Posted Payments form. 

After voiding the checks, you can reprint them. 

Voiding Posted Checks Using the A/P Payments Form 

To void posted checks using the A/P Payments form: 

1 Select Actions > New. 

2 Enter data in the following fields:  

 Vendor: Select the number of the vendor whose check you want to void. 

 Bank Code: Enter a valid bank code for the bank against whom the original check was 

issued. 

 Payment Type: Select Manual Check. 

 Check Number: Enter the number of the check you want to void. 

 Check Date: Enter the date of the manual check. 

 Seq: Accept the default, which is the next incremental number. The system uses this number 

only to keep the distributions in numerical order. 

 Check Amt: Enter the negative value of the check you are voiding. For example, to void a 

$250.00 check, specify -250.00. 

3 In the G/L Reference field, enter the description for this transaction that is to appear in the 

journals. The default is APP, followed by the vendor number. 

4 Select Distributions. 
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5 Select Actions > New. 

6 Distribute to the vouchers as negative amounts. 

7 Print the final register and post the negative check.  

NOTE: The check number that defaults on the A/P Check Printing and Posting form during this 

process is strictly for standard checks. You do not need to update this number when posting the 

negative manual check.  

Voiding a Check Using the Void A/P Posted Payments Utility 

NOTE: If the A/P payments are manual checks, are compressed, or are multi-site, you cannot void 

them using this utility. 

To void a payment using the Void A/P Posted Payments utility: 

1 Enter data in the following fields:  

 Bank Code: Select the bank code of the bank account associated with the payments you 

want to void. 

 Starting and Ending Check Num: Enter the range of check numbers you want to void.  

For a single check, use the same starting and ending check number. 

2 Select Process. 

Voiding Posted Drafts 

After posting drafts, you can void them, using the Void Posted Draft Payments form. 

After voiding the drafts, you may reprint them. 

Voiding Drafts Using the Void Posted Draft Payment Utility 

NOTE: If the A/P payments are standard drafts, are compressed, or are multi-site, you cannot void 

them using this utility. 

To void drafts using the Void Posted Draft Payments form: 

1 Enter data in the following fields:  

 Bank Code: Select the bank code of the drafts you want to void. 

 Starting and Ending Draft Number: Enter the draft number range of the drafts you want to 

void. 

2 Perform one of the following actions:  

 To view the results of running the utility without saving the results in the database, select 

Preview. 

 To save the results in the database, select Commit. 

3 Click Process. 
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Vouchers 

Activating Voucher Authorization 

You can turn the Voucher Authorization feature on or off using the Purchasing Parameters form. 

Once you activate voucher authorization, you can also set up voucher tolerance criteria to allow 

flexibility in authorizing vouchers. 

1 On the General tab, select the Voucher Authorization check box. 

2 In the Voucher Tolerance Over field, enter the upper tolerance factor percentage. 

3 In the Voucher Tolerance Under field, enter the lower tolerance factor percentage.  

NOTE: The tolerance factor cannot be greater than 100 percent or a negative number. 

4 To save your selection, select Actions > Save. 

You need special authorization to update purchasing parameters. See your system administrator for 

assistance. 

When you activate Voucher Authorization, you can update the Auth Status and Authorizer fields on 

the A/P Vouchers and Adjustments form. The system determines the vouchers to post, depending 

on the value in the Auth Status field. 

The Auth Status field has three possible values: Authorized, Failed, and/or Matched. If the 

purchase order's unit material cost equals the voucher's cost or is within the acceptable tolerance 

limit, the system assigns the voucher a status of Matched; otherwise, the voucher is assigned a 

status of Failed. If the vouchers can be posted, the system updates the Auth Status field to 

Authorized when you start the Voucher Authorization utility. 

NOTE: PO Line/Release Unit Material Cost (not Unit Plan Cost) is compared to Generate A/P 

Transactions Unit Cost.  

When you create vouchers automatically from Purchasing, the system follows these rules: 

 The Authorizer field default value comes from the purchase order's Buyer field. 

 The system assigns all returns or adjustments an authorization status of Failed. 

 Variances between expected freight, miscellaneous charges, etc., do not cause the system to 

set the authorization status to Failed. 

When you create vouchers manually from Accounts Payable, the system follows these rules: 

 The system always assigns to vouchers an authorization status of Failed. 

 Any time a voucher is updated, the system assigns it an authorization status of Failed. 

 The Authorizer field is required if the Auth Status field is set to Authorized. 

Authorizing Vouchers 

You can control which vouchers to post. However, this process is optional. 
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To authorize vouchers: 

1 On the Purchasing Parameters form, activate voucher authorization.  

For more information, see Activating Voucher Authorization. 

2 Create vouchers. For more information, see Creating Vouchers or Adjustments. 

3 To select the vouchers to post, run the Voucher Authorization utility. This utility examines 

vouchers and determines whether they can be posted. The default selection processes all 

vouchers and adjustments. None of the selection criteria fields is required, but you can use them 

to limit the number and type of vouchers the system processes.  

Enter information in these fields, as appropriate: 

 Starting and Ending Authorizer: Enter the range of authorizers. All vouchers authorized by 

people whose names fall alphabetically between the starting and ending names are affected 

by this utility. 

 Starting and Ending Voucher: Enter the range of vouchers you are authorizing. 

 Starting and Ending Invoice Date: Enter the range of invoice dates for the vouchers you 

are authorizing. 

 Starting and Ending Vendor: Enter the range of vendors whose vouchers you are 

authorizing. 

 Authorization Status: Enter the status of the vouchers you are authorizing: F for "failed" 

and/or M for "matched." 

4 Perform one of the following actions:  

 To view the results of running the activity or utility without saving the results in the database, 

select Preview. 

 To save the results in the database, select Commit. 

5 Click Process.  

NOTE: The system does not post vouchers that have an authorization status of Failed. 

6 Post the vouchers you selected in the Voucher Authorization utility.  

If Voucher Authorization is not activated, follow your usual posting procedure to post vouchers. 

Creating Recurring Vouchers 

You can create recurring vouchers for payments you make to the same vendor every month. These 

recurring payments include such things as rent, lease payments, and insurance bills. You should 

generate recurring vouchers each month. 

CAUTION: Your company must develop procedures to prevent multiple generations for the same 

month. 

1 Open the Recurring Vouchers form. 

2 Select Actions > New. 

3 Enter the required information listed below. 
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For more information, see the field descriptions for the relevant fields. 

 Vendor 

 Voucher 

 Distribution Date 

 A/P Acct 

 Reference 

 Invoice Date 

 Due Date 

 Disc Date 

NOTES:  

This field displays the default terms from the vendor's terms code. 

If you are using Advanced Terms, the European algorithm is used to calculate the due date, 

based on all the elements of the terms. This algorithm is also used to recalculate the due date 

if any element of the terms has changed or if the invoice date has changed. 

4 (Optional) Enter information in the other fields. 

5 Save the record. 

6 To distribute the recurring voucher, click Distribution.  

After you enter the recurring voucher and create a distribution for it (either manually or system-

generated), the distribution record remains on file. You do not need to distribute each month 

unless the purchase amount changes. If this amount changes, you must update the distribution 

record to reflect the new amount. 

Examples of these two situations are rent and utility bills. Typically, the rent amount is the same 

each month and so it is not necessary to distribute it each month. While a utility bill is recurring, 

the currency amount usually is different each month, in which case it would be necessary to 

redistribute it. 

7 After vouchers are created and distribution is set up, you can generate recurring vouchers at 

each payment cycle. 

Creating Vouchers or Adjustments 

There are two ways to automatically generate vouchers: configure the Auto Voucher feature for 

each vendor, or use the Generate A/P Transactions form.  For more information about using the 

Auto Voucher feature, see Automatic Vouchering. For more information regarding the Generate A/P 

Transactions form, continue reading this topic. 

To automatically create adjustments, however, follow these steps using the Generate A/P 

Transactions form: 

1 Display receipts for purchase order lines. 

2 Edit the lines to reconcile receipts with the vendor's invoice. 



Infor CloudSuite Industrial Financials User Guide 

48 

3 Create pending tax transaction lines for the received purchase orders. 

4 Enter payable amounts in the voucher header. 

5 Generate the voucher or adjustment. 

Display Receipts for Purchase Order Lines 

1 Select the vendor whose invoice you are entering. 

2 Do one of the following:  

 To create a voucher for received purchase order lines, select the Voucher option. 

 To create an adjustment to an existing voucher for returned items, select the Adjustment 

option. 

3 If you selected the Adjustment option, in the Voucher field, select the existing voucher number. 

4 In the G/L Dist field, select a date or accept the default, which is the current date. The date is the 

record date of the accounts payable transaction. 

5 To link the new voucher to a voucher pre-register, select the voucher pre-register number, and 

then select OK. For details, see Pre-Register. 

6 Select the Additional Material Selection tab. 

Vouchering Purchase Order Lines 

1 Select the Generate from PO check box. 

2 Select the range of purchase orders you want to use. 

3 Select the lines/releases you want to use.  

NOTE: If the unit of measure of a purchase order line item was changed to something other than 

the original unit of measure listed on the Items form, the Generate A/P Transactions utility uses 

the original unit of measure to validate the data. 

Vouchering GRN Lines 

1 Select the Generate from GRN check box. 

2 Select the range of GRNs appearing in the invoice. 

3 (Optional) Select the range of GRN line numbers appearing in the vendor's invoice. 

4 (Optional) Select the range of purchase order numbers appearing in the vendor's invoice. 

Vouchering EDI Invoices 

Selecting the Generate from EDI Invoices check box clears any values currently in the Generate 

from PO and Generate from GRN fields of the Additional Material Selection tab and disables 

those fields. 
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1 Select the Generate from EDI Invoices check box. This field is disabled if the vendor is not set 

up for EDI transactions or if there are any pending transactions currently on the Material tab or 

the Taxes tab. 

2 Select an invoice. 

3 To include GRN lines, select the Received via GRN check box and select a GRN number in the 

GRN field. 

4 Select Select Matching. Receipts for purchase order lines display in the browser on the 

Material tab. 

Edit Receipts for Purchase Order Lines 

When you edit receipt lines, the amount in the Total field on the Material tab is automatically 

recalculated. 

1 Delete any purchase order receipt lines or GRN lines in the Material tab that are not referred to 

in the vendor's invoice. 

2 In the To Vch/Adj field, modify (as required) the number of units of each line item to include in 

the voucher, or accept the default value of the quantity received minus any quantity previously 

vouched for the purchase order line or GRN line. 

3 Modify (as required) the unit cost of each line, or accept the default value. 

Create Tax Transaction Lines 

The Taxes tab is enabled when the Active for Purchasing check box is selected on the Tax 

Systems form for at least one tax system. 

If the Taxes tab is disabled, you can enter tax amount(s) from the vendor's invoice, or other amounts 

as required, in the Sales Tax field(s) on the header. 

1 Select the Taxes tab. 

2 Select Generate Tax. The activity calculates the sales tax for each pending voucher line on the 

Material tab and creates a pending tax transaction line for each purchase order on which tax is 

owed. The activity displays the total of the line amounts in the Sales Tax field(s) on the Taxes 

tab and provides the option of copying the sum(s) to the header.  

NOTE: The label for the Sales Tax field is user-defined. 

3 To add a tax amount that was not created in the generation process, create a new tax 

transaction line. 

Enter Payable Amounts in the Header 

1 In the Material field on the header, enter the amount displayed in the Total field on the Material 

tab. Amounts in the two fields must be equal. The amount should be equal to what is specified 

on the vendor's invoice. 

2 In the Freight and Misc Charges fields on the header, enter amounts from the vendor's invoice 

or as required. 
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3 If you have not already entered sales tax on the header, do so now. Sales Tax amount(s) on the 

header must equal the total(s) on the Taxes tab. 

4 If you are creating a non-EDI voucher or adjustment, select the General tab and enter the 

required information. 

Generate the Voucher 

Click Generate. 

The new voucher number appears in a message when processing is complete. 

Creating Vouchers or Adjustments Manually 

You can create a voucher for these tasks: 

 To record an amount you owe to a vendor. 

 To reduce the amount of a previously entered voucher. 

 To reverse the full amount of a previously entered voucher, using single entry accounting. For 

this task, do not follow the steps below. See About Cancellation Posting for Single-Entry 

Accounting. 

NOTE: You can also create vouchers or adjustments automatically. After you receive the purchase 

order, use the Generate A/P Transactions utility to create the vouchers or adjustments, or configure 

your vendors to allow generation of vouchers immediately after receiving a shipment by using the 

Auto Voucher field. 

To print a new voucher with adjusted amounts, you must first negate the original voucher entirely. 

Using the PO Receiving form, perform a debit return for the same quantity originally vouchered. The 

system generates an adjustment to offset the corresponding voucher, allowing you to begin again. 

Then, receive the quantity back in. The new voucher can now be generated with the corrected 

domestic currency amount. 

1 Open the A/P Vouchers and Adjustments form. 

2 Select Actions > New. 

3 In the Vendor field, select the vendor for which you are entering the voucher or adjustment. 

4 Specify this information:  

Type  

To add a voucher, select Voucher. To enter an adjustment, select Adjustment. 

Voucher 

If you are entering a Voucher transaction, specify a unique voucher number, or accept the 

default of the next available voucher number. If you are entering an Adjustment transaction, 

select the voucher number to be adjusted. 

Invoice 

Specify the vendor's invoice number. 
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Invoice Date  

By default, this field displays today's date, but you can change it to the date on which the vendor 

invoiced you for this transaction. 

Distribution Date 

By default, today's date displays, but you can change it to the date on which you want to 

distribute these funds (for a voucher) or on which you want to apply the adjustment to this 

vendor's account. 

PO 

Select the vendor's purchase order number to apply the transaction against. When applicable, 

the default value comes from the voucher. 

Pre-Register 

(Voucher transactions only) If you want to voucher material before it is received, specify a pre-

register number. 

GRN 

The goods receiving note number displays. 

Posted from PO 

This check box is automatically selected if the voucher was added as part of the posting process 

from the Purchasing module. If you are manually adding a voucher through the A/P Vouchers 

and Adjustments form, this check box is not available for selection. 

If this check box is selected, you cannot delete the record. In addition, you can modify only some 

of the fields. Note that you can still manually distribute the transaction to re-allocate the G/L 

account amounts. 

Auto Vouchered 

This check box is selected if the order was automatically vouchered during PO receipt.  

5 Specify the appropriate amounts in these fields: 

Purch Amt  

For a Voucher transaction, enter the total amount of the vendor invoice you are recording. Do 

not include miscellaneous taxes, brokerage, duty, freight, insurance, and local freight in this 

amount.  

For an Adjustment transaction, enter the amount by which to adjust the voucher and the vendor's 

purchases YTD. A negative amount decreases the balance, while a positive amount increases it. 

Freight  

Specify the amount of freight payable for the transaction. 

Duty 

Specify the duty charges for the transaction. 

Brokerage 
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Specify the brokerage charges for the transaction. 

Insurance 

Specify the insurance charges for the transaction. 

Local Freight 

Specify the local freight charges for the transaction. 

Misc Charges  

Specify the miscellaneous charges for the transaction. 

Sales Tax  

Specify the amount of tax for Tax System 1 payable on this transaction. This field is available 

only if the Prompt for State Tax check box is selected on the Tax Parameters form. 

Sales Tax 2 

Specify the amount of tax for Tax System 2 payable on this transaction. This field is available 

only if a second tax system is defined, and the Prompt for Tax System 2 check box is selected 

on the Tax Parameters form. 

Non-Disc Amt  

Specify the domestic currency amount of the invoice amount that is not eligible for a discount. 

Disc Amt  

Specify the domestic currency amount of the discount that may be taken if the payment is made 

on or before the discount date. 

6 Specify this information:  

Prox Code  

If you selected the Advanced Terms field on the Billing Terms form, enter the appropriate Prox 

Code. During the calculation of the due date, the "prox code" adjusts the date before the due 

days are added on. 

Prox Day  

If you specified a Prox Code value, enter the day of the month following the invoice date on 

which the voucher becomes due. 

Disc Pct  

Specify the discount percentage to be given if payment is made by the discount date. This field 

displays the default value from the Billing Terms record that is associated with the vendor's 

Terms Code, but you can change it. 

Disc Days 

Specify the number of days after the invoice date that payment of the invoice qualifies for a 

discount. This field displays the default value from the Billing Terms record that is associated 

with the vendor's Terms Code, but you can change it. The system uses this value to calculate 

the discount date. 
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Disc Date 

Specify the date on which this voucher must be paid to qualify for a discount, or accept the 

default date that is calculated. If the vendor does not offer a discount, you can clear this field. 

Due Days 

Specify the number of days after the invoice date that the invoice payment is due, or accept the 

default that is displayed from the Billing Terms record that is associated with the vendor's Terms 

Code. 

Due Date  

This field displays the date on which the invoice is due. The system calculates this date using the 

Invoice Date and the Due Days or Prox Day value, but you can change it. 

Fixed Rate 

(For non-domestic currency vendors only) Select this check box only if you want to use a fixed 

rate. Selecting this check box fixes the rate for the life of the document. 

Exchange Rate  

(For non-domestic currency vendors only) This field is enabled when the Allow Exchange Rate 

Update field is selected on the Accounts Payable Parameters form. Accept the default rate, or 

specify a new exchange rate. 

A/P Acct 

(Voucher transactions only) By default, this field displays the General Ledger A/P account 

number from the Accounts Payable Parameters form, but you can select a different account. 

(Unit Code 1-4)  

(Voucher transactions only) For each unit code that you use, you can select the applicable code 

for journal and reporting purposes. 

Reference 

The default value for this field is APRV (for Voucher transactions) or APA (for Adjustment 

transactions) plus the voucher number, but you can specify a different reference to appear in the 

journals for this transaction. 

Builder PO Originating Site 

The ID of the site where the Purchase Order Builder form was run to create this purchase order 

is displayed. 

Builder PO 

If a Builder Purchase Order number is displayed in this field, the purchase order was created 

with the Purchase Order Builder form. There may be purchase orders at different sites that are 

included under this "umbrella" order. The ordered items may be included as part of a Master Buy 

Agreement; if the quantities in the original PO are altered, the Master Buy Agreement may no 

longer be applicable for this PO. 

Builder Voucher Originating Site 
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The ID of the site where the Voucher Builder or Manual Voucher Builder forms were run to 

create this voucher is displayed. 

Builder Voucher 

If a value is displayed in this field, this voucher was generated using the Voucher Builder or 

Manual Voucher Builder forms.  

Auth Status  

Select the authorization status of the transaction. Options include Matched, Authorized or Failed.  

(Authorizor)  

Specify the name of the person authorizing the transaction. Note that you must enter a name if 

the Auth Status field is set to Authorized.  

Notes  

Optionally, you can add notes about the transaction. 

Fiscal Reporting System Type 

If this voucher is for a DAS2 vendor, specify a type  to classify the transaction. 

7 Select Actions > Save. 

Creating Vouchers with the Manual Voucher Builder 

The Manual Voucher Builder form allows you to quickly create a voucher in one or more sites for a 

single vendor's invoice. On any site, you can specify the portion of the vendor invoice amounts to 

allocate. You can enter all or some subset of the vendor invoice amounts. You may use the 

originating site as the To Site. 

1 Set up Replication Rules for the Voucher Builder category. This is a one-time setup.  

 From the Manual Voucher Builder site to the remote site(s) into which pending voucher 

transactions will be created. This allows the setup of how the system will process pending 

voucher transactions. 

 From the remote site(s) into which pending voucher transactions will be created to the 

Manual Voucher Builder site. This will replicate the necessary _all table data for validations 

performed on the Manual Voucher Builder form. 

2 Open the Manual Voucher Builder form. 

3 Enter this information in the header:  

 Vendor: Select the vendor for which you are entering the voucher. The vendor's name 

displays. 

 Invoice: Enter the vendor's invoice number for tracking purposes. 

 Invoice Date: By default, this field displays today's date, but you can change it to the date on 

which the vendor invoiced you for this transaction. 

 Distribution Date: By default, today's date displays, but you can change it to the date on 

which you want to distribute these funds. 



Accounts Payable (A/P) 

55 

 Notes: (Optional) Enter any notes about the transaction. 

 Generate Distribution: Select this check box to have the system automatically distribute the 

voucher once you process it. 

 Fixed Rate: (For non-domestic currency vendors only) Select this check box only if you want 

to use a fixed rate. Selecting this check box fixes the rate for the life of the document. 

 Currency: The currency rate displays. 

 Exchange Rate: (For non-domestic currency vendors only) Enter the exchange rate. 

 Purchase Amt: Enter the total amount of the vendor invoice you are recording. 

 Freight: Enter the freight charges. 

 Duty: Enter the duty charges. 

 Brokerage: Enter the brokerage charges. 

 Insurance: Enter the insurance charges. 

 Local Freight: Enter the local freight charges. 

 Misc Charges: Enter the miscellaneous charges. 

 Sales Tax: Enter the amount of tax for Tax System 1. 

 Sales Tax 2: Enter the amount of tax for Tax System 2. 

 Invoice Amt: The invoice amount displays. 

4 In the grid for each site, enter this information. Allocation totals display at the bottom of the form.  

 To Site: Select the target site. 

 Purchase Amt: Enter the purchase amount for the site. 

 Freight: Enter the freight charges. 

 Duty: Enter the duty charges. 

 Brokerage: Enter the brokerage charges. 

 Insurance: Enter the insurance charges. 

 Local Freight: Enter the local freight charges. 

 Misc Charges: Enter any miscellaneous charges. 

 Sales Tax: Enter the sales tax. 

 Sales Tax 2: If this field is available, enter the sales tax for Tax System2. 

 Invoice Amt: The invoice amount displays. 

5 To generate the vouchers for each site, click Process.  

If validation is successful, the system creates the pending voucher transactions in the site(s) 

specified. It generates a new Builder Voucher number based on the originating sites Purchasing 

Parameters and the last Builder Voucher number. The Builder Voucher Orig Site is set as the 

site specified on the General Parameters form where you are creating the manual voucher. 

If validation fails, the system handles the failure in one of the following ways: 

 If the To Site is equal to the Manual Voucher Builder site, or if replication is transactional, 

from the Manual Voucher Builder site to the remote site, then the system returns the error 

and does not process the transactions. 
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 If the To Site is not equal to the Manual Voucher Builder site and replication is non-

transactional, the system handles the failure only at the remote site via the error-handling 

process that has been defined for non-transactional replication. 

The new Builder Voucher number is displayed in a message when processing is complete. 

When you close the form, the system removes any unprocessed rows. 

Distributing Recurring Vouchers 

You can distribute the amount of each recurring voucher across multiple accounts in the General 

Ledger. You can distribute these recurring vouchers either manually or automatically. 

Distributing Recurring Vouchers Manually 

To manually create a voucher distribution: 

1 Open the Recurring Vouchers form. 

2 Select the desired voucher. 

3 To display the voucher in the Recurring Voucher Distribution form, click Distributions. 

4 On the Recurring Voucher Distribution form:  

 Select the vendor. 

 To add a distribution, select Actions > New. 

 Enter the following required information:  

 Amount: Enter the amount for this distribution sequence number. 

 Account: Enter the account number for this distribution sequence number. 

5 Continue adding distributions until the Distribution Total field equals the Invoice Amt field. 

Distributing Recurring Vouchers Automatically 

To automatically create a voucher distribution: 

1 Open the Recurring Vouchers form. 

2 Select the desired voucher and then select Actions > Distribution Generation.  

When you do this, the distribution uses the default purchases account from the Vendor record. If 

there is not a default purchases account on the Vendor record, then it uses the default 

purchases account from Accounts Payable Parameters. 

You need to create the General Ledger (G/L) distributions only once for each recurring voucher, 

unless the payment amount changes. 

After the recurring vouchers and their distributions are set up, then each time you run the A/P 

Recurring Voucher Generation utility, it creates a recurring voucher and posts the voucher and its 

G/L distributions to the A/P Vouchers and Adjustments form. 

NOTE: The system saves the recurring voucher's G/L distribution records until you delete the 

recurring voucher. 
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Linking a Distribution to a Project 

To associate a distribution with a project using the Recurring Voucher Distribution form, do the 

following: 

1 In the Dist Seq field, accept the default of the next available sequence number. 

2 In the Project field, select the project number for the recurring voucher. 

3 Select the task number. 

4 Select the project cost code. 

Adding Tax Information to a Distribution 

You might have to enter tax information on the Recurring Voucher Distribution form, depending 

on how the tax parameters were set up for this vendor. 

To add tax information, do the following: 

1 Select the tax system number to be used with this tax distribution. 

2 Select the tax code rate. 

3 Select the exempt tax code, if necessary. 

4 In the Tax Basis field, enter the taxable monetary amount on which the tax amount is based. 

Distributing Vouchers and Adjustments 

You can manually or automatically create distributions for vouchers and adjustments. You can also 

have the system distribute the amounts for you during the posting process. 

Manually Distributing Vouchers and Adjustments 

To distribute vouchers and adjustments manually: 

1 Open the Voucher Adjustment Distribution form. 

2 To add a distribution, select Actions > New. 

3 In the Vendor field, select the vendor whose voucher or adjustment you want to distribute. 

4 In the Voucher field, select the transaction you want to distribute. 

5 In the Dist Seq field, accept the default value of the next available sequence number.  

This number is used to order the distributions for the selected transaction. 

6 On the Allocation And Tax tab, in the Amount field, enter the distribution amount. 

7 In the Account field, select the General Ledger account to post the transaction to. 

8 If you must submit DIOT and IETU reports, specify or review this information on the Tax 

Parameters tab: 

Tax Reg Number Type 
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Specify the tax regulation number. 

DIOT Transaction Type 

Specify the DIOT transaction type. 

Tax Reg Num Foreign 

If selected, indicates that the vendor has a foreign tax regulation number. 

Deduction Percent 

Specify the percentage deducted from the voucher distribution. 

Vendor Name 

The vendor name is displayed. 

Tax Reg Num 

The tax regulation number is displayed. 

ISO Country Code 

Select the ISO-defined country name. 

These fields are only displayed for users who are assigned a Mexico Localization license. 

9 Select Actions > Save. 

10 Repeat steps 1-7 to continue distributing the transaction until the value in the Distribution Total 

field on the Amounts tab equals that of the Invoice Amt field. 

Automatically Distributing Invoices and Adjustments 

To distribute invoices and adjustments automatically: 

1 Open the A/P Vouchers and Adjustments form or the Voucher Adjustment Distribution 

form. 

2 Verify that you are working with the transaction you want to distribute. 

3 Select Actions > Distribution Generation. 

4 When prompted, to have the system generate the distributions for the displayed transaction, click 

OK. 

Generating Vouchers 

Vouchers can be generated: 

 Automatically, using the Generate A/P Transactions form 

 Manually, using the A/P Vouchers and Adjustments form 

 For multiple sites, using the Voucher Builder form 

When you generate vouchers, remember this information: 
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 Before any transactions are created, the total distributed cost of the PO must equal the sum of all 

vouchered line/releases. If they are not equal, the system displays an error message. 

 If you are creating an adjustment rather than a voucher, you must select the number of the 

voucher you are adjusting. 

 When generating an adjustment, the A/P transaction record is filled with values from the A/P 

posted transaction record. The transaction type is A, and the reference begins with APA. 

 As each line/release is processed, the Unit Cost field of the purchase order is set to the 

vouchered unit cost, and the purchase order detail costs are set to the vouchered detail costs. 

 While transactions and distributions are set, messages display if the corresponding account 

number has not been set up on the Accounts Payable Parameters form (the message is only a 

warning, and processing continues). 

 If the cost method is Actual or Standard, the system displays a message if the corresponding 

account numbers are not set for the line item. 

 The following A/P distribution transaction records are created when you generate vouchers:  

 If any miscellaneous charges were entered, an A/P transaction distribution record is created, 

using the Misc Charges account from the Accounts Payable Parameters form. The 

distribution amount is set to the miscellaneous charges amount from the voucher. 

 If sales tax was entered, an A/P transaction distribution record is created, using the Sales 

Tax Exp account from the Accounts Payable Parameters form. The distribution amount is 

set to the sales tax amount entered for the voucher. If the Active for Purchasing check box 

is selected on the Tax Systems form, the system uses the A/P Tax account from the tax 

code. 

 If a freight amount was entered, an A/P transaction distribution record is created, using the 

Freight-In account from the Accounts Payable Parameters form. The distribution amount is 

set to the freight amount entered for the voucher. 

 If the cost method is None, an A/P distribution transaction record is created for the 

distributed amount (total of the items), using either the product code's inventory account 

number (if the item has an associated product code) or the purchases account from the 

Accounts Payable Parameters form. For all other cost methods, the Vouchers Payable 

account is used. The distribution amount is set to the amount vouchered (the total cost of the 

items). 

 Finally, an A/P transaction record is created for the total cost of the items (including freight, 

miscellaneous charges, and sales tax), using the Accounts Payable account from the 

Accounts Payable Parameters form. 

 The distribution amount is set to the total of the miscellaneous charges, freight, sales tax, 

and cost of the items. At that time, the system creates a voucher register record with a line 

item for each line release being vouchered.  

After the vouchers are posted in A/P, you can view the completed transactions using the 

Journal Entries form, by selecting the A/P Dist journal option. 

 The PO line/release quantity vouchered is set to the quantity received minus the quantity 

returned. 

 The PO line/release quantity returned is set to zero. 
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When all transactions and distributions are created, the system displays a message indicating that 

the process is complete. 

Generating Landed Cost Vouchers 

After you receive your purchase order, you can voucher your landed costs (duty, freight, brokerage, 

insurance, and local freight). 

1 Open the Generate Landed Cost Vouchers form. 

2 Select the vendor number and any other pertinent information in the form's header. 

3 Click the filter-in-place button.  

In the header of the Receipts tab, the system displays a list of all receipts that meet the criteria 

you entered. 

4 To select:  

 All the receipts displayed, click Select All. 

 One or more individual receipts, select the Select check box for each receipt. 

To ensure that you are selecting the correct line items and view the selected line item's details, 

you can click the Detail button, which opens the appropriate purchase order line/release form. 

NOTE: If you select multiple records, they must all have the same exchange rate. 

5 To allocate any landed costs you entered in the header across all selected PO receipt records, 

click Cost Allocation.  

This determines the ratio of each individual domestic landed cost to the total domestic landed 

cost and then applies that ratio to the foreign translated amount. If the foreign translated amount 

column sum is not equal to the total of the duty, freight, brokerage, insurance, and local freight 

amounts in the header, the system generates a warning. 

After you allocate costs, you can still change the landed cost on individual landed cost PO 

receipt lines before you post. 

6 (Optional) Use the Taxes tab to generate and modify the tax distributions. Tax distributions 

should be specified after all landed cost records have been selected. For more information, see 

"Taxes," below. 

7 To generate the voucher for the selected receipts, click Generate Voucher. When this process 

complete, the system displays a message showing the number of vouchers created successfully.  

After you generate the voucher, the system updates the actual landed cost amounts to the 

respective POs in order by type. 

NOTE: After you generate landed cost vouchers, you cannot update them in A/P. 

8 Post the landed cost vouchers just as you would post vouchers for material. 

9 (Optional) Run the Landed Cost Variance Report. 
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Variances 

When you run the Generate Landed Cost Vouchers activity for POs, variances are written to the 

PO Distribution Journal: 

 For non-inventory items, the system calculates variances between the vouchered amount and 

the PO line item amount. 

 For inventory items, the system variances between the vouchered amount and received amount. 

Taxes 

The Taxes tab is enabled when the Active for Purchasing check box is selected on the Tax 

Systems form for at least one tax system. If the Taxes tab is enabled, you can enter tax amount(s) 

from the vendor's invoice, or other amounts as required, in the Sales Tax field(s) on the header. 

NOTE: The label for the Sales Tax field is user-defined. 

Area-Based Tax Systems 

To calculate the sales tax for each selected voucher line on the Receipts tab and create a pending 

tax transaction line, on the Taxes tab, click Generate Tax. The activity displays the total of the line 

amounts in the Sales Tax field(s) on the Taxes tab and provides the option of copying the sum(s) to 

the header. 

To add a tax amount that was not created in the generation process, create a new tax transaction 

line. 

Item-Based Tax Systems 

Tax distributions for an item-based tax system, where no area-based system is defined, should be 

entered manually. If you enter the tax distribution manually, do not click the Generate Tax button. 

Exchange Rate 

For a description of how the landed cost exchange rate is calculated, see the Exchange Rate topic. 

Generating Recurring Vouchers 

To create the vouchers and distributions for the current payment cycle, use the A/P Recurring 

Voucher Generation utility. Use the existing recurring vouchers and distributions as the templates 

to create the current vouchers and distributions. 

NOTE: If you have not posted the previously created voucher, you cannot create a new voucher 

from a recurring voucher for a vendor. 

To generate recurring vouchers: 

1 Enter information in the following fields:  

 Starting and Ending Vendor: Enter the range of vendors for which you want to generate 

vouchers from their recurring vouchers. 
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 New Voucher Month: The current month number displays by default, but you can change it 

to a different number of the month for which you want to generate recurring vouchers. 

 New Voucher Year: The current year displays by default, but you can change it to a different 

year for which you want to generate recurring vouchers. 

 Distribution Date: The current system date displays by default, but you can change it to the 

date you want to assign to the generated voucher.  

NOTE: If the date you enter is outside of the current period and you have not activated Enter 

Out of Date Range authorization, the system stops processing the vouchers and displays an 

error message. 

2 Click Process. 

You can view the generated vouchers using the A/P Vouchers and Adjustments form. 

Posting Vouchers - Detail 

What Happens During Posting 

Posting does the following: 

 Updates vendor records 

 Creates posted transactions 

 Updates the voucher register 

 Updates the G/L journal 

During posting, the system performs these steps: 

1 Adds the invoice amount to the Purchases YTD field on the Vendors or Multi-Site Vendors 

form for each posted transaction. For a voucher, the Last Purchase Date field on the Vendors 

or Multi-Site Vendors form is updated with the distribution date, provided that the distribution 

date is after the Last Purchase Date. 

2 Creates a posted transaction record for each voucher transaction, and updates the 

corresponding posted transaction record for each adjustment transaction. 

3 Creates a voucher register record for each transaction that is not posted from PO. For each 

transaction, one voucher register distribution record is created for the A/P account, and one is 

created for each posted distribution record. 

4 Creates G/L journal entries for all A/P transactions, whether generated in PO or created in A/P. 

Printing and Posting Vouchers 

To print and post vouchers: 

1 If your company uses the Voucher Authorization feature, run the Voucher Authorization utility 

before posting the approved transactions.  
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NOTE: Running the Voucher Authorization utility is not required before posting transactions. 

The posting process allows you to post vouchers with authorization statuses of Approved and/or 

Matched. 

2 On the A/P Voucher Posting form, provide information in the following fields:  

 Authorization Status: Select from the drop-down list the authorization status of the 

vouchers you want to post. 

 Sort By: Select from the drop-down list the order in which you want records to be created in 

the posting table, and listed in the report and grid. 

 Display Voucher Totals: If you want to include voucher totals in the report, select this check 

box. 

 Starting and Ending Vendor Number: Select the range of vendor numbers whose 

vouchers you want to post or, to process vouchers for all vendors, leave both fields blank. 

 Starting and Ending Voucher: Select the range of vouchers or, to process all vouchers, 

leave both fields blank. 

 Starting and Ending Due Date: Select the first and last due dates for vouchers you want to 

include or, to process vouchers for all due dates, leave both fields blank. 

 Starting and Ending Distribution Date: Enter the first and last distribution dates to include 

or, to process vouchers for all distribution dates, leave both fields blank. 

3 To print and review the A/P Voucher Posting report, select Print. 

4 When you are ready to post the vouchers, select Commit and then click Process. 

You can view the posted vouchers using the A/P Posted Transactions Detail and A/P Posted 

Transactions Summary forms. 

NOTE: If you use the External Financial Interface, additional processing may occur during voucher 

posting. For more information, see "Setting Up an External Financial Interface." 

Purging Voucher History 

To delete records associated with posted transactions from voucher history and free up space in 

your database, use the Purge Voucher History utility. 

1 Open the Purge Voucher History form. 

2 In the Ending Voucher field, select the last voucher you want to purge, or, to delete all 

vouchers, leave this field blank. 

3 In the Ending Invoice Date field, select the most recent date of the invoices you want to purge, 

or, to delete invoices of any date, leave this field blank. 

4 If you want to delete only the line items of the vouchers and not the header information, select 

the Delete Line Items Only check box. 

5 The system does not purge voucher headers associated with unposted A/P transactions or POs 

with a status of Planned or Ordered. If you want the system to display an error message every 

time it finds a voucher that cannot be purged, select the Show Unpurgable Vouchers check 

box. 
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6 To purge voucher history, click Process. 

NOTES:  

 To deactivate A/P posted transactions before purging, you must use the Activate/Deactivate 

Posted Transactions - A/P utility. 

 Also, purging the voucher history does not remove the voucher and payment from the A/P 

Posted Transactions Detail form. To do that, you must run the Delete A/P Posted 

Transactions utility before purging the vouchers. 

Using Cancellation Posting for a Voucher Adjustment 

You can cancel a posted voucher one time. The entire amount of the original voucher is cancelled; 

partial adjustments cannot be made.  

1 Open the General Parameters form and make sure Enable Cancellation Posting is selected.  

2 Open the A/P Vouchers and Adjustments form and click the filter-in-place button.  

3 Select Actions > New.  

4 Specify this information:  

Vendor  

Specify the vendor for which a voucher must be cancelled.  

Type  

Specify Adjustment.  

Cancellation  

Select this check box.  

Voucher  

Specify the voucher to which to apply the cancellation. The list of posted vouchers to which you 

can apply cancellation posting does not include those that are referenced by posted adjustments 

or payments.  

Amounts and Discount Date and Due Date from the original posted voucher are entered 

automatically and cannot be changed.   

5 Complete the voucher and save the record. 

Voucher Pre-Register Overview 

The VAT (Value Added Tax) captures information about the value of intra-community sales and 

purchases. Voucher Pre-Register allows the VAT to be recognized as soon as the supplier ships the 

material. 

The information on the Voucher Pre-Register form does not require a specific purchase order. 

Once the voucher pre-register has been created, the system posts the pre-register and creates 
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journal entries using a new suspense account. When you are ready to voucher the material (after 

receiving it), you can associate the voucher with one of the pre-registers. When you post the 

voucher, the system changes the voucher pre-register to a status of Closed and creates the 

appropriate journal entries. 

If the Recognize VAT check box is selected on the Accounts Payable Parameters form (Misc 

tab), the pre-register date becomes the journal entry date, and the following journal entries occur: 

Planned to Posted 

Field Debit Credit 

Suspense Acct ### Material portion from pre-register. 

Freight ###   

Misc. Charges ###   

Tax 1 ### There will be a debit for each Tax 

Distribution. 

Tax 2 ###   

A/P Unmatched   ### 

If the Recognize VAT check box is not selected, the following journal entries occur: 

Field Debit Credit 

Suspense Acct ### Material + Tax portion from pre-register. 

Freight ###   

Misc. Charges ###   

A/P Unmatched   ### 

If a voucher is associated with a pre-register and the voucher is posted, the status of the pre-register 

changes from Posted to Closed, and new journal entries are created to back out the original entries. 

You can also manually change the pre-register status to Closed to create the offsetting journal 

entries. 

If the Recognize VAT check box is selected on the Accounts Payable Parameters form, the 

voucher date becomes the journal entry date, and the following journal entries occur: 
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Posted or Matched to Closed 

Field Debit Credit 

Suspense Acct   ### 

Freight   ### 

Misc. Charges   ### 

Tax 1   ### 

Tax 2   ### 

A/P Unmatched ###   

If the Recognize VAT check box is not selected, the following journal entries occur: 

Field Debit Credit 

Suspense Acct   ### (Material + Tax) 

Freight   ### 

Misc. Charges   ### 

A/P Unmatched ###   

Pre-register can hold one of four different status types: 

 Planned: If the pre-register status is Planned, the pre-register is in the process of being created, 

or it has been created but is not yet posted. 

 Posted: If the pre-register status is Posted, the pre-register has been posted. The only way to get 

a status of Posted is to manually change the status from Planned to Posted. Journal entries are 

created upon saving the status. 

 Matched: If the pre-register status is Matched, the pre-register has been entered and saved 

either on the Generate AP Transactions form or the A/P Vouchers and Adjustments form. 

 Closed: If the pre-register status is Closed, the status of the pre-register number has been 

changed manually to Closed or changed to Closed by the system. The system changes the 

status of a voucher pre-register to Closed when a voucher is posted that has a pre-register 

number. When the status is changed to Closed, journal entries are created to back out the 

original journal entries. Once the status of the pre-register is Closed, it cannot be updated. The 

pre-register can be deleted by clicking the Delete button on the toolbar or by using the Delete 

Voucher Pre-registers utility. 
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Deleting a Voucher Pre-register 

The Delete Voucher Pre-Registers utility deletes all voucher pre-registers within a specified range. 

The voucher pre-register must have a status of Closed before it can be deleted. All voucher pre-

register distributions for the range of voucher pre-registers are also deleted. Deleting voucher pre-

registers removes all information about the voucher pre-registers, and affects tax reporting. 
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Accounts Receivable (A/R) 

Accounts Receivable Steps 

Accounts Receivable (A/R) is the process you use to invoice customers for services you rendered or 

goods you provided to them. You also use A/R to process customer payments and track 

discrepancies. A/R is closely linked to Customer Service, where you enter orders and track customer 

interaction. 

The basic steps for A/R are listed here. See the linked help topics for more information. 

1 Create an invoice, debit, or credit memo in A/R (Eliminate residual balances by generating debit 

or credit memos).  

NOTE: You should create most invoices through Customer Service. Use A/R to enter only those 

invoices, debit memos, and credit memos that do not result from the sale or return of inventory 

items. 

2 Distribute invoices. 

3 Post invoices, debits, and credit memos. 

4 Enter customer payments (Enter customer payments using Quick Payments). 

5 Distribute customer payments. 

6 Post payments. 

7 Run the A/R Aging Report. 

8 Generate and post finance charges. 

9 Rebalance customer balances. 

10 Close the year for Accounts Receivable. 

About A/R Posting 

During posting, the system updates three types of records: 

 Customer Master records 

 Open Item records 

 G/L Journal records 

Following is a summary of the posting process: 

 The system updates two fields of the Customers file for each transaction posted. 
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 If the receipt date for the payment transaction is later than the last payment date in the 

Customers file, the receipt date becomes the new last payment date. 

 The system reduces the Customer Posted Balance amount by the payment amount and any 

discount or allowance you give to the customer. 

 The system creates an Open Item record for each transaction being posted. 

 The system creates A/R Ledger Distribution Journal records. 

 For each transaction, there is one journal record for the cash amount and one transaction for 

each distribution record you enter. 

 While posting payments, the system recalculates the Customer's Days Outstanding fields for 

customers with an Open Item Balance Method. The values change if the payments being posted 

fully pay an invoice. 

 The system enters multi-currency gains and losses in the A/R journal (if applicable). 

 When posting multiple checks, wires, and adjustments, a summary entry is created on the Bank 

Reconciliations form. You can also post checks, wires, and adjustments individually to create 

individual bank reconciliation entries. 

About Credit for Returns 

Determining How Much Credit to Issue 

The decision about how much credit to issue is made when the customer is authorized to reject 

material on the RMA Line Items form. Factors that enter into the calculation of the credit include: 

 Quantity to Return: You enter the number of items for which return is authorized. If the material is 

referenced to a customer order and line item, then the quantity returned cannot be greater than 

the quantity invoiced. If the item is serial-tracked, then the quantity returned must be a whole 

number. 

 Unit Credit: You can enter the credit which you authorize for each unit returned. The default is 

the cost associated with the item on the original customer order, if known, or the cost taken from 

current pricing routines if the item is inventoried. 

 Restocking Fee: Your company can elect to charge customers a small fee for the staff time it 

takes you to process the returned material. This fee is often called a restocking fee, but you can 

call it something else on your credit memos simply by changing the name in the Description 

field of the RMA Parameters form. The system calculates the restocking fee based on the 

Restocking Fee % stored on the RMA Parameters form to provide a Restocking Fee amount. 

This percent and amount can be overwritten. Overwriting either one will cause the other to be 

recalculated. 

NOTE:  

 If an RMA line item references a valid customer order and line, then an attempt is made to 

back out the commission given on the original order by the RMA amount. In the calculation of 

the commission to reverse, the restocking fee is not included. 
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 All invoicing (and crediting) must be done at the shipping site. All accounts receivable and 

inventory transactions also occur at this site. 

Printing and Posting the Credit 

RMA Status Report 

First, to preview all RMA line items that are ready to be credited, run the RMA Status Report. RMA 

line items appear on the RMA Status Report when: 

 The Return check box is selected and the quantity returned is greater than the quantity credited 

thus far, OR the Return check box is cleared and an amount remains to be credited. 

 RMA line items have a status of Open or Filled. (RMA line items with a status of Closed or 

History cannot be printed or posted.) 

 The RMA associated with the RMA line item has a status of Open. (Items associated with 

headers which have a status of Stopped, Closed, or History cannot be printed or posted.) 

After reviewing the records pulled by the report, you might want to modify the range of RMA 

numbers or of RMA dates, to eliminate records that should not be receiving credit memos at this 

time. 

RMA Credit Memo 

Second, to print RMA credit memos and to post the credits to Accounts Receivable, perform the 

RMA Credit Memo activity. 

Printing: The RMA credit memo is printed on the same special form as the standard invoice. The 

words RMA CREDIT will print beneath the header information to differentiate the two documents. 

 Form alignment: You can print a sample credit memo using Xs and 9s to represent data fields. 

 Restocking Fee: The restocking fee will print on the RMA credit memo with the label defined by 

you on the RMA Parameters form. If you do not charge your customers a fee to return 

merchandise, do not enter any label in the Description field on the RMA Parameters form. That 

way, no label prints on the credit memo. 

 Multi-lingual credits: If the customer is flagged for multi-lingual invoices, the credit memo will 

automatically be printed using the same language for labels. 

 Non-domestic currency: The amount posted is always credited in the customer's currency, even 

if the amount printed on the credit memo was translated to the domestic currency. 

 Preprinted forms: Be sure to specify whether you use new Moore forms (the default) or the 

previously available (old) Moore forms. 

 Pre-numbered forms: If your company uses preprinted and pre-numbered forms, the maximum 

number of lines allowed per credit memo is defined on the Accounts Receivable Parameters 

form. The invoice headers are the same but the credit memo number changes. Also, the total 

amount prints in words on the footer. 
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Posting: As part of the posting process, the status of all RMA line items that have been fully 

credited is automatically changed to Closed. If all RMA line items associated with an RMA 

header have a status of Closed, then the RMA header status is also changed to Closed. 

 Accounts: The account numbers which will be debited and credited when you post credits are 

pulled as follows:  

 If the item exists in the Items form, from the End User Type (if specified) or the Distribution 

Account record 

 If the item does not exist in the Items form, from the End User Type (if specified) or 

Accounts Receivable Parameters (sales discount account and unit codes) form. 

Adjustments Calculated by the System 

Associated adjustments: When customers reject material for which they received a discount, or for 

which a sales representative received commission, then the system adjusts those calculations where 

possible. 

Both the order level and line item level sales discounts (if any) given on the original customer order 

will be backed out if: 

 The original customer order and line are known. 

 The item on all RMA line items matches the item on the associated customer order line items. 

NOTE: The amount of sales discount to back out is adjusted to reflect any differences in the unit 

price on the original order and the unit credit on the RMA line. 

The amount on which the sales commission is figured is adjusted by the amount of the credit (prior 

to the application of the restocking fee) if: 

 The RMA line item references a valid customer order (including History orders) and line. 

 The RMA line item exists in the Items form and is the same as the item on the original customer 

order. 

 There were commissions associated with that particular item on the original customer order. 

Accounts Receivable: When you print an RMA credit memo, the document is assigned a number 

which prints in the Invoice No space. However, the RMA credit appears in Accounts Receivable as 

an open credit, with an invoice number of 0. 

About Rebate Programs 

Infor CloudSuite provides functionality for setting up and maintaining rebate programs to give your 

customers incentives for buying. These rebate programs allow your customers to earn payment 

credits to use in the future. 

For more information about Infor CloudSuite rebate programs, refer to these topics: 

 Promotion Pricing and Rebate Programs Overview 

 Setting Up Promotion Pricing and Rebate Programs 
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 Maintaining Earned Rebates 

 Processing Earned Rebates 

 Closing Rebate Programs 

About A/R Direct Debits 

Using the SEPA (Single Euro Payments Area) direct debit functionality, you can automatically collect 

payments from a customer using a SEPA file.  

After a direct debit A/R payment is posted, the DebitTransfer BOD is populated. The BOD is 

processed by Local.ly, which then uses the data to create a SEPA file for bank collection. This SEPA 

file is sent to the bank, informing the bank to move the funds from the customer account to the user's 

account. This file is sent to the user's bank for direct debit, where the money is collected from  the 

customer's bank. Upon receiving a bank statement, you must manually enter direct debit deposits on 

the Bank Reconciliations form.  

Outside Infor CloudSuite 

You must perform these tasks outside the ERP system before utilizing the direct debit functionality: 

 Obtain a signed SEPA mandate from the customer. 

 Apply for and obtain a SEPA creditor identifier number. 

 Obtain your and your customer's IBAN and BIC numbers. 

General Set Up 

1 On the Chart of Accounts form, add any new accounts for direct debit receivables. 

2 On the Accounts Receivable Parameters form, specify the SEPA creditor identifier number 

and direct debit account information. 

3 Optionally, on the End User Types form, specify the direct debit account information. 

4 On the Customers form, set the payment type to direct debit.  

Specify the bank code, customer bank code, customer IBAN, and customer SEPA mandate 

information. Optionally, specify the end user type. 

5 On the Bank Reconciliations form, specify the BIC and IBAN values for your company bank 

and the BIC value for the customer's bank.  
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Chargebacks Overview 

The chargebacks functionality allows you to approve or disapprove a non-full payment from 

customers who may take a chargeback for reasons that include but are not limited to damage, 

lateness, or improper packaging. 

Use these forms with this functionality: 

 Accounts Receivable Parameters 

 Chargeback Types (and the associated Chargeback Types Query form) 

 Chargebacks 

 A/R Payment Distributions 

 A/R Quick Payment Application 

Clearing Offsetting Open Items in Accounts Receivable 

In order to get open items off of the A/R Aging Report, they need to be applied to an invoice. 

If an invoice does not already exist that would be appropriate for applying the open items, then you 

need to create an invoice for zero dollars, and do reapplications of the open debit item(s), open 

credit item(s), or open payment(s) to that invoice. 

If one or more of the items are open credits or debits, then you will need to use one of the following 

procedures. 

Reapplying an Open Debit or Credit to One Invoice 

1 Open the A/R Posted Transactions Detail form. 

2 Filter for both Customer and Open Credit. 

3 In the Invoice field, either enter or select the invoice to apply the open debit or credit. 

4 Click Save. 

Reapplying an Open Credit to More Than One Invoice 

1 From the A/R Posted Transactions Detail form, determine the chk/ref number of the credit 

memo you wish to reapply. 

2 Add the customer number and chk/ref number of your open credit.  

NOTE: The receipt date normally would not be changed. Credits are already against Accounts 

Receivable and no journal entries will be created as a result of this reapplication. 

3 Click Save. 

4 Go to the A/R Payment Distributions form. 
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5 Add as many invoices as required to distribute the credit amount. 

6 Perform A/R Payment Posting to post the reapplication. 

7 If one of the items is an open payment transaction, then you will need to do the following:  

 Determine the customer number and check number from A/R Posted Transaction Detail 

form. 

 Open the A/R Payments form. 

 Enter Customer Number and Check Number. You should see RE-APPLICATION OF OPEN 

PAYMENT beside the G/L Reference. If this does not appear, stop here and re-examine the 

check number being entered. 

 The date of the check should be changed to the current date. A journal entry will be created 

as a result of the reapplication. The entry will debit the A/R Deposit Account and credit the 

Accounts Receivable Account. 

 Go to the A/R Payment Distributions form, enter the zero dollar invoice number as required 

to distribute the Open payment. 

 Perform A/R payment posting. 

Closing the Year for Accounts Receivable 

To close an accounts receivable (A/R) period or a year, use the A/R Period/Year End Procedure 

utility. This utility clears the customer period-to-date information, or both the period-to-date (PTD) 

and year-to-date (YTD) information. In addition, you can use it to clear the salesperson PTD or YTD 

information. Finally, this utility also updates customer records to reflect the change of year. 

To close a period or the year for A/R: 

1 Open the A/R Period/Year End Procedure form. 

2 Enter the appropriate information in these fields:  

 Customers, Salespersons, Both:  

 To process only records for selected customers, select Customers. 

 To process only records for selected salespersons, select Salespersons. 

 To process both customer and salesperson records, select Both. 

 Statement Cycles: Select the statement cycles you want to process. Options include: 

Weekly, Monthly, Quarterly, or All. 

 Zero PTD Only: If you want to start a new period and clear only the period-to-date 

information, select this check box. If you want to clear all year-to-date information, clear this 

check box. 

 Starting and Ending Customer: Enter the range of customers you want to process. To 

process records for all customers, leave both these fields blank. 

 Starting and Ending Salesperson: Enter the range of salespersons you want to process. 

To process records for all salespersons, leave both these fields blank. 

3 Click Process. 
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Deleting A/R Posted Transactions 

To delete accounts receivable (A/R) transactions that have been posted: 

1 Open the Delete A/R Posted Transactions utility form. 

2 Enter information in these fields:  

 Through Date: Enter the date through which to delete A/R transactions, or accept the 

default, which is the current system date. 

 Statement Cycles: Enter the statement cycles for which you want to delete A/P 

transactions. Options include: Weekly, Monthly, Quarterly, or All.  

NOTE: With the exception of All, these options cause the utility to process only those records 

for which the statement cycles match. For example, if you select Weekly, then only the 

records with a statement cycle setting of Weekly are processed. Records tagged for Monthly 

or Quarterly cycles do not get processed. 

 Starting and Ending Customers: Enter the range of customers for which you want to delete 

A/R transactions. To delete A/R transactions for all customers, leave these fields blank. 

 Preview/Commit:  

 To view the results of running the utility without saving the results in the database, select 

Preview. 

 To save the results in the database, select Commit. 

3 Click Process. 

Using Chargebacks Functionality 

A chargeback is the amount a customer deducts from a payment for reasons including but not 

limited to damage, lateness, or improper packaging. 

To use this functionality: 

1 Establish Chargebacks and Chargebacks Deposit accounts on the Accounts Receivable 

Parameters form. 

2 Define chargeback types on the Chargeback Types form. The types are the reasons why a 

customer might apply a chargeback. 

3 Use the Chargebacks form to quickly enter chargeback data. You can specify the amount, 

choose the type, see invoice, credit memo, and status information, and set that status to 

approve, pending, or denied. 

4 At this point you can either: 

 Record a payment on the A/R Payments form and on the A/R Payment Distributions form 

and then, while still on the A/R Payment Distributions form, click the Distribute 

Chargebacks button for the appropriate customer to populate the Chargeback Amount field 

with the amount to be distributed, or 
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 Enter the payment amount on the A/R Quick Payment Application form and then click the 

Apply button to apply any chargebacks from the Chargebacks form. 

5 Use the A/R Payment Posting form to post like you would for any other payments or 

distributions. For chargebacks that were approved on the Chargebacks form, the process on the 

A/R Payment Posting form creates and posts credit memos tied to an invoice for each 

chargeback amount. If the chargeback is approved after the payment is posted, a credit memo is 

created and posted. The credit memo is tied to the chargeback manual invoice. 

Invoice, Credit or Debit Memo 

About Multiple Due Dates for Invoices and Debit Memos 

Creating multiple due date payment terms allows you to set up an invoice payment schedule for 

customers. 

NOTE: The system does not support multiple due dates for billing terms when running the Infor 

CloudSuite Industrial  Enterprise Financials Interface package. 

Multiple due dates can be set up for the following: 

 Invoices generated from customer orders and manually entered on the Invoices, Debit and 

Credit Memos form. 

 Debit memos generated from the Price Adjustment Invoice form and manually entered on the 

Invoices, Debit and Credit Memos form. 

The successful use of multiple due dates depends on creating billing terms with multiple due dates 

and percentages, and selecting the appropriate billing terms for customers and customer orders. 

Billing Terms Setup 

To use multiple due dates, create a new terms code on the Billing Terms form. On this form, you 

indicate that you want to use multiple due dates by selecting the Use Multiple Due Dates check 

box. You can create more than one terms code that uses multiple due dates. 

System-generated debit memos from the Price Adjustment Invoice form should have multiple due 

dates if the terms code being used is a multiple due date terms code. 

You can use prox days and Advanced Terms in a multiple due date terms code. However, you 

cannot create billing terms with Discount Days. 

A multiple due dates terms code includes the following: 

 Sequence: Sequence is used internally to track the sequence of the multiple due date record 

and is assigned by the system. The first sequence starts with 10 and the next/subsequent 

sequences at increments of 10. The due date calculation takes place normally, using the due 

days from billing terms. You must enter more than one sequence. 
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 Due Days Offset: Number of days from the previous due date sequence of the billing terms. The 

offset day in the first sequence is always equal to zero. 

 Percent: The total of all sequence records for the multiple within a billing terms code must equal 

100 percent. 

Customers and Customer Orders 

Once a new terms code is created, it is immediately available. The default billing terms code is set 

up on the Customers form, but it can be changed on the Customer Orders, Price Adjustment 

Invoice, or Invoices, Debit and Credit Memos forms. 

You should not assign a multiple due date terms code to a customer and customer order where the 

following options are used: 

 Letter of Credit Required 

 Consolidated Invoicing 

 Payment Type is Draft 

If these options are selected, the system displays an error message. 

Invoicing 

Once the customer order has been shipped, the system generates the invoice and calculates the 

invoice payment schedule according to the settings in the terms code. Multiple due date records are 

assigned to the invoice for as long as the invoice exists. If an invoice is deleted, the system deletes 

all due date records for that invoice. If the terms code is modified, the system recalculates the due 

dates and creates new due date records for the invoice. 

On the Invoices, Debit, and Credit Memos form, you can adjust the amounts and due dates after 

the invoice is created, but the total due amount must still equal the total invoice due amount. On the 

A/R Posted Transaction Detail form, you can only update the due date. 

NOTE: If the customer uses revision and pay dates for invoices, the system adjusts the invoice due 

dates to consider the revision and pay days. Revision and pay days are set up on the Customers 

form, Revision/Pay tab. 

To create invoices or debit memos with multiple due dates on the Invoices, Debit, and Credit 

Memos form, use the Generate Distributions function to create the sequence of due dates and 

amounts. 

Invoicing Examples 

The following examples show how multiple due dates are set up and invoiced. The second example 

uses prox days and prox codes. 

EXAMPLE: There are four sequences defined. The invoice date is May 5. For Billing Terms, the due 

days offset is 30 days. The following table shows how the system calculates the due date. 
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Sequence      

Due Days 

Offset      Percent      Final Due Date 

10 0 25 June 5 (May 5 plus 30 days) 

20 30 25 July 5 (May 5 plus 60 days) 

30 30 25 August 3 (May 5 plus 90 days) 

40 30 25 September 1 (May 5 plus 120 

days) 

EXAMPLE (Advanced Terms): There are three sequences defined. The invoice date is May 5. For 

Billing Terms, the due days is 30, prox code is 2 (system sets the due date to the end of the month), 

and prox days are 15 (day of the month). The following table shows an example of how you can 

divide the billing and how the system calculates the amount to pay and the due date. 

Sequence      

Due 

Days 

Offset      Percent      

Invoice 

Due 

Date      

Prox Code 

Applied      

Final Due Date with Prox 

Days Applied      

10 0 30 June 4 June 30 July 15 

20 30 30 July 3 July 30 August 15 

30 30 40 August 

3 

August 31 September 15 

Viewing Due Date Records for an Invoice 

You can view the list of due dates for an invoice by clicking Multiple Due Dates on the following 

forms: 

 Invoices, Debit and Credit Memos 

 A/R Posted Transaction Detail 

 A/R Quick Payment Application 

Applying Payments to Invoices 

When you make payments using the A/R Payments form, if there is more than one due date 

amount applied to the same invoice, the system creates one record per payment per invoice. 
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When you make payments using the A/R Quick Payment Application form, the system applies 

payments to each due date in chronological order regardless of when they were received. The 

earliest due date is always paid first. 

EXAMPLE: For example, an invoice I101 has 3 due date records: 

1 Due date = May 10 Due amount = $200 

2 Due date = June 10 Due amount = $100 

3 Due date = July 10 Due amount = $100 

A payment of $250 is applied to this invoice and one record of type Payment is create for $250 for 

invoice I101. When the system needs to display the aging of the invoice that is not fully paid, it: 

 Looks up all the records for invoice I101 

 Takes the payment and credit memo 

 Totals the amount 

 Applies that amount to the earliest due date 

In this example, take the payment record of $250 and apply that to the first due date record and then 

the second due date record. The A/R Aging Report shows the following due records for invoice 

I101: 

 Due date = June 10 Due amount = 50 

 Due date = July 10 Due amount = 100. 

Applying Debit Memos to Invoices 

You can also create debit memos with multiple due dates, either manually or automatically. If the 

debit memo is automatically generated, you can update it using the Invoices, Debit, and Credit 

Memos form before posting. After it is posted, you can view it in the A/R Posted Transaction Detail 

form, just like an invoice. When the debit memo is applied to an invoice, it is processed with the 

invoice for A/R payment processing and aging for reports and customer statements. 

There are three ways debit memos can be applied to invoices when either or both have multiple due 

dates: 

 For a debit memo with a single due date applied to an invoice with multiple due dates, the debit 

memo is applied to the first due date. 

 For a debit memo with multiple due dates applied to an invoice with multiple due dates, the total 

debit memo is applied to the first due date record of the invoice. 

 For a debit memo with multiple due dates applied to an invoice with a single due date, the total 

of the debit memo due amount is applied to the first due date record of the invoice. 

Canceling Drafts 

To cancel previously printed drafts from the print invoice credit/debit memo transaction, use the A/R 

Draft Cancellation form. 
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To restrict your report output, you can fill in the fields. To cancel all drafts, leave all fields blank. 

1 In the Starting and Ending Customer fields, enter the customer ID range for the drafts to 

cancel. 

2 In the Starting and Ending Draft Number fields, enter the draft number range for the drafts to 

cancel. 

3 Do one of the following:  

 To preview the results before writing them to the system, select Preview. 

 To write the changes to the system, select Commit. 

4 Click Process. 

Distributing Invoices 

You can distribute invoice amounts to multiple General Ledger (G/L) accounts, using any of three 

methods: 

 Automatic Distribution 

 Manual Distribution 

 Reapplication of an Open Credit 

Automatic Distribution 

1 On the Invoices, Debit and Credit Memos or Invoices, Debit and Credit Memos G/L 

Distribution form, select the record for the invoice you want to distribute. 

2 Select Actions > Generate Distributions. 

NOTE: The default G/L accounts from the Accounts Receivable Parameters form and the 

customer's tax code are used. 

Manual Distribution 

1 On the Invoices, Debit and Credit Memos G/L Distribution form, select Actions > New. 

2 Select the customer for which you are adding a distribution. 

3 Select the number of the invoice you are distributing. 

4 In the Dist Seq field, accept the default, which is the next available sequence number.  

This number is used to order the distributions. 

5 In the Tax System field, select the tax system for the distribution; or, for a non-tax distribution, 

leave this field blank. 

6 In the Dist Amount field, enter the amount of the distribution. 

7 In the Account field, select the account to post the distribution to. 

8 Select Actions > Save. 
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9 To continue adding distributions until the Total Remaining field is 0 (zero), repeat these steps 

as necessary. 

Reapplication of an Open Credit 

1 On the A/R Posted Transactions Detail form, locate the open credit you want to reapply. 

2 Make a note of the customer, debit or credit transaction, check/reference number, and invoice 

number associated with the transaction. 

3 Follow the remaining steps in the topic Reapplying Open Payments. 

Posting Invoices, Debit Memos, and Credit Memos 

To post invoices, debit memos, and credit memos: 

1 Open the Invoice Posting form or the Multi-Site Invoice Posting form. 

2 Indicate whether you want to post invoices, debit memos, and/or credit memos. You can select 

more than one. 

3 Select how you want to sort and display the report data. By default, the system posts 

transactions for all customers, but you can further refine your posting by selecting ranges of 

customers, invoices, and dates. On the Multi-Site Invoice Posting form, you can also refine by 

builder invoice. 

4 To print the report, click Process.  

NOTE: You must first print the posting report before you can post transactions. By default, the 

Print option is automatically selected when you open this form. 

5 After reviewing the report, select the Commit option. 

6 To post the transactions, click Process. 

7 When prompted to proceed, click OK. 

If errors are detected in a transaction, the system displays a message indicating that not all 

transactions were posted. 

NOTE: If you use the External Financial Interface, additional processing might occur during invoice, 

debit memo or credit memo posting. For more information, see "Setting Up an External Financial 

Interface." 

Using Cancellation Posting for a Credit Memo 

You can cancel a posted invoice one time. The entire amount of the original invoice is cancelled; 

partial credit memos cannot be made.  

1 Open the General Parameters form and make sure Enable Cancellation Posting is selected.  

2 Open the Invoice, Debits and Credit Memos form and click the filter-in-place button.  
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3 Select Actions > New.  

4 Specify this information:  

Customer  

Specify the customer for which an invoice must be cancelled.  

Type  

Specify Credit Memo.  

Cancellation  

Select this check box.  

Apply To Invoice  

Specify the invoice to which to apply the cancellation. The list of posted invoices to which you 

can apply cancellation posting does not include those that are referenced by a posted credit 

memo, debit memo, or payment.  

Amounts from the original posted invoice are entered automatically and cannot be changed.   

5 Complete the credit memo and save the record.  

A/R Payments 

Accepting Customer Payments in the Euro Currency 

If your domestic currency is the euro, or if a customer has converted to the euro, you can accept 

customer payments in the euro currency. 

You can accept payments in the customer's currency, the euro currency, or your domestic currency. 

To accept payments in the euro, follow these steps: 

1 Set up a bank reconciliation account for the euro currency on the Bank Reconciliations form. In 

the Currency field, enter the currency code for the euro that you entered on the Currency 

Codes form.  

NOTE: If none of your customers has converted to the euro currency, this step is optional. You 

use this bank account to accept payments from those customers that use the euro as their 

domestic currency. 

2 When you are ready to process a customer payment (for example, after you have applied the 

payment amount to invoices), access the A/R Payments form. 

3 In the Customer field, select the customer ID of the customer that is making the payment. 

4 In the Bank Code field, select the code for the bank into which you are receiving the 

payment.The bank code must use the same currency code as either the customer currency or 

your domestic currency. 
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5 In the Euro Amount field, enter the amount of the payment in the euro currency. The system 

converts the amount to the customer's national currency and to your domestic currency.  

NOTE: The customer's balance is reduced by the amount in the Customer Amount field. The 

amount in the Domestic Amount field is received into the specified bank code. The system 

does not use the amount in the Euro Amount field; this field simply enables you to enter the 

euro payment amount to be converted. 

6 Enter any additional data in the remaining fields. 

7 To save the record, select Actions > Save. 

Adjusting a Payment 

To adjust a posted transaction, use the following payment adjustment process. 

NOTE: You can only adjust a draft that was manually entered and not one generated from an 

invoice. 

Creating the Adjustment 

To create the adjustment, do the following: 

1 Access the A/R Payments form. 

2 Select Actions > New. 

3 Select the customer. 

4 Select the payment type Adjust. 

5 Enter the check or draft number to apply the adjustment.  

NOTE: To find the check or draft number for the adjustment, you might need to review the A/R 

Posted Transactions Detail form. 

6 Select the bank code, if necessary. 

7 Enter the amount you want to adjust.  

To increase the payment amount, enter a positive number. To reduce the payment amount, 

enter a negative number. 

The G/L Reference field displays either ARPA or ARPR and the check or draft number. The 

Description field displays either Payment Adj or Reapplication and the check or draft number. 

8 Save the transaction by selecting Actions > Save. 

Distributing the Adjustment 

1 Access the A/R Payment Distributions form by clicking Distributions on the A/R Payments 

form.  

NOTE:When you distribute the adjustment, you can only distribute it to either an invoice or a 

finance charge. 



Accounts Receivable (A/R) 

85 

2 Distribute the adjustment:  

 To distribute the adjustment to an invoice, select Invoice in the Type field, and then select 

the invoice number. 

 To distribute the adjustment to a finance charge, select Finance Charge in the Type field. 

 If the customer is a corporate customer, you can assign the adjustment to a subordinate 

customer. 

3 In the Amount field, enter the amount of the distribution. 

4 Save the transaction by selecting Actions > Save. 

Posting the Adjustment 

1 Access the A/R Adjustment Posting form. 

2 Enter the customer range. 

3 Click Process. 

4 Run the A/R Payment Transaction Report.  

Use this report to verify that the payments and their related distributions are accurate. The 

Payment Type field on the report displays adjustment to indicate an adjustment. 

NOTE: The system does not post transactions containing errors. If a transaction contains errors, 

correct the errors and perform the posting again. 

The adjustment will show up as a payment on the A/R Posted Transactions Detail form. 

Creating Open Payments for a Customer 

To enter a payment that is applied to the customer's total account balance, use the following 

procedure. This type of payment is the only payment type required for balance forward customers. 

For open item customers, these open credits need to be reapplied against invoices or finance 

charges at a future time. 

1 On the A/R Payments form, select Actions > New. 

2 Enter the appropriate information in the following fields:  

 Customer: Select the number of the customer the payment is for. 

 Type: This field displays the customer's default payment method, but you can select a 

different method. 

 Number: Enter the check or draft number of the payment. 

 Receipt Date: Enter the date you received the payment, or accept the default, which is 

today's date. 

 Payment Due Date: (Available only if the payment type is Draft.) Enter the date the draft is 

due. 

 G/L Reference: Enter a description to appear in the distribution journal for this transaction, 

or accept the default, which is ARP, followed by the check or draft number. 
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 Description: Enter a description to appear in the distribution journal for this transaction, or 

accept the default description. 

 Bank Code: The customer's default bank code displays, but you can select a different code 

of the bank into which the payment will be deposited. 

 Customer Amount: Enter the amount of the payment. 

3 Select Actions > Save. 

4 To distribute the payment, using the A/R Payment Distributions form, click Distributions. 

5 Under the General tab, in the Type field, select Open Credit. 

6 In the Order field, enter the number of the sales order to which the payment is to be applied. 

7 In the Dist Amount field, enter the amount to apply against the customer's sales order or the 

amount to post as an open payment. 

8 In the Disc/Credit 1 and Allowance/Credit 2 fields, enter the discount and allowance, if 

applicable. 

9 Select Actions > Save. 

Distributing Customer Payments 

You can use the A/R Payment Distributions form to apply or distribute payment amounts before 

posting them. The distributions determine how a payment is applied to a customer's account, and 

how it is distributed to the General Ledger (G/L). 

CAUTION: The system posts only balanced transactions, one side to the cash account for the 

payment and the other to the accounts receivable (A/R) account for the distributions. Therefore, the 

applied amount for any transaction must equal the check amount of the payment. If these amounts 

are not equal, the system detects the error and cancels the posting. 

You can create customer payment distributions automatically or manually. 

Distributing Payments Automatically 

To distribute payments automatically: 

1 On the A/R Payments or A/R Payment Distributions form, select the customer for which you 

want to create the distributions. 

2 Select Actions > Generate Distribution.  

To review the distributions that were automatically generated, if you are using the A/R 

Payments form, you can click the Distributions button. 

NOTE: Creating distributions automatically will use the G/L default account from the Accounts 

Receivable Parameters form. 

Distributing Payments Manually 

To distribute payments manually: 
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1 On the A/R Payment Distributions form, select Actions > New. 

2 Enter the appropriate information in the following required fields:  

 Customer: Select the number of the customer whose payment you are distributing. 

 Payment Type: This field displays the customer's default payment method, but you can 

select a different method. 

 Number: Select the number of the customer's check or draft you are distributing. 

 Bank Code: This field displays the customer's default bank code displays, but you can select 

a different code for the bank into which this distribution will be deposited. 

 Type: Select from the drop-down list the desired distribution type. 

3 Use the following table to fill in information according to the distribution type:  

If the 

distribution 

type is:       

Provide information for the following fields: 

Invoice Invoice Select the number of the customer's invoice to 

distribute the payment to. 

Site This field displays the site that owns the invoice to 

which the payment distribution is being applied 

displays, but you can select a different site to which to 

apply the payment. 

Dist Amount Enter the distribution amount. 

Disc/Credit 1 If the payment receipt date is less than the discount 

date of the invoice, this field displays the discount 

amount for the invoice, but you can change it to a 

different amount. 

Allowance/Credit 2 Enter the allowance amount or the second credit 

distribution amount (in the customer's currency) given 

to the customer. 

Open 

Credit 

Order Select the customer order against which you are 

applying the distribution. 

Site This field displays the site that owns the invoice to 

which the payment distribution is being applied, but 

you can select a different site to which to apply the 

payment. 
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Dist Amount Enter the distribution amount. 

Disc/Credit 1 If the payment receipt date is less than the discount 

date of the invoice, this field displays the discount 

amount for the invoice, but you can change it to a 

different amount. 

Allowance/Credit 2 Enter the allowance amount or the second credit 

distribution amount (in the customer's currency) given 

to the customer. 

Finance 

Charge 

Site This field displays the site that owns the invoice to 

which the payment distribution is being applied, but 

you can select a different site to which to apply the 

payment. 

Dist Amount Enter the distribution amount. 

Non-A/R Site This field displays the site that owns the invoice to 

which the payment distribution is being applied, but 

you can select a different site to which to apply the 

payment. 

Disc/Credit 1 If the payment receipt date is less than the discount 

date of the invoice, this field displays the discount 

amount for the invoice, but you can change it to a 

different amount. 

Allowance/Credit 2 Enter the allowance amount or the second credit 

distribution amount (in the customer's currency) given 

to the customer. 

4 Select the Accounts tab. 

5 Use the following table to fill in information according to the distribution type:  

If the distribution type 

is:       
Provide information for the following fields: 

Invoice 

 

and you entered 

amounts in 

the  Disc/Credit 1 

Disc/Credit 1 Acct Select the G/L account number to post the 

discount/credit 1 amount to, or accept the 

default discount G/L account number that 

displays from the Accounts Receivable 

Parameters form. Then, if any of the Unit 
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and  Allowance/ 

Credit 2 fields 

Code 1-4 fields are available, select the 

applicable unit codes. 

Allowance/Credit 2 Select the G/L account number to post the 

allowance or credit amount to, or accept 

the default G/L allowance account number 

that displays from the Accounts Receivable 

Parameters form. Then, if any of the Unit 

Code 1-4 fields are available, select the 

applicable unit codes. 

Tax Adjustment 1 If Tax Discount/Allowance is selected on 

the Tax Systems form, enter this amount. 

Tax Adjustment 2 If this field displays and if Tax 

Discount/Allowance is selected on the Tax 

Systems form, enter this amount. 

Open Credit Disc/Credit 1 Acct Select the G/L account number to post the 

discount/credit 1 amount to, or accept the 

default discount G/L account number that 

displays from the Accounts Receivable 

Parameters form. Then, if any of the Unit 

Code 1-4 fields are available, select the 

applicable unit codes. 

Deposit Acct Select the G/L account number to post the 

open credit (deposit) amount to, or accept 

the default deposit G/L account number 

that displays from the Accounts Receivable 

Parameters form. Then, if any of the Unit 

Code 1-4 fields are available, select the 

applicable unit codes. 

Tax Adjustment 1 If Tax Discount/Allowance is selected on 

the Tax Systems form, enter this amount. 

Tax Adjustment 2 If the field displays and if Tax 

Discount/Allowance is selected on the Tax 

Systems form, enter this amount. 

Non-A/R 

 

and you entered 

Disc/Credit 1 Acct Select the G/L account number to post the 

discount/credit 1 amount to, or accept the 

default non-A/R cash account from the 
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amounts in 

the  Disc/Credit 1 

and  Allowance/ 

Credit 2 fields 

Currency Codes form. Then, if any of the 

Unit Code 1-4 fields are available, select 

the applicable unit codes. 

Allowance/Credit 2 

Acct 

Select the G/L account number to post the 

allowance or credit amount to, or accept 

the default non-A/R cash account from the 

Currency Codes form. Then, if any of the 

Unit Code 1-4 fields are available, select 

the applicable unit codes. 

Tax Adjustment 1 If Tax Discount/Allowance is selected on 

the Tax Systems form, enter this amount. 

Tax Adjustment 2 If this field displays and if Tax 

Discount/Allowance is selected on the Tax 

Systems form, enter this amount. 

6 Select Actions > Save. 

Entering Customer Payments 

To enter and process payments from customers, use the A/R Payments form. On this form, enter 

payments for invoiced amounts, finance charges, and other amounts your customers owe you. 

NOTE: You can enter and post non-customer payments to the General Ledger as non-A/R cash. 

To create a payment, on the A/R Payments form: 

7 Select Actions > New. 

8 Enter the appropriate information in the following fields:  

 Customer: Select the customer ID of the customer the payment is for. 

 Type: This field displays the customer's default payment method, but you can select a 

different method. 

 Number: Enter the check or draft number of the payment. 

 Receipt Date: Enter the date you received the payment, or accept the default, which is 

today's date. 

 Payment Due Date: (Available only if the payment type is Draft.) Enter the date the draft is 

due. 

 Deposit Date: Enter the date you deposited the check. This field is available for entering 

post-dated checks. It is enabled only if the payment type is Check, and no credit memo is 

associated with the payment. Enter the date on the customer's check. 

 G/L Reference: Enter a reference ID to appear in the distribution journal for this transaction, 

or accept the default, which is ARP followed by the check or draft number. 
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 Description: Enter a description to appear in the distribution journal for this transaction, or 

accept the default description. 

 Bank Code: This field displays the customer's default bank code, but you can select a 

different code for the bank into which the payment will be deposited. 

 Customer Amount: Enter the amount of the payment. 

9 Select Actions > Save. 

You can then distribute and post the payment. 

Processing Returned Checks 

This topic includes the procedures to follow when returning checks. There are several different 

scenarios and situations listed below, so scan the list before determining your course of action. 

Returning a single check 

1 Contact the customer and determine a course of action. A new check may be collected or the 

returned checks re-deposited. 

2 Open the Bank Reconciliations form. 

3 Filter by the bank that failed to accept the check.  

4 Using your bank records, search for the deposit date that matches the rejected check's deposit 

date.  

5 Select the Returned Check check box in the grid. 

6 If applicable, select the Generate Returned Check Fee check box, and enter data for the 

Returned Check Fee Type and Returned Check Fee Value fields.  

7 Open the Returned Checks form and process the appropriate bank code. A message will 

display indicating that the utility was successful. See the different scenarios below. 

Scenario 1 

If when you run the Return Checks utility, the Generate Debit Memo per Invoice check box is 

selected on the Accounts Receivable Parameters form, the following occurs: 

 One debit memo is created for each invoice to reverse the payment amount for that invoice. 

 Two distribution rows are created. The first is for the actual amount of the check, crediting the 

cash account. The second is for the discount amount, crediting the early pay discount account. 

 If the Generate Returned Check Fee check box is selected on the Bank Reconciliations form 

and a Returned Check Fee Type of "Amount" is selected, a second debit memo is created for 

the returned check fee amount. 

 If the Generate Returned Check fee check box is selected on the Bank Reconciliations form 

and a Returned Check Fee Type of "Percent" is selected, a debit memo is created for the fee 

amount associated with each invoice paid off by the check being returned. Each debit memo is 

for the amount of the invoice multiplied by the fee percentage. 
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 The Invoice Posting needs to be executed to post the debit memo(s) generated by the Returned 

Checks utility. 

 Journal entries are created to book the offset of the returned check and discount amounts. The 

fee amount is also booked. 

Scenario 2 

If when you run the Return Checks utility the Generate Payment Adjustment for Returned 

Checks check box is selected on the Accounts Receivable Parametersform:  

 One negative amount adjustment is created, to show the invoice amount as still being due.  

 A payment adjustment distribution record is created to offset the payment and any associated 

discount amount.  

 If the Generate Returned Check Fee check box is selected on the Bank Reconciliations form 

and a fee type of "Amount" is selected, a debit memo is created for the returned check fee 

amount.  

 If the Generate Returned Check Fee check box is selected on the Bank Reconciliations form 

and a fee type of "Percent" is selected, a debit memo is created for the fee amount associated 

with each invoice paid off by the check being returned. Each debit memo is for the amount of the 

invoice paid off by the check multiplied by the fee percentage.  

 A/R Adjustment Posting needs to be executed to post the negative check adjustment created by 

the Returned Checks utility.  

 Journal entries are created to book the offset of the returned check and discount amounts.  

 Invoice Posting needs to be performed to post any debit memo(s) created for the returned check 

fee.  

 Journal entries are created to book the fee amount.  

Returning a check that was originally part of a summarized check deposit 

1 Using your bank records, search for the deposit date that matches the rejected check's deposit 

date.  

NOTE: The Bank Reconciliations form includes summarized transaction records. Therefore, 

it may not be possible to match the exact check amount on your bank record with the exact 

check amount on the Bank Reconciliations form. If the Bank Reconciliations form displays 

multiple deposits on the day in question, use your best judgment in determining the proper 

row to modify. As long as you enter the correct amount, modifying the wrong row will not 

cause any problems.  

2 Modify the number in the Bank Amount field to reflect the actual amount deposited in the bank. 

The difference between the two numbers should equal the amount of the returned check. 

3 Add a new Bank Reconciliations record, with the following information:  

 Type: Deposit 

 Amount: [returned check amount] 

 Bank Amount: 0 
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 Ref Number: customer number 

 Customer Check Number: check number 

 Returned Check?: Selected 

 Returned Check Fee?: Accept the default (from A/R Parameters) or (de)select 

 Returned Check Fee Type: Accept the default (from A/R Parameters) or select a type 

 Returned Check Fee Amount: Accept the default (from A/R Parameters) or enter an 

amount.  

4 Run the Returned Checks utility, post invoices or payment adjustments as mentioned in previous 

examples. 

Redepositing a check 

1 On the Bank Reconciliations form, uncheck the Returned Check field for the check being 

redeposited, and select the Bank Reconciled field. 

2 On the Returned Checks utility form, select the Process Returned Check Deposit check box 

for the appropriate bank code and click Process. A credit memo is created to show the check 

has been redeposited. 

3 On the Invoice Posting form, post the credit memo. Journal entries are created to book the 

redeposited check. 

Finance Charges 

Calculating Finance Charges 

Calculating A/R Finance Charges 

How the System Calculates Finance Charges 

For each customer whom the Finance Charge check box is selected on the Customers form, the 

system looks at all open invoices, debits, credits, finance charges and payments. If the system finds 

an invoice or debit, it performs the following: 

TA * APR/365 * (BD - (LFCD or TDD)) = CFC 

where: 

CFC = Calculated Finance Charge 

 

TA = Transaction Amount 

 

APR = Annual Percentage Rate (from the Accounts Receivable Parameters form) 

 

365 = days in a year 

 

BD = Base Date (first choose Generate Charges) 
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LFCD = Last Fin Chg Date (from the Customers form) 

 

TDD = Transaction Due Date 

If the Last Fin Chg Date is more recent than the Transaction Due Date, the system uses the Last 

Fin Chg Date; otherwise, it uses the Due Date. The calculated amount is a positive finance charge. 

If a transaction is a credit or payment, the system calculates the transaction the same way, except 

the amount is a negative finance charge. 

If a transaction is a finance charge transaction, the system calculates the finance charge only on this 

amount if the Compound Charges check box is selected on the Accounts Receivable Parameters 

form. In this case, the system calculates the amount the same way as invoices and debits. 

After the system calculates all finance charge amounts, it sums them to arrive at the final finance 

charge amount for the customer. 

Multi-Site A/R Finance Charge Calculations 

Although the finance charge activity does run across sites, when run from the entity, they are not 

split to see where all the charges came from. The site that generated the finance charge is the only 

one with the finance charge transactions. See the examples below. 

Example 1 

Example 2 

Example 3 

Given these three examples, you will need to determine whether you want to have "centralized" or 

"decentralized" finance charge collections. the system automatically provides you with decentralized 

finance charge generation and posting. If you want to have only one of your sites be the collection 

point for finance charges, you must have defined customers in that one site for all customers that 

exist in all sites (as shown in Example 3). Once that is done, finance charge generation and posting 

should not be run at sites other than the collection site. 

Example 1: Multi-Site A/R Finance Charge Generation 

In this example, if Site 1 generated the finance charges, nothing would happen for customer C-1 

since C-1 is not local. 

Site 1 Site 2 Site 3 

C-1 not local C-1 C-1 

$0.00 $400.00 $300.00 

 

(past due balances) 

$0.00 4.00 3.00 

 

(Individual Finance Charges) 
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Example 2: Multi-Site A/R Finance Charge Generation 

In this example, Customer C-1 exists in all three sites and finance charges are run individually at 

each site. When run individually, the finance charges stay in the site where they were run. 

Site 1 Site 2 Site 3 

C-1 C-1 C-1 

$0.00 $400.00 $300.00 

 

(past due balances) 

$0.00 4.00 3.00 

 

(Individual Finance Charges) 

Example 3: Multi-Site A/R Finance Charge Generation 

In this example, Site 1 is responsible for accepting payments (which can be distributed to the proper 

site) and running the finance charges. In this case, only Site 1 generates the finance charges and 

becomes the actual location of the finance charge transactions before and after finance charge 

posting. 

Site 1 Site 2 Site 3 

C-1 C-1 C-1 

$0.00 $400.00 $300.00 

 

(past due balances) 

$7.00 0.00 0.00 

 

(Centralized Finance 

Charges) 

Entering Finance Charges Manually 

On the Finance Charges form, you can enter the finance charges manually by entering the finance 

charge for the selected customer in the Finance Charge field. 
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Generating and Posting Finance Charges 

To calculate finance charges for customers who have a past-due balance and for whom the Finance 

Charge check box on the Customers form is selected, use the A/R Finance Charge Generation 

utility. 

To post the finance charges, use the Finance Charge Posting form. 

1 On the A/R Finance Charge Generation form, enter information in these fields:  

 Site Group: Enter the multi-site group ID for which you want to generate finance charges. 

 Start and End Customer: Enter the range of customers you want to generate finance 

charges for. 

 Statement Cycle: Select from the drop-down list the statement cycles you want to generate 

finance charges. 

 Cutoff Date: Enter the cutoff date of the transactions you want to include in the calculation. 

 Include Fully Paid Invoices: If you want to include invoices that are fully paid, but which are 

late, select this check box. 

 Delete All Records First: If you want to delete all finance charge records before generating 

the new amounts, select this check box. 

 Increment Date: If you want the system to automatically increment date ranges and re-run 

reports and utilities, select this check box. 

2 To generate finance charges for the selected customers, click Process. 

After you generate the finance charges and review them for accuracy, you must post the charges. 

To post the charges, use the Finance Charge Posting form: 

1 Select the range of customers whose finance charges you want to post, or, to post finance 

charges for all customers, leave these fields blank. 

2 To print the Finance Charge Transaction Report and verify that the finance charges are 

correct, click Process.  

NOTE: You must print this report before you can post the charges. The Commit option is 

inactive until you perform this step. 

3 After verifying the report, to post the finance charges, select Commit and then click Process. 

After the finance charges are posted, they display on the A/R Posted Transactions Detail form with 

Finance Charge as the type and -1 as the invoice number. The posted finance charges display as 

Finance Charge on this form. 

The system does not post transactions that contain incorrect information. In this case, the system 

displays an error message stating that the posting process is partially complete. You must correct 

the errors, and then post the finance charges again. 
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Importing Electronic A/R Payments 

Importing A/R Payment and Distribution Data from Bank Files 

You can import and process electronic customer payments from a bank or electronic lock box and 

apply them to A/R invoices.  Different banks use different file formats. Set up a Map ID for each type 

of file format  that will be imported.  

Setup 

To prepare for the import: 

1 On the Accounts Receivable Parameters form, specify the A/R Payment Import Archive Path. 

This is the folder where the A/R payment file is stored after it has been processed. You archive 

the files in case they need to be reimported or referred to later. 

2 Optionally, use the A/R Customer Bank Account form to link customers with their bank routing 

and account numbers. This information is used during the A/R Payment Import Workbench 

validation process. When a payment is processed, the system checks to see if a record exists on 

this form for the bank routing and bank account. If so, it uses that information to find the 

customer associated with the payment. If not, the user specifies the customer in the workbench, 

and a record is added to this A/R Customer Bank Account form  for future reference. 

3 The file to be imported into the A/R Payment Import Workbench must be based on Microsoft 

Windows format, where end-of-line is indicated by Carriage Return (CR – CHAR(13) – \r – 0x0D) 

and Line Feed (LF – CHAR(10) – \n – 0x0A) control characters. Using this format allows Infor 

CloudSuite to import each line into a separate row in the table. 

Mapping 

Because it is a standard format already defined in Infor CloudSuite, you only need to specify a Map 

ID and the Type when you set up mapping for the NACHA CCD bank file format. For other delimited 

or non-delimited bank file formats, you must specify additional information about the file format and 

how the contents are mapped to the import workbench tables. 

Use these forms to set up the mapping: 

 A/R Payment Import Mappings 

 A/R Payment Import Field Mappings 

 A/R Payment Import Conversions  

For more information, see Mapping Bank Files to A/R Payments and Distributions. 

Importing 

After customers' payments are deposited in your bank, use the A/R Payment Import utility to import 

electronic files from your bank that provide a record of the A/R payments. Then process the data 

with the A/R Payment Import Workbench: 

1 To access the utility from the workbench form, click A/R Payment Import. You can also open 

the utility standalone. 
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2 Select a valid import map ID, as defined on the A/R Payment Import Mappings form. 

3 When the map ID is specified, the default import path for that ID is displayed. You can change 

the path, which should be specified in UNC format (//server/folder). 

4 Click Process.  

The utility reads each file in the import path and imports each file based on the mappings defined 

for the map ID. The data from successfully imported files are loaded into the workbench tables, 

and the files are moved to the Archive Directory specified in the Accounts Receivable 

Parameters form. 

If an error occurs while importing a file, the error is captured and no more files are processed. 

You can view the error in the Background Task History form.  

5 Open the A/R Payment Import Workbench form to view and manipulate the values and then 

post the data to the A/R payment tables. 

Note: Bank reconciliation records are not imported with this utility. Only A/R payments and 

distributions are imported and processed using the import utility and workbench. Bank reconciliations 

are created when the A/R payments are posted in Infor CloudSuite. 

Processing 

Use the A/R Payment Import Workbench form to view, modify, and validate the payment and 

distribution information so that it is ready to post. All batches that were successfully imported are 

listed in this form.  

Note: For EFT files in NACHA CCD format, the import assumes that positions 40-54 (Company's ID 

Number) of record type 6 in the EFT file contain the check number. The import places this value in 

the Check Number field of the workbench form. If the import finds any non-numeric characters in 

those positions of the file, it places a zero in this field. If this field is not populated with the check 

number, please contact the bank to determine if the bank can place the check number in positions 

40-54. 

1 Select a batch ID to view its status:  

 If the status is Processed, every payment record in the batch has been processed; you can 

click Delete to remove the batch from the form. The original file is stored in the Archive folder 

in case it needs to be reviewed later.  

 If the status is Unprocessed, at least one payment is not processed; that record has a status 

of Unprocessed, Error, or Hold. 

2 Click Validate to validate all payments and distributions for batches where the payment status is 

Unprocessed or Error. During validation, if the customer field is blank for a payment or 

distribution record, the system:  

 Tries to find the customer number based on the invoice number. 

 If that fails, tries to find a matching customer in the A/R Customer Bank Account form, 

based on the bank routing and account number. 

 If that fails, leaves the customer number blank. 

Other validations are performed. Any resulting validation error messages are displayed in the 

grid. 
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3 Correct any validation errors and fill in any blank customer numbers. 

4 In the Payment grid, select the payment records that you want to process. If you do not want to 

process a record, you can change its status to Hold. 

5 The Distribution grid lists all distributions associated with a selected payment in the Payment 

grid. You cannot add or delete records in this grid. If you do not want a distribution to be 

processed, set the Apply Amount and Discount Amount to zero. Distribution records are 

disabled for a payment whose status is Processed or Hold. 

6 Click Process.  

All payments and distributions in the batch ID that have a payment status of Unprocessed or 

Error are validated, even if they are not selected. 

All selected payments that are unprocessed with no errors will be processed. A/R Payment and 

A/R Payment Distribution records are created. When an A/R Payment record is created, the 

customer, routing number and bank account are checked against the A/R Customer Bank 

Account records. If a matching customer bank account record is not found, one is created. 

Note: Discount amounts are not calculated on the distribution records. They are either included in 

the values from the import file, or they must be manually updated. 

Mapping Bank Files to A/R Payments and Distributions 

Use these steps to set up the mapping between an electronic A/R payment file from a bank and Infor 

CloudSuite tables, so that the import works for specific bank file formats. For an example of a bank 

file mapping, see Example: Bank Import File Mapping. 

Mapping General Import Settings and File Formats 

Use the A/R Payment Import Mappings form to define the import path, contents, and formatting of 

an incoming A/R payment file from a specific bank: 

1 In the header area of the form, specify this information:  

Map ID and Description 

Specify an ID and description that clearly define the bank and the type of file to be used for this 

import. 

Import Path 

Specify the folder, in UNC format (\\server\folder), where files to be imported with this format are 

placed for processing. The folder path must already exist. 

Type 

Specify one of these options:  

 Delimited: There is a delimiter character between each field in the imported file.  

 Non-Delimited: There are no delimiters in the imported file. 

 NACHA CCD: This Map ID is used when you import fixed format files that use the 

NACHA format. In this case, you cannot further define the mapping. The A/R Payment 

Import will process incoming files based on the standard NACHA CCD fixed format. 
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2 If Type is set to Delimited, specify the delimiter character and specify whether the fields are 

enclosed in quotation marks. If so, the quotation marks are stripped off. 

3 If amounts in the imported file do not contain an actual decimal point, but have an implied 

decimal point, select Amounts Contain Implied Decimal and then specify the number of digits 

that are included to the right of the decimal. 

4 Specify the Date Format used in the file. 

5 In the Record Identifier section, indicate whether Record Identifiers Are Used in the file. If yes, 

then specify this information:  

Field Number 

If Type is set to Delimited, specify the field position of the Record ID field. 

Starting and Ending Position 

If Type is set to Non-Delimited, specify the characters in the row that are the start and end of the 

Record ID value. 

6 Specify the number of header records (initial rows) to skip in the file. 

7 In the Mapping Groups section, specify this information:  

Group Name  

Specify the name of the mapping group, which identifies the purpose of field mappings in the 

group. Currently the options are Payment or Distribution. 

First Record ID of Group 

If you selected Record Identifiers are Used, then specify the record ID of the row that starts the 

new group. 

8 The grid at the bottom of the form is read-only and contains values from the A/R Payment 

Import Field Mappings form after they are defined. 

9 Click Mapping Fields to continue.  

To see an example that shows how this mapping is set up for a particular bank file, see Example: 

Bank Import File Mapping. 

Mapping Fields to Tables 

Use the A/R Payment Import Field Mappings form to define, for a particular incoming format, the 

mapping of each imported field to a table and column in the import workbench: 

1 If you open this form from the A/R Payment Import Mappings form, the fields at the top of this 

form are filled in with values defined on that form. 

2 For each Map ID and Table Group, specify where field data is located in an incoming row, and 

the table/column that the field is mapped to:  

Table Name and Column Name 
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Specify the workbench table and column that are mapped to this payment data field within a row. 

The ar_eft_import_arpmt table is used for records in the Payment group, or the 

ar_eft_import_arpmtd table is used for records in the Distribution group. 

Field Number 

If Type is Delimited, specify the field position of the field within a row to capture. 

Starting Position and Ending Position 

If Type is Non-Delimited, specify the characters in the row that indicate the start and ending 

positions of the field in the row. 

Record ID 

Specify the Record ID, if any, associated with the imported row containing the field data. If 

Record IDs are used, they are helpful to determine the row in the file that is being imported. 

Field is Amount 

If you select this field, and Amounts Contain Implied Decimal is selected on the on the A/R 

Payment Import Mappings form, the value is stored in the database with a decimal point and 

trailing digits. The number of trailing digits is based on the Digits Following Implied Decimal 

value on the A/R Payment Import Mappings form. 

Field is Date 

If this field is selected, the Date Format on the A/R Payment Import Mappings form is used to 

parse the value. 

Value Conversion ID 

If the imported value must be converted to a valid Infor CloudSuite value before it is stored in the 

database, specify the conversion ID to use. Conversions are defined in the A/R Payment Import 

Conversions form. 

3 If you need to return to the A/R Payment Import Mappings form to add another group, click 

Payment Import Map. 

4 If you need to define any value conversions between values in the incoming file and values used 

in Infor CloudSuite, continue with the following section. 

Setting up Conversions for Imported Values 

Use the A/R Payment Import Conversions form to specify conversions of values from incoming 

payment files into acceptable Infor CloudSuite values. For example, the payment types used in the 

bank file, such as ACH, WIR, etc., probably do not match the Infor CloudSuite  payment type values 

(C, W, etc.). 

Example: Bank Import File Mapping 

This example shows the information you would specify in the various forms to import an A/R 

payment file for a particular bank. For more information about the steps, see Mapping Bank Files to 

A/R Payments and Distributions. 

A/R Import Mapping - Header 
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Field Value 

Map ID AR00000001 

Type Delimited 

Delimiter |  (pipe) 

Amounts contain implied decimal Yes 

Digits following implied decimals 2 

Date format YYMMDD 

Record IDs are used Yes 

Record ID field number 1 

A/R Import Mapping - Groups 

Group name First record ID of group 

Payment PR 

Distribution IV 

A/R Payment Import Field Mappings 

Table 

group Table name Column name 

Field 

number 

Record 

ID 

Field is 

amount 

Field 

is 

date 

Value 

conversion 

ID 

Payment arpmt_import_payment account_num 8 PR       

Payment arpmt_import_payment check_amt 4 PR Yes     

Payment arpmt_import_payment deposit_date 9 PR   Yes   

Payment arpmt_import_payment payment_type 2 PR     PaymentType 
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Payment arpmt_import_payment routing_num 7 PR       

Payment arpmt_import_payment check_num 16 SP       

Distribution arpmt_import_distribution amt_paid_amt 5 IV Yes     

Distribution arpmt_import_distribution disc_amt 7 IV Yes     

Distribution arpmt_import_distribution inv_num 3 IV       

A/R Payment Import Conversions 

Define this information in the A/R Payment Import Field Mappings form: 

Value conversion ID Source value Converted value 

PaymentType ACH C 

PaymentType BKW C 

PaymentType FWT C 

PaymentType LBX C 

PaymentType SWT C 

PaymentType WIR W 

Quick Payment Application 

Using the A/R Quick Payment Application 

You can use the A/R Quick Payment Application form to: 

 Enter full or partial payments. 

 Distribute full or partial invoices. 

 Create open payments. 

 Pay finance charges. 

 Distribute finance charges. 

 Reapply open payments. 
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 Reapply open credits. 

To access the A/R Quick Payment Application utility from the A/R Payments or A/R Payment 

Distributions form, click the Quick button. 

When using the A/R Quick Payment Application utility: 

1 If you haven't done so on a previous form, enter all the A/R payment information (customer, type, 

number, receipt date, due date, and so on). 

2 Enter the payment amount. 

3 You can also enter a G/L Reference and a Description, or accept the default values that display. 

4 Select Actions > Save.  

NOTE: You must save the payment before you can select transactions to apply it to in the grid. 

5 Select the invoice, payment, credit, or finance charge to which you want to distribute the 

payment.  

 To select all displayed transactions, click Select All. 

 To remove the selection flag from all displayed transactions, click Deselect All. 

6 Click Apply. 

Creating Open Payments Using A/R Quick Payment Application 

To create an open payment using the A/R Quick Payment Application form: 

1 Select Actions > New. 

2 Specify information in these fields:  

 Customer: Enter the customer ID of the customer for whom you are entering the payment. 

 Type: This field displays the customer's payment method by default, but you can select a 

different method. 

 Number: Enter the check or draft number for this payment. 

 Receipt Date: Enter the date you received the payment, or accept the default, which is 

today's date. 

 Payment Due Date: (Available only if the payment type is Draft.) Enter the date the draft is 

due. 

 G/L Reference: Enter a description to appear in the distribution journal for this transaction, 

or accept the default, which is ARP followed by the check or draft number. 

 Description: Enter a description to appear in the distribution journal for this transaction, or 

accept the default description. 

 Bank Code: Enter the bank code of the bank from which the payment will be made, or 

accept the customer's default bank code. 

 Amount: Enter the amount of the payment. 

3 Do one of the following:  
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 To apply the entire payment to an open payment, select Actions > Save, and then select 

Apply. The entire amount is then distributed to an open payment. 

 To apply part of the payment to an open payment, select the Selected check box for each 

invoice and/or finance charge you want to apply the payment to. Then select Apply. The 

remaining amount is then distributed to an open payment. 

NOTE: If you select multiple invoices, open payments, and/or open credits, the oldest open 

transaction is applied to the oldest invoice. You cannot enter the invoice number of the open 

payment to apply the payment to. 

Entering Customer Payments Using A/R Quick Payment Application 

To process payments from customers, you can use the A/R Quick Payment Application form. You 

can select open invoices, finance charges, payments, and credit memos. 

To process payments using the A/R Quick Payment Application form: 

1 Select Actions > New. 

2 Enter the appropriate information in the following fields:  

 Customer: Enter the customer ID of the customer you're entering the payment for. 

 Type: This field displays the customer's payment method by default, but you can select a 

different method. 

 Number: Enter the check or draft number for this payment. 

 Receipt Date: Enter the date you received the payment, or accept the default, which is 

today's date. 

 Payment Due Date: (Available only if the payment type is Draft.) Enter the date the draft is 

due. 

 Deposit Date: Enter the date you deposited the check. This field is available for entering 

post-dated checks. It is enabled only if the payment type is Check, and no credit memo is 

associated with the payment. Enter the date on the customer's check. 

 G/L Reference: Enter a description to appear in the distribution journal for this transaction, 

or accept the default, which is ARP followed by the check or draft number. 

 Description: Enter a description to appear in the distribution journal for this transaction, or 

accept the default description. 

 Bank Code: Enter the bank code of the bank from which the payment will be made, or 

accept the customer's default bank code. 

 Amount: Enter the amount of the payment. 

3 Select Actions > Save.  

NOTE: You must perform this step before you can select any transactions in the grid. 

All open invoices, finance charges, payments, and credit memos for this customer display in the 

grid at the bottom of the form. If any of these transactions have been distributed, the Selected 

check box is selected for each. 

NOTE: On the A/R Quick Payment Application form, non-A/R payment distributions display as 

selected in the grid. The amounts display in the Discount and Allowance columns. In the 
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Discount column, you enter Credit Amount 1, and in the Allowance column you enter Credit 

Amount 2. 

4 For each transaction you want to make a payment against, select the Selected check box, or, to 

select all the displayed transactions, click Select All. 

5 Select Apply. The system displays a message informing you of the actions that were taken. 

Reapplying Open Payments and Credits Using A/R Quick Payment Application 

If you add a customer payment and also add a payment distribution type of Open Credit, and then 

post the payment, you can reapply the posted payment using the A/R Quick Payment Application 

form. 

You can reapply an open payment and credit by: 

 Entering and saving a payment without selecting transactions to applied it against. 

 Selecting an open payment or credit in the grid at the bottom of the form. 

Entering a Payment to Be Reapplied 

1 Select Actions > New. 

2 Select the customer number, and enter the check number that matches the open payment you 

want to reapply.  

The system fills the G/L Reference field with the description Re-Application of Open 

Payment/Credit. 

3 Change the G/L Reference and Description fields, if necessary.  

NOTE: When reapplying open credits, do not change the Receipt Date. The journal entries 

created will be a debit and credit to the A/R account. 

 

When reapplying open payment, and a separate A/R Deposit account is used, change the 

Receipt Date to current date. The journal entries created will be a debit to the A/R Deposit 

account and a credit to the A/R account. If the deposit account is the same as the A/R account, 

then the receipt date should not be changed. 

4 Select Actions > Save.  

NOTE: You must perform this step before you can select transactions in the grid at the bottom of 

the form. 

5 Select the Selected column of each transaction you want to apply the payment to. 

6 Click Apply. The system updates the payment with the new invoice number, and journal entries 

are posted for the reapplication. The journal entries will have a reference of ARPR (payment or 

credit reapplication). 

Selecting a Payment to Be Reapplied 

1 Make sure that you have entered all the payment information. 

2 Select Actions > Save.  
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NOTE: You must perform this step before you can select transactions in the grid at the bottom of 

the form. 

3 Select an invoice in the grid. 

4 Select an open credit or payment in the grid. The selection of both the invoice and the open 

credit/payment triggers the reapplication process. 

5 Click Apply. The system creates a payment distribution for the invoice for the value in the 

Customer Amount field. To verify that the system has reapplied the open payment, you can 

view it in the A/R Posted Transactions Detail form.  

NOTE: If you select multiple invoices, open payments and/or open credits, the oldest open 

transaction is applied to the oldest invoice. You cannot enter the invoice number to apply the 

open payment to. 

Examples: Using A/R Quick Payment Application 

Scenario 1 

You enter a payment for $150, and select three $50 invoices in the grid against which to apply the 

payment. 

The grid shows the following: 

Customer    Type    Invoice    Site    Order    

Delivery 

Order    Chk/Ref    

Invoice 

Date    

Due 

Date    

Amt To 

Apply    Discount    

1 I 101 01 C000001     05/15/02 06/15/02 50.00 0.00 

1 I 150 01 C000007     06/15/02 07/15/02 50.00 0.00 

1 I 156 01 C000010     06/22/02 07/22/02 50.00 0.00 

When you select Apply, the system creates three distribution records for each one of these invoices. 

Scenario 2 

You enter a payment, and do not select any transactions in the grid. 

You enter a payment for $100 on the A/R Quick Payment Application form with a payment date of 

06/15/02, and save it. Then, you select Apply. A payment distribution is created as an Open credit 

for $100. 

The grid shows the following: 

Customer    Type    Invoice    Site    Order    

Delivery 

Order    Chk/Ref    

Invoice 

Date    

Due 

Date    

Amt To 

Apply    Discount    

1 P Open 01       06/15/02 06/15/02 50.00 0.00 
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Scenario 3 

You enter a payment, select an invoice, and some payment amount is left to be applied. 

You enter a payment for $100 on the A/R Quick Payment Application form, and save it. Then you 

select an invoice for $60, and click Apply. Two payment distributions are created, one as an invoice 

for $60, and the other as an open credit for $40. Both the invoice and the open credit display as 

selected in the grid. 

Customer    Type    Invoice    Site    Order    

Delivery 

Order    Chk/Ref    

Invoice 

Date    

Due 

Date    

Amt To 

Apply    Discount    

1 C Open 01       06/15/02 06/15/02 40.00 0.00 

1 I 102 01 C000001     05/15/02 06/15/02 60.00 0.00 

Scenario 4 

You enter a payment for $0, and select an invoice and an open credit. 

Customer    Type    Invoice    Site    Order    

Delivery 

Order    Chk/Ref    

Invoice 

Date    

Due 

Date    

Amt To 

Apply    Discount    

1 C Open 01 C000001     06/15/02 06/15/02 50.00 0.00 

1 I 101 01 C000001     05/15/02 06/15/02 50.00 0.00 

The open credit is automatically when you click Apply. The invoice number in the A/R Transaction 

table (artran) now shows 101. The A/R account in the original artran record for the open credit is 

11000. The A/R account in the parameters is 11000. The journal entries created will be: 

29 * 06/15/02 11000   50.00 ARPR 1 

  Accounts Receivable 50.00 USD 1.000 

30 * 06/15/02 11000     50.00 ARPR 1 

  Accounts Receivable   50.00 USD 1.000 

Scenario 5 

You enter a payment for $50, and select multiple invoices, open payments, and credits: two invoices, 

101 with a due date of 06/15/02 and 150 with a due date of 07/15/02 for $50 each; and the open 

credit has a due date of 06/15/02. The payment is for $50 on 07/20/02. 

When you click Apply, the open credit of $50 is applied to invoice 101 and then posted. A/R Posted 

Transactions will show the credit with an invoice number of 101. The new payment of $50 is applied 

to invoice 150, and a payment distribution is created. 

The grid shows the following: 
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Customer    Type    Invoice    Site    Order    

Delivery 

Order    Chk/Ref    

Invoice 

Date    

Due 

Date    

Amt To 

Apply    Discount    

1 I 150 01 C000007     06/15/02 07/15/02 50.00 0.00 

Scenario 6 

You enter a payment, and select a Finance Charge transaction. 

Three finance charges exist in posted transactions: one for $20 with a due date of 05/15/02, one for 

$20 with a due date of 06/15/02, and one for $20 with a due date of 07/15/02. 

You enter a payment for $40. The finance charges display in the grid as follows: 

Customer    Type    Invoice    Site    Order    

Delivery 

Order    Chk/Ref    

Invoice 

Date    

Due 

Date    

Amt To 

Apply    Discount    

1 F Fin chg 01       05/15/02 05/15/02 60.00 0.00 

You must update the Amt To Apply (in the grid) to $40.00. When you click Apply, a distribution is 

created for the finance charge. Upon posting the payment, the amount will automatically be applied 

to the oldest finance charges. 

Scenario 7 

Reapplication of an Open payment/Open credit. 

You enter an open payment/open credit to reapply for $1000. The grid shows an invoice selected for 

$1000. When you click Apply, a payment distribution is created. The A/R account in the original A/R 

transaction (artran) record for the open credit is 11000, and the A/R account in the original record for 

the open payment is 26000 (Deposit account). The open credit journal entries are the same as in 

scenario #4 above. When the open payment is applied, payment application occurs within the due 

date, so a discount for $50 is automatically created by the system in the Discount column. 

When the payments are posted, the open payment entries are: 

55 * 01/18/03 
26000 

  1,000.00 ARPR 656 

  AR Deposit 1,000.00 USD 1.000 

56 * 01/18/03 
40450 

  50.00 ARPR 656 

  Sales Discount 50.00 USD 1.000 

57 * 01/18/03 
11000 

3000   1,050.00 
ARPR 

656 

  Accounts   1,050.00 USD 1.000 
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Receivable 

Scenario 8 

Reapply an Open payment to an invoice from another site. 

An invoice is selected from Site 2. The open payment was entered in Site 1, and is being applied in 

Site 1. When you click Apply, you are prompted to transfer cash. If you select Yes, journal entries in 

Site 2 will transfer the amount from Accounts Receivable to cash. In Site 1, the amount will be 

transferred from the deposit account to cash. The entries appear: 

Site 2 

32 * 01/17/03 11000 3000   100.00 ARPR 25 

  Accounts Receivable   100.00 USD 1.000 

33 * 01/17/03 10000   100.00 ARPR 25 

  Cash 100.00 USD 1.000 

Site 1 

43 * 01/17/03 26000   100.00 ARPR 25 

  AR Deposit 100.00 USD 1.000 

44 * 01/17/03 10000     100.00 ARPR 25 

  Cash   100.00 USD 1.000 

If transfer cash is not selected, the A/R Inter-Site Liability and Asset accounts will be used instead of 

Cash. The entries are: 

Site 2 

35 * 01/17/03 11000 3000   100.00 ARPR 23 

  Accounts Receivable   100.00 USD 1.000 

36 * 01/17/03 49020 49020 100.00 ARPR 23 

  A/R Inter-Site Asset 100.00 USD 1.000 

Site 1 

47 * 01/17/03 26000   100.00 ARPR 23 

  AR Deposit 100.00 USD 1.000 

48 * 01/17/03 49000     100.00 ARPR 23 
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  A/R Inter-Site Liability   100.00 USD 1.000 

Scenario 9 

Reapply an open payment to an invoice with a different exchange rate. An open payment for $310 

Canadian Dollars (CND) at an exchange rate of 1.55 is applied to an invoice with an exchange rate 

of 1.60. The following entries happen in the journal when the Apply button is selected: 

66 * 01/14/03 26000   200.00 ARPR 5651 

  AR Deposit 310.00 US$ 1.550 

67 * 01/14/03 40200 3000   7.03 ARX   

  Currency Gains   10.90 CND 1.550 

68 * 01/14/03 11000   7.03 ARX   

  Accounts Receivable 10.90 CND 1.550 

69 * 01/14/03 11000     200.00 ARPR 5651 

  Accounts Receivable   310.00 CND 1.550 

Scenario 10 

You enter a payment for $95. You also enter a non-A/R cash distribution for $5.00 in A/R Payment 

Distributions. When you access the A/R Quick Payment Application form, the following 

transactions display: 

Customer    Type    Invoice    Site    Order    

Delivery 

Order    Chk/Ref    

Invoice 

Date    

Due 

Date    

Amt To 

Apply    Discount    

1 F Fin chg 01     -1 05/15/02 05/15/02 100.00 0.00 

  Non 

A/R 

Non 

A/R 

01       05/15/02     5.00 

  Open 

Credit 

Open 01     -1 05/15/02   20.00 0.00 

1 I 100 01       05/15/02 06/15/02 10.00 0.00 

When you click Apply, the $20 open credit is applied to the finance charge. It is automatically posted 

and shows on the A/R Posted Transactions form. 

The $95.00 payment is then applied. Distributions for an $80 finance charge, $5.00 non-A/R cash, 

and $10.00 invoice will then be created. The non-A/R cash already exists in the distributions. 
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Posting A/R Draft Payments 

Draft payments cannot be directly posted to a cash account like you would post a check or a wire 

payment. When you first post the draft payment, the draft status is changed to Posted and the usual 

journal transactions are created. However, the transaction does not yet impact the Cash account in 

the General Ledger, but instead it impacts the Draft Receivable account found in the Accounts 

Receivable Parameters form. 

Next, based on the due date of the draft and when you wish to receive the cash (at due date or 

before the due date), perform a draft remittance using the A/R Posting Draft Remittance form. 

NOTE: The bank charges an additional discount fee when you want to receive the cash before the 

due date. 

After the draft remittance, post the draft. Posting the draft changes the status of the draft to Remitted 

and creates a journal entry from the Draft Receivable account to either the Draft Remitted account or 

the Draft Discounted account identified in the Bank Address form. 

Posting prepares entries for the AR DIST journal like this: 

Journal Entries 

Journal entries created when running the A/R Posting Draft Remittance form: 

Dr             Drafts Remitted 

                Cr Drafts Receivable 

For discounted drafts: 

Dr             Drafts Remitted 

                Cr Draft Discounted Receivable  

  

When the bank tells you it has given you the money, use the Bank Reconciliations form to perform 

a draft deposit. The deposit updates the draft status to its final value of Paid and creates the new 

journal entry that finally impacts the Cash account. 

Journal Entries 

Journal entries created when reconciling draft payment deposits using the Bank Reconciliations 

form: 

Dr            Cash 

               Cr Drafts Remitted  

Posting Payments 

NOTE: The Accounts Receivable account must be assigned on the Accounts tab on the Accounts 

Receivable Parameters form; otherwise, an error message displays and the posting process stops. 
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1 Open the A/R Payment Posting form. 

2 (Optional) By default, payments for all customers will be posted, but you can further refine the 

posting by selecting a range of customers, bank codes, receipt dates, and check numbers. You 

also can select a single payment for posting.  

The Print option is automatically selected. You must first print the A/R Payment Transaction 

Report to review and verify the transactions that will be posted. 

3 To produce the report, click Process. After reviewing the report, you can post the transaction(s) 

and create Bank Reconciliation record(s). Notice that the Commit option is now enabled. 

4 Select the Commit option. 

5 To post the payment(s) and create the Bank Reconciliation record(s), click Process. 

The system does not post transactions containing errors. If a transaction contains errors, correct 

them, and then try again to post. 

When you post an A/R open payment that is tied to a customer order, the system asks if you want to 

apply it as a prepaid amount on the customer order. You have three options: 

 To post the payment and not update the customer order, select No. 

 To post the payment and update the customer order, select Yes. 

 To cancel the action and not update the order or post payments, select Cancel. 

Reversing a Posted Payment 

To reverse a posted A/R payment, do the following: 

1 Enter a negative A/R payment for the customer with the same check number. You must add a 

one or zero to the end of the original check number, as the system will see that this check has 

already been used for this customer. 

2 Distribute the negative amount to the invoices that were originally paid. If the original payment 

was distributed as an open payment to the customer's A/R journal, then distribute the negative 

amount the same way. 

3 Create a zero-amount invoice (for example, 0.00) and post it to the customer's A/R journal. 

4 Reapply the open positive payment to the zero-amount invoice. 

5 Reapply the open negative payment to the zero-amount invoice. 

6 Post the payments to zero them out on the customer's A/R journal. 

Posting A/R Direct Debit Payments 

1 Open the A/R Direct Debit Posting form.  

2 Select Display Report Header if you want to include a header on each page of the payment 

report. 
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3 Select the ranges of customers, bank codes, due dates, and direct debit numbers that you want 

to include in the payment post.  

4 To populate the grid and print the payment report, select Print and click Process. 

5 In the grid, select Process for the records that you want to include. 

6 To post the payments, select Commit and click Process. 

After posting A/R direct debit payments, these actions are performed: 

 The appropriate journals are posted to:  

 Debit: Direct Debit Receivable 

 Credit: Accounts Receivable 

 The corresponding direct debit status is set to Generated. 

 A DebitTransfer BOD is triggered containing the A/R payment data. 

 The customer's SEPA mandate last used date is updated to the current date. 

Purging A/R Direct Debits 

1 Open the A/R Direct Debit Purge form.  

2 Select the range of direct debit records you want to purge. 

3 Select the statuses of the direct debits that you want to purge:  

 Cancelled 

 Paid 

 Voided 

4 To review the list of direct debits that will be purged before actually deleting them, select 

Preview and then click Process. The grid at the bottom of the form is updated with the list of 

records that match your selection criteria. 

Purging Drafts 

The A/R Draft Purge utility deletes draft records, based on status. Only Cancelled, Paid, and Voided 

drafts can be purged. A register of the purged drafts is produced as an audit trail. 

To purge A/R drafts: 

1 Open the A/R Draft Purge form. 

2 (Optional) By default, all drafts are purged, but you can select a range of drafts to purge instead. 

3 Select the status check boxes for the drafts you want to purge: Cancelled, Paid and/or Voided. 

4 To review the list of drafts that will be purged before actually deleting them, select Preview and 

then click Process. The grid at the bottom of the form is updated with the list of drafts that match 

your selection criteria. 
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5 After reviewing the list and optionally making changes to the selection criteria, to purge the 

drafts, select Commit and then click Process. 

Purging Invoice History 

To purge the invoice history: 

1 Open the Purge Invoice History form. 

2 In the Ending Invoice field, select the last invoice whose associated history information you 

want to delete. 

3 In the Ending Invoice Date field, select the date of the last invoice you want to delete. 

4 To delete only transaction list items and not their associated header information, select the 

Delete Line Items Only check box. 

5 Select the source of the transactions you want to delete: Order Entry, A/R or Both. 

6 Click Process. 

CAUTION: Running this utility may impact the use of invoice sequencing by adding gaps to invoice 

series. Run this utility after deleting an invoice/credit memo/debit memo sequence. (Deleting a 

sequence automatically voids any unused numbers in the sequence.) 

NOTES:  

 You must use the Activate/Deactivate Posted Transactions - A/R utility to deactivate A/R 

posted transactions before purging. 

 Purging the invoice history does not remove the invoice and payment from the A/R Posted 

Transactions Detail form. In order to do that, you must run the Delete A/R Posted 

Transactions utility before purging the invoices. 

Reapplying Open Payments and Credits for Customers 

If you add a customer payment and a payment distribution type of Open Credit for it, and then post 

the payment, you can reapply the posted payment. 

1 Open the A/R Payments form. 

2 To add a payment, select Actions > New. 

3 Select the customer number, and enter the check number that matches the open payment you 

want to reapply. The system fills in the G/L Reference field with the description Re-Application of 

Open Payment. 

4 (Optional) Change the G/L Reference, Description, and Notes fields.  

NOTE: When reapplying open credits, do not change the Receipt Date. The journal entries 

created will be a debit and credit to the A/R account. When reapplying an open payment, and a 

separate A/R Deposit account is used, change the Receipt Date to current date. The journal 
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entries created will be a debit to the A/R Deposit account and a credit to the A/R account. If the 

deposit account is the same as the A/R account, then the receipt date should not be changed. 

5 Click Distributions. 

6 To add the new distribution(s), select Actions > New. 

7 Post the reapplication and distribution(s). 

8 To verify that the system has reapplied the open payment, you can view it using the A/R Posted 

Transactions Detail and A/R Posted Transactions Summary forms. 

  

Reapplying Open Payments or Credits Against Multiple Invoices 

To reapply an open payment or credit against multiple invoices you will need to create a payment 

distribution for each invoice. 

1 On the A/R Payment form, add the customer. 

2 If you are reapplying a payment, enter the check number. If you are reapplying an open credit, 

find the chk/ref number on the A/R Posted Transaction form. Use this chk/ref number in the 

check number field.  

3 After the check number is populated, the date and the amount of open payment/credit will 

appear on the form and the reference will identify this as a reapplication. If this does not happen, 

either the check number is incorrect, or your chk/ref number is incorrect. 

After the system recognizes this transaction as a reapplication, save the payment record and 

click the Distribution button. 

4 On the A/R Payment Distribution form, click New to create a new distribution. Usually the Type 

will be Invoice and you will enter the invoice number. If the reapplication does not pay the invoice 

in full, change the amount of the distribution to be the amount to be paid against this invoice. 

5 If the open payment is for more than the total amount you are applying (for example, you have 

check for 1=$100.00 and you want to only apply $75.00 at this time), create a distribution for the 

remaining amount. Change the type from Invoice to Open and put in the remaining amount. If 

the balance will be a non-A/R transaction, change the type from Invoice to Non-A/R Payment 

and enter the amount and the account number. 

6 After all distributions have been created and amount remaining equals zero, save the 

distributions. 

7 Post the check. 

Running the Accounts Receivable Aging Report 

To view the current status of all customer account balances, use the Accounts Receivable Aging 

Report form. 
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Normally, you print this report at the end of the period, before you print statements. This report is 

helpful in identifying customers with past-due invoices. 

To print the Accounts Receivable Aging Report: 

1 Select the field values and check boxes to define the parameters of the report you want.  

The default selections print a report for all customers. 

2 (Optional) To view the report before printing the final version, click Preview. 

3 To print the final report, click Print. 

Running the AR Balance History Utility 

To update the average balance outstanding, the largest balance outstanding, and the last amount 

outstanding for selected customers, use the A/R Balance History utility. 

1 Specify the range of customers and the date through which this utility should update customer 

balances. 

2 To reset the selected customers' balance history information, select the Reset Period Count To 

1 check box. 

3 Click Process. 
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About Cancellation Posting for Single-Entry 
Accounting 
For businesses that use single-entry accounting, cancellation posting allows for cancellation or 

reversal adjustment transactions using a negative entry on the same side, debit or credit, as the 

original entry. A negative sign (–) is displayed to identify the adjustment. Cancellation posting is 

available for accounts payable adjustments and accounts receivable credit memos.  

Setup and Application  

You enable cancellation posting functionality by selecting a setting on the General Parameters 

form. You can then apply this functionality to individual adjustment entries on the Invoices, Debit 

and Credit Memos and A/P Vouchers and Adjustments forms. 

When you apply cancellation posting to a transaction record, these indications are visible on 

subsequent posted transactions, journal entries, and ledger reports for the transaction:  

 On related forms and reports, a negative sign (–) is displayed with the adjustment amount.  

 On these forms, a display-only Cancellation check box is selected:  

 A/P Posted Transactions Detail  

 A/R Posted Transactions Detail  

 G/L Posted Transactions  

 Journal Entries 

 On these reports, an X is displayed next to the transaction:  

 A/P Voucher Posting Report  

 Invoice Transaction Report  

 Journal Transaction Report  

Processing Rules  

This section explains processing rules for cancellation posting. 

Accounts Payable  

On the A/P Vouchers and Adjustments form, a cancellation posting adjustment references the 

original voucher number and reverses the entire amount of the original voucher. Partial adjustments 
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cannot be made. Also, amounts and discount and due dates from the original voucher cannot be 

changed.  

Posted vouchers can be cancelled only one time. Posted vouchers referenced by posted 

adjustments or payments cannot be cancelled.  

Accounts Receivable  

On the Invoices, Debit and Credit Memos form, a cancellation posting credit memo references the 

original invoice number and reverses the entire amount of the original invoice. Partial credit memos 

cannot be made. Also, amounts from the original invoice cannot be changed. The due date follows 

existing rules based on credit terms. 

Posted invoices can be cancelled only one time. Posted invoices referenced by posted credit 

memos, debit memos, or payments cannot be cancelled.  

Journal Entries and General Ledger Posted Transactions  

On the Journal Entries and G/L Posted Transactions forms, negative-signed debit and credit 

amounts are displayed for cancellation adjustments in the AP Dist journal and for cancellation credit 

memos in the AR Dist journal. Debit amount totals are tallied using the sum of positive and negative-

signed debits. Credit amount totals are tallied using the sum of positive and negative-signed credits. 

All other entries are displayed using traditional double-entry accounting notation.  

Example Journal Entry for a Cancellation Credit Memo  

The application of cancellation posting does not alter transaction entry. It affects only the display of 

the debit and credit amounts and totals, as shown in this example:  

Original A/R Invoice 

Double-Entry Credit Memo for 

Original Invoice 

Single-Entry Cancellation Posting 

Credit Memo for Original Invoice 

Dr  Accounts Receivable      119  

      Cr  Revenue                                 100  

      Cr  VAT                                          19 

Dr  Revenue                              100  

Dr  VAT                                       19  

      Cr  Accounts 

Receivable                119          

Dr  Accounts Receivable    – 119  

      Cr  Revenue                                –

 100  

      Cr  VAT                                          –

19       

Reporting 

Reports related to voucher adjustments and credit memos display transactions using negative-

signed debit and credit amounts. This applies to reporting that occurs during the transaction-to-
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journal-to-ledger cycle. Again, debit amount totals are tallied using the sum of positive and negative-

signed debits. Credit amount totals are tallied using the sum of positive and negative-signed credits.  

For information about reporting rules when the Separate Debit and Credit Totals option is also 

applied to reports, see Separate Debit and Credit Totals.  
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Creating and Maintaining Budgets and Plans 
Budgets are estimates of anticipated receivables and payables for a specific time frame. They are 

usually based on historical facts, including past sales and growth trends. The budget amounts are 

used by General Ledger reports, financial statements, and the Chart of Accounts Report. Budgets 

are also displayed when viewing posted General Ledger (G/L) transactions to allow a comparison 

between a period's actual transaction amount and the budgeted amount. 

The Chart of Accounts Budget and Plan form is a worksheet that you use to create budgets and 

plans for each individual account, accounting period, and fiscal year. This form maintains information 

for budgets, plans, and actual change amounts. Actual change values are used only to define 

statistical accounts.  

The Chart of Accounts Budget and Plan form allows you to store budgets for multiple fiscal years. 

Each time a new fiscal year is added to the accounting periods or a new Chart of Accounts is added, 

you must manually add corresponding budget, plan, and actual records. You can either click New to 

add them one at a time or use the Copy Balances to Budgets form to copy ranges of Unit Codes 

and account ranges to and from fiscal years. These amounts are useful for comparing actual 

financial activity against budgeted or planned activity.  

Budget amounts and plan amounts are handled the same way. The plan amounts simply allow for a 

second budget or planning figure. A common practice is to use the plan amounts to maintain last 

year's sales figures. 

If you are using a second Analytical Ledger in addition to the General Ledger, see About Analytical 

Accounting to learn how budgets and plans are affected. 

To enter amounts manually for a new fiscal year:  

1 Select Actions > New. 

2 Select the account. 

3 Select the fiscal year, if necessary. 

4 In the Budgeted Change field, enter the amount. 

5 In the Planned Change field, enter the amount. 

6 Click Actions > Save. 

You can use the Planned Change amounts in this form to contain last year's account balances. 

To create a base value for budgeted amounts that increment each preceding accounting period by a 

specific percentage:  

1 Select Actions > Budget Growth Auto-Set.  

The system displays the Chart of Accounts Budget and Plan Growth form. 

2 Enter the base amount and the desired percentage increase per accounting period.  

This process updates each accounting period for that year. 
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3 To save the entries, click OK. 

To create a base value for planned amounts for all currently defined accounting periods that 

increment each preceding accounting period by a specific percentage:  

1 Select Actions > Plan Growth Auto-Set.  

The system displays the Chart of Accounts Budget and Plan Growth form. 

2 Enter the base amount value and the desired percentage increase rate of change per accounting 

period.  

This process updates each accounting period for that year. 

3 To save the entries, click OK. 
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Consolidation Overview 
You can consolidate your financial data from several sites for timely reporting and online queries. 

Entities 

In a multi-site environment, you can specify a hierarchy of financial entities that operating sites report 

to. A financial entity is a level of business operation for which there is: 

 A complete set of financial statements, 

 Its own domestic currency code, which must be shared by sites that report to it, and its own 

currency rates, which may or may not be shared by reporting sites/entities. 

 Its own account template, chart of accounts, and accounting periods, which must be shared by 

reporting sites. (Reporting entities do not have to share these characteristics.) 

Each entity allows no business activity aside from period, chart and currency maintenance, and the 

reporting of its consolidated ledger and budgets. Entity users should all belong to the default 

authorization group Entity Forms, which limits them to using only entity-level forms. They should also 

be licensed for the "Infor CloudSuiteEntity" module. 

If ledger detail is replicated to the entity from the sites, you may be able to view detail down to the 

level of the originating transaction. (This assumes that any other categories required for the 

transaction-level detail are also being replicated. Having this level of G/L and other transaction detail 

replicated to the entity generally does not make sense from a performance standpoint.) Otherwise, 

you will need to access the specific site in order to view the transaction detail. 

Sites Reporting to an Entity 

The majority of operations at sites reporting to an entity remain the same as at a non-reporting site, 

including the financials. If a site reports to an entity, the site's Chart of Accounts is now owned by the 

entity and copied from it. In the local copy of the Chart of Accounts, you can delete records to use a 

subset of the accounts. The site must use the domestic currency of its entity, but it may use its own 

rates. Consolidation utilities must be run at the reporting sites to copy the posted ledger transactions 

and budgets into the entities all the way up the hierarchy. 

A site is not required to report to an entity, in which case its financials are not consolidated. 
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Setup of Entities and the Reporting Structure 

When you create system databases or add sites and entities to a database in the Configuration 

Wizard, you must specify a site type. When you create entities in the Configuration Wizard, specify a 

site type of entity. 

Operational data such as entry or selection of customers and vendors is not necessary for entities. 

Defining the Hierarchy 

To define or change the hierarchy of your sites and entities, several tools are available: 

 Change Reports to Entity: Use this utility at the reporting site/entity to specify the next-level 

entity to which this site/entity reports. 

 Multi-Site Chart Copy: Use this utility at the entity to copy the Chart of Accounts to the reporting 

sites/entities. 

 Ledger Consolidation: Use this utility at the reporting site/entity to consolidate all previously 

unconsolidated records for the site, all the way up the financial reporting hierarchy. 

NOTE: Additional steps are required in order to initially set up a financial hierarchy. For more 

information, see Setting Up a Consolidation Reporting Structure. We suggest that you contact Infor 

Consulting Services to help with your implementation. 

It is not necessary to have a balanced financial hierarchy. 

Changes to Your Reporting Structure 

Over time, sites come and go and the hierarchy of entities may change. As these changes occur, the 

historical consolidated financial data will not change, and an historical time-phased site/entity 

structure will be maintained. This allows prior period reporting and drill-downs to yield identical 

results, even after the structure has changed. On the date of a reporting structure change, a large 

transaction is posted to close out all accounts for all selected subordinate sites, computing the 

account balance of each account. Half of this transaction is immediately consolidated to the existing 

structure, effectively zeroing the balances from the books. After the hierarchy is changed, the other 

half of the transaction is consolidated to the new structure, creating opening balances for all the 

accounts. At the site level, this has no effect, since a debit and credit for the same amount is posted 

to the same account on the same date. 

Be aware of the following when changing the reporting hierarchy: 

 Financial statement reporting at entities only shows data for transactions that occurred during the 
time period that the hierarchy was in place. 

 When you change an entity's Reports To mapping, there is no historical audit trail of how it was 
formerly set up. 

 Transactions are consolidated to the current structure only, regardless of effective date of the 
hierarchy change or the ledger transaction date. 
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NOTE: Sites can only report to entities that have matching reporting parameters. This includes the 

same chart template, domestic currency and financial periods, as well as every Chart of Accounts 

already defined at the entity. 

Additional Notes 

Currency 

Average exchange rates are calculated based on exchange rates established by sites (set up by site 

or mid-level entity that the site reports to in a shared currency environment). During ledger 

consolidation, when posting revenue and expense accounts, exchange rates set up at the site level 

(set up by site or mid-level entity that the site reports to in a shared currency environment) are used 

to calculate average exchange rate for the period and are used to translate site amounts in site's 

currency to corporate currency. Exchange rates must be set up at the site (or mid-level entity that 

the site reports to in a shared currency environment) for Ledger Consolidation to correctly post 

amounts in corporate currency. 

When dealing with multiple currencies in a consolidated environment: 

 The base (domestic) currency must be the same at all sites reporting to an entity. However, you 

may set up the sites so they can maintain their own currency exchange rates - or you may want 

to maintain the rates only at the entity. For more information, see the section on replicating 

shared currency in Default Replication Categories. 

 In each entity's Chart of Accounts, the currency translation method and the exchange rate type 

are specified for each account. 

 The currency table of the entity is the one used for translation during the consolidation. (Sites 

use the domestic currency of their entity, so there is no currency translation at this level.) 

Combined vs. Consolidated Reporting 

Financial statements can either show combined data from a group of sites, or consolidated data from 

an entity and its reporting sites. 

If you want to create sample financial statements before changing a hierarchical structure, to see 

what the combined data from multiple sites will look like, you can mimic the new structure by using 

multi-site group IDs and combined financial statements. For more information, see Combined 

Financial Statements. 

Even after you have set up a consolidated environment, you may still run combined financial 

statements for a group of sites. 

When you run consolidated financial reports from the entity, all sites that report to the entity must 

have run the Ledger Consolidation utility. When the financial statement is run, no currency 

translation is required, because the data at the entity level is already translated into the entity's 

currency and Chart of Accounts. Also, since no multi-site group IDs are specified, it looks only at the 
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information in the entity. Therefore, consolidated financial reports run much faster than combined 

financial reports. 

Unit Code Mapping 

Each unit code is copied to the Reports To entity verbatim if that account in the Reports To entity 

has the unit code enabled. 

Budget Consolidation 

Use the Budget Consolidation utility at the reporting site/entity to consolidate all previously 

unconsolidated site budgets and plans through the cutoff date. All entities in the hierarchy that are 

senior to the current site must be replicating G/L or Ledger Consolidation data with the current site. 

Each budget and plan for each account is consolidated all the way up the hierarchy; the budget and 

plan at the current site remains unchanged. For higher level entities, the newly created budgets and 

plans are stored using that entity's chart of accounts, base currency, and financial periods. 

If a site or entity enters and leaves a hierarchy in the course of a single year, the original budget/plan 

will be replaced with the later one. 
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Generating a Positive Pay File 
A positive pay file is a file you send to your bank that provides a list of the checks issued, their dollar 

amounts, and your bank account number in a text file. 

Generating this file involves using three forms: 

 Positive Pay Format Sections 

 Positive Pay Format Fields 

 Positive Pay File Generator 

Create the format 

1 Open the Positive Pay Format Sections form. 

2 Select the desired bank code. 

3 Provide the format.  

You must get this format from the bank.  

4 Select section 1, 2, or 3. 

5 Provide a description of the section if desired. 

6 Save. 

Define Fields 

1 Open the Positive Pay Format Fields form. 

2 Select the bank code, format name, and section.  

The format name and section choices for each bank code were created on the Positive Pay 

Format Sections form.  

3 Provide a sequence number. 

4 In the Type field, specify Constant, Database, or Function.  

Other fields on this form are either active or inactive depending on the choice you choose here.  

5 Provide the length. 

6 Save. 
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Generate the File 

1 Open the Positive Pay File Generator form. 

2 Select the bank code and the format name. 

3 Select a check date range. 

4 Either accept the default location and name for the file, or change this. 

5 Click Process. 
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Offsetting A/R Invoices and A/P Vouchers 
To offset A/R Invoices and A/P vouchers: 

1 Create an offset account on the Accounts Payable Parameters form. 

2 Link a customer to a vendor with the Customer field on the Vendors form. 

3 Create offsetting payments for A/R and A/P on the A/R A/P Payment Offset form. 

a Select either the vendor or the customer. Only vendors and customers with a corresponding 

customer or vendor appear in the drop down lists. The grid populates with outstanding 

invoices and vouchers. 

b Select a combination of vouchers and invoices that have equal amounts. For example, select 

an invoice for $1,000 and two vouchers; one for $400 and one for $600. If you don't have 

amounts that exactly balance, click the offset amount either for the voucher or the invoice 

and provide the new number. 

c Click the Create Offsets button. A message is displayed that tells you that A/P and A/R 

payment distributions were created. You can now post these payments using the A/R 

Payment Posting and A/P Check Printing/Posting forms. The grid on the A/R A/P 

Payment Offset form does not refresh with current data until you post. 

4 View payments as offset with the Offset check box on these forms: A/R Payments, A/R 

Payment Distributions, A/P Payments, and A/P Payment Distributions. 
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Invoice Builder Overview 
With the Invoice Builder form, you can: 

 Generate invoices and credit memos across a multi-site intranet. Invoices and credit memos 

generated by the Invoice Builder form are only from shipped and returned customer order 

lines/releases. The invoices and credit memos are generated based on the target site 

configurations such as invoice numbering, currency code, etc.  

 Print and reprint invoices and credit memos across a multi-site intranet. 

You can perform these tasks for both the base site (login site) and the target site (a different site 

within the same multi-site intranet). For other sites, if the site domestic currency is different from the 

base site, or if the customer currency code of this site is different from the customer currency code of 

the base site, the customer order lines/releases are not displayed in Invoice Builder. 

What Happens When You Use This Form 

Using this form affects what you can do on other forms: 

 Builder Invoice Originating Site field is available on these forms: AR Payment Distributions, 

AR Posted Transactions Detail, Invoice, Debit and Credit Memos, and Invoices, Debit and 

Credit Memos G/L Distribution. 

 Builder Invoice field is available on these forms: AR Payment Distributions, AR Posted 

Transactions Detail, Invoice, Debit and Credit Memos, Invoices, Debit and Credit Memos 

G/L Distribution, Multi-Site Invoice Posting, and Invoice Transaction Report. 
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Using the Invoice Builder 
The Invoice Builder is a form that allows you to generate and print invoices for CO shipments and 

returns in multiple target sites from a base site crossing a multi-site intranet. 

Setup 

1 If desired, specify a builder invoice prefix on the Order Entry Parameters form. 

2 Set up Replication Rules for the Invoice Builder category. The Invoice Builder base site (login 

site) and the target sites must all be replicating the Invoice Builder replication category to each 

other.  

Generate and Print an Invoice or Credit Memo 

1 On the Invoice Builder form, specify a customer in the Customer field. If you leave the field 

blank, all customers are returned. 

2 In the Type field, specify Invoice or Credit Memo. If you choose Invoice, shipped but not 

invoiced customer order lines/releases are displayed. If you choose Credit Memo, returned but 

not invoiced customer order lines/releases are displayed. 

3 In the Invoice Type group box, select the options for the types of invoices you want to include. 

4 You can use the grid to make selections, or use the Additional Selection tab to make selections 

for a larger number of records. If you use the Additional Selection tab, click the Select 

Matching CO button to see the desired selections in the grid. 

5 Use the Print tab to customize further. You can also set reprint criteria on this tab. 

6 Click Process. 
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About Bank Statement Reconciliations 
The Bank Statement form displays information relating to one customer or vendor bank identifier 

code (BIC) or to one employee account used for payment. This information is generated from 

BankStatement BODs that are received from Infor Local.ly GEMS. GEMS receives bank statements 

in the proprietary format of specific banks and transforms them into Infor standard BODs that are 

then sent to Infor CloudSuite. 

Automatic A/P Payments 

When a BankStatement BOD is received into Infor CloudSuite, automatic payments are generated 

for any A/P transactions in the statement that have a domain family code of Issued Direct Debits 

(IDDT) or Issued Credit Transfers (ICDT). Use the A/P button on the Bank Statement form to view 

the A/P payment transactions that were created automatically. The A/P button is enabled only for 

IDDT or ICDT transactions. 

An agreement could exist between the provider and the customer for automatic transfer of funds as 

payment for a product or service. Control methods for this transfer of funds are considered 

separately; there is a general tolerance on the voucher and the payment that results in a variance 

that must be monitored.  

Generally, you can expect that the bank statement is correct and can be reconciled with your 

general ledger. If the billing is incorrect and must be adjusted, perform the adjustment as a reversal, 

because it requires all parties to apply the adjustment. There is no reason to deny an automatic 

transaction that may be in error, because the other parties will still show an incorrect transaction until 

all parties agree on a resolution. 

A/R and A/P Transactions in the Bank Statement 

In order to balance your books, you must be able to view all relevant bank statement transactions 

(records and charges). Some records show transactions that require subsequent action; other 

records indicate a completed and accepted transaction: 

 A/R records usually require confirmation of an existing transaction that has already been initiated 

and performed.  

 A/P recods usually require the execution of an A/P payment transaction. Ideally the payment is 

associated with a Vouchers Payable transaction and can be reconciled. The final reconciliation 

of the voucher must be done manually, because the process is variable. Not all A/P transactions 

require an A/P payment; for example, the transaction could be a result of a check, wire posting 

or other transaction type that is only being reported in the bank statement.  
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All bank statement line records are available for review. You must determine which records require 

manual action on your part. 

Transaction Types 

The bank statement can include many transaction types. The transaction type codes follow ISO 

standards, and are divided into domain codes, domain family codes, and domain sub family 

codes.  For example, the Account Management (ACMT) family code is subdivided into domain family 

codes such as Miscellaneous Credit Operations (MCOP) and Miscellaneous Debit Operations 

(MDOP), which are further subdivided into domain sub family codes, for example Commission 

(COMM), Fees (FEES), Interest (INTR) and so on. These transaction codes are predefined on these 

forms: 

 ISO Bank Transaction Domain Codes 

 ISO Bank Transaction Domain Family Codes 

 ISO Bank Transaction Domain Sub Family Codes 

Currency Exchange 

The source currency for the bank transactions is always the account owner's currency. A/P 

transactions are converted to domestic currency using the specified exchange rate. Fluctuations in 

the exchange rate are reflected in the currency gains and losses. For more information, see About 

Realized and Unrealized Gains and Losses.  

For example, a vendor bank account is established using the Philippine Peso (PHP). The bank 

statement reports all transactions using PHP. To apply an A/P voucher, the target currency for the 

voucher must also be PHP.  

If a fixed exchange rate is applied (by agreement between all parties), no variance occurs due to 

currency fluctuations.  If a variable exchange rate is used, all vouchers will have fluctuations based 

on currency rate fluctuations. Thus, to have the vendor's currency in balance with your domestic 

currency, there must be a redistribution if the exchange rate has changed since the voucher was 

created. This causes offsetting transactions for currency gains and losses, because the change in 

exchange rate changes the value of the PHP account in domestic currency. The voucher value 

would also be adjusted up or  down in relation to domestic currency. 

To protect against currency fluctuations, you can set up an account in the vendor's currency, and 

pay the vendor from that account. That way, the currency is never actually exchanged into your 

company's domestic currency, even though it is represented in Infor CloudSuite in the domestic 

currency amounts. Offsetting gains and losses cancel each other out.  

If your payment account is in a different currency from the vendor's currency, then the exchange rate 

is determined at the time of exchange (?payment?) , and you do not have offsetting currency 

adjustments.  
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For A/R accounts in Infor CloudSuite, the currency used in the account must be either the domestic 

currency or the customer's (?) currency. For A/P accounts, we recommend that you use either the 

vendor's currency or the domestic currency. 
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Purging Bank Statements 
Use the Bank Statement Purge Utility to purge bank statement records that are marked as 

Processed. You can set up this utility to process batches of records on a regular schedule. 

Purging Individual Statements 

1 On the Bank Statement Purge Utility form, select the range of dates for which you want to 

delete records. 

2 If your selection criteria include dates and you are scheduling the process to run periodically, 

select Increment Date. 

3 Specify the range of reference types (Bank, Customer, Vendor, or Employee) for which you 

want to delete records.  

4 Specify the range of reference numbers. For example, if you specified Customer as the 

Reference Type, specify the range of processed customer bank statement records to purge. 

5 Click Process. 

Purging a Batch of Statements 

To purge processed bank statements on a regular basis, specify your selections in the Bank 

Statement Purge Utility form and select Actions > Background Queue. Then see the instructions 

in Scheduling Background Tasks. 
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About Statistical Accounts 
Statistical accounts are used to track non-financial, that is, non-monetary, amounts over a period of 

time.  

You can use the information from statistical accounts to compare non-financial data to related 

financial data - for example, compare Shipping Expenses to Quantity Shipped in each shipping 

department - in order to control costs or measure productivity.  

You can also use statistical accounts to track periodic changes in non-financial data, and to allocate 

and distribute expenses based on that variable data. For more information, see Example: Allocating 

Expenses with Variable Percentages based on YTD Amounts from Statistical Accounts. 

NOTE: You can only use statistical accounts within the Chart of Accounts form and the Chart of 

Accounts Budget and Plan form, where they are maintained. 
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Currency 

About the Euro Triangulation Conversion 

During a euro conversion interim period (when one or both of the currencies involved is a part-of-

euro currency and neither currency is the euro), euro regulations prohibit direct currency conversions 

between participating countries. Therefore, to convert a monetary amount from one national 

currency to another, the system currency conversion process: 

 Converts the amount from the national currency to the euro. 

 Converts the resulting amount, which is expressed in euros, to the other national currency. 

For example, to convert Deutsche marks to francs: 

The same principle applies if your domestic currency is not part-of-euro, but you need to do business 

with a vendor or customer situated in a participating country who will be using the euro, but has not 

yet switched to it. The system conversion process 

 Converts the amount from your domestic currency to the euro. 

 Converts the resulting amounts, which are expressed in the euro currency, to the national 

currency of the vendor or customer. 

For example, to convert US dollars to francs: 
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The exchange rate between each participating national currency and the euro is fixed. If the 

currency is part-of-euro, this fixed exchange rate to the euro is stored in the system  (on the 

Currency Codes form). There is only one exchange rate to the euro (1 euro =) for each part-of-euro 

currency there is no buy and sell rate. 

NOTES:  

 This conversion process applies only if one or both of the currencies involved is a part-of-euro 

currency and neither currency is the euro. If one of the currencies is the euro, the system 

performs the conversion normally. Also, if one of the currencies involved in a transaction is 

part-of-euro, and the other currency uses the Rate is Divisor option, the triangulation is 

calculated differently. 

 The system does not round any numbers during this conversion process. After the conversion 

is complete, the system rounds the final value to match the display format of the end currency. 

Conversion rates are always expressed as 1 euro to the other currency. 

 The use of francs and Deutsche marks above is only for illustration purposes; in reality, both 

currencies have already been converted to the euro. 

Converting the Domestic Currency to the Euro 

To change your base domestic currency to the euro currency and convert all related records, use 

these steps. Where applicable, refer to the linked help topics for more information. 

1 Perform a complete database backup. 

2 Set up a currency code for the euro. 

3 On the Currency Codes form, select the Part of Euro check box for your base currency. 

4 On the Currency Rates form, enter the correct Buying Exchange Rate and Selling Exchange 

Rate for all currencies, including the euro. 

5 Post all A/P and A/R transactions. 
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6 Process and post all records of the types listed in the Unconverted Records Help topic. 

7 Open the Domestic Euro Currency Conversion utility. 

8 To use the standard unit cost for the purchased item, select the Use Std Cost for Purchased 

Item check box. To use the current unit cost from the Item Costs form to update the material 

cost for purchased items, clear this check box. 

9 In the Account field, enter the number of the account to contain any rounding variances that 

may occur during the conversion process. 

10 To start the conversion, click Process.  

NOTE: If your system still contains unposted A/P or A/R transactions (such as payments, 

invoices, vouchers, etc.), the conversion process does not proceed and the system generates an 

error message stating the type of transactions that must be posted. 

11 After the conversion is complete, to convert the period totals records, run the Rebalance Ledger 

Period Totals utility. 

12 Run the Recalculate Journal Balances utility for each journal. 

13 To update the low level codes, run the Current Bill of Material Processor. 

14 To correct any possible rounding errors from the conversion of cost values, run the Current 

BOM Cost Rollup utility. 

Converting a Multi-Site Installation 

If you are converting a multi-site installation, perform the following steps: 

 After running the conversion utility, review and manually reestablish the exchange rates for your 

inter-site transactions (defined on the Inter-Site Parameters form). The conversion utility does 

not convert these rates automatically. 

 When you convert an individual site, you must also convert all sibling sites (the sites of the same 

low-level entity) and the parent low-level entity at the same time. 

 When you convert a low-level entity, the conversion utility does not convert any of its child 

entities. To convert child entities, run the conversion utility for each entity. 

NOTE: If you are converting a low-level entity that has no direct child sites, you can convert the 

entity without converting any other entities. 

About Realized and Unrealized Gains and Losses 

When a company headquartered in one (domestic) country executes a transaction with a company 

in another (foreign) country using a currency other than the domestic currency, one currency needs 

to be converted into another to settle the transaction. This conversion from one currency to another 

creates gains and losses depending on the currency exchange rate. 

This topic covers realized and unrealized currency exchange gains and losses. 
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Realized Currency Exchange Gains and Losses 

Realized currency exchange gains and losses can occur when full or partial payments are applied to 

voucher or invoice amounts. 

NOTE: Gains and losses are calculated on each payment amount instead of the outstanding 

voucher or invoice amount. 

Balance Paid in Full 

In the following examples, the transactions were completed by the receipt of the payment of cash. 

Therefore, any exchange gain or loss was realized and, in an accounting sense, was recognized on 

the date of the cash receipt or cash payment. 

For example, a U.S. company purchasing items from a British company that requires payment in 

British pounds must exchange dollars ($) for pounds (£) to settle the transaction. This exchange of 

one currency into another involves the use of an exchange rate. If the U.S. company had purchased 

items for £1,000 from a British company on June 1, when the exchange rate was $1.40 per British 

pound, $1,400 would need to be exchanged for £1,000 to make the purchase. 

NOTE: The foreign exchange rates used in this example do not reflect current rates. 

Because the U.S. company maintains its accounts in dollars, the transaction would be recorded as 

follows: 

June 1 Purchases ......................... 1,400 

Cash ............................................. 1,400 

Payment of Invoice #1725 from Sterling Co. 

 

£1,000; exchange rate: $1.40 per British pound 

Special accounting problems arise when the exchange rate fluctuates between the date of the 

original transaction (such as a purchase on account) and the settlement of that transaction in cash in 

the foreign currency (such as the payment of an account payable). In practice, such fluctuations are 

frequent. 

For example, assume that on July 10, when the exchange rate was $.004 per yen (¥), a purchase for 

¥100,000 was made from a Japanese company. Since the U.S. company maintains its accounts in 

dollars, the entry would be recorded at $400 (¥100,000 X $.004), as seen below: 

July 10 Purchases .......................................... 400 

Accounts Payable - M. Suzuki ......................... 400 

Invoice #823 

 

¥100,000, exchange rate: $.004 per yen 

If on the date of payment, August 9, the exchange rate had increased to $.005 per yen, the 

¥100,000 account payable must be settled by exchanging $500 (¥100,000 X $.005) for ¥100,000. In 
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this case, the U.S. company incurs an exchange rate loss of $100, because $500 was needed to 

settle a $400 debt (accounts payable). The cash payment would be recorded as follows: 

August 9 Accounts Payable - M. Suzuki ......................... 400 

Exchange Loss .............................................................. 100 

Cash .............................................................................. 500 

Cash paid on Invoice #823 

 

¥100,000, or $400, current exchange rate: $.005 per yen 

All transactions with foreign companies can be analyzed as in the examples above. For example, 

assume that on May 1, when the exchange rate was $.25 per euro, a sale on account for $1,000 

from a U.S. company to a French company was billed in euros (€4,000). The transaction would be 

recorded as follows: 

May 1 Accounts Receivable - Crusoe Co. .................... 1,000 

Sales .......................................................................... 1,000 

Invoice #7782 

 

€4,000, exchange rate: $.25 per euro 

If the exchange rate had increased to $.30 per euro on May 31, the date of receipt of cash, the U.S. 

company would realize an exchange gain of $200. The gain was realized because the €4,000, which 

had a value of $1,000 on the date of sale, had increased in value to $1200 (€4,000 * $.30) on May 

31 when payment was received. The receipt of the cash would be recorded as follows: 

May 31 Cash .................................................. 1,200 

Accounts Receivable - Crusoe Co. .................. 1,000 

Exchange Gain .................................................. 200 

Cash received on Invoice #7782 

 

€4,000 or $1,000, exchange rate: $.30 per euro 

Partial Payments 

When the balance is not paid in full, however, the system calculates currency gains and losses on 

each payment amount instead of the outstanding voucher or invoice amount. The system uses the 

following formula when performing the gain/loss calculation: 

Gain/Loss Amount = (Payment / Average Exchange Rate) - (Payment / Payment Exchange Rate) 

where: 

Average Exchange Rate = Foreign Amount Outstanding Balance / Domestic Outstanding Balance 
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For example, a German company purchasing items from an U.S. company pays in euros. The U.S. 

company must then exchange euros for U.S. dollars to settle the transaction. In this case, the 

German company is making partial payments rather than paying the balance in full. The transaction 

would occur as follows: 

Partial Payment Transaction: Euros to U.S. Dollars 

  

Foreign 

Amount 

 

(euro) 

   Exchange 

Rate    

Domestic 

Amount 

 

(U.S Dollar)      

Invoice #1800 €1100.00 €2:$1 $550.00   

Credit Memo 200.00 4:1 50.00   

Balance 900.00   500.00 Avg. Exch. Rate: 

900:500 = 1.8 

Payment 600.00 3:1 200.00   

Loss     133.33 Loss: (600/1.8) - 

(600/3) = 133.33 

Balance 300.00   166.67 Avg. Exch. Rate: 

300:166.67 = 1.8 

Payment 300.00 3:1 100.00   

Loss     66.67 Loss: (300/1.8) - 

(300/100) = 66.67 

Balance 0.00   0.00   

The German company purchases items from the U.S. company for €1100 at an exchange rate of 

€2.00 per $1.00. After a credit memo for €200 is issued, a credit is shown for $50 due to a exchange 

rate of €4.00 per $1.00, resulting in a balance of €900 ($500). 

Before calculating the gain/loss amount, the system must first calculate the average exchange rate 

by dividing the foreign balance by the domestic balance (€900 / $500 = 1.8 average exchange rate). 

After a payment of €600 at an exchange rate of €3.00 per $1.00, the loss is $133.33. The system 

calculates the loss by (Payment Amount/Avg. Exchange Rate) - (Payment Amount/Payment 

Exchange Rate) or (600/1.8) - (600/3) = 133.33. The resulting balance is €300 or $166.67. 

Again, before calculating the gain/loss, the system must first calculate the average exchange rate by 

dividing the foreign balance by the domestic balance (€300 / $166.67 = 1.8 average exchange rate). 
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The final payment of €300 at an exchange rate €3.00 to $1.00 settles the transaction, resulting in a 

loss of $66.67. The system calculates the loss by (Payment Amount/Avg. Exchange Rate) - 

(Payment Amount/Payment Exchange Rate) or (300/1.8) - (300/100) = 66.67. 

Unrealized Currency Exchange Gains and Losses 

However, if financial statements are prepared between the date of the original transaction (sale or 

purchase on account, for example) and the date of the cash receipt or cash payment, and the 

exchange rate has changed since the original transaction, an unrealized gain or loss must be 

recognized in the statements. 

For example, assume that a sale on account for $1,000 had been made to a German company on 

December 20, when the exchange rate was $.50 per euro (€), and that the transaction had been 

recorded as follows: 

Dec. 20 Accounts Receivable - Mueller Co. ............. 1,000 

Sales ...................................................................... 1,000 

Invoice #22 

 

€2,000; exchange rate: $.50 per euro 

If the exchange rate had decreased to $.45 per euro on December 31, the date of the balance sheet, 

the $1,000 account receivable would have a value of only $900 (€2,000 X $.45). This "unrealized" 

loss would be recorded as follows: 

Dec. 31 Exchange Loss ............................... 100 

Accounts Receivable - Mueller Co. ............... 100 

Invoice #22 

 

€2,000 X $.05 decrease in exchange rate 

Assuming that €2,000 are received on January 19 in the following year, when the exchange rate is 

$.42, the additional decline in the exchange rate from $.45 to $.42 per euro must be recognized. The 

cash receipt would be recorded as follows: 

Jan. 19 Cash ............................................. 840 

Exchange Loss ($.03X€2,000) .................... 60 

Accounts Receivable - Mueller Co. ............ 900 

Cash received on Invoice #22 

 

€2,000, or $840, exchange rate: $.42 per euro 

If the exchange rate had increased between December 31 and January 19, an exchange gain would 

be recorded on January 19. For example, if the exchange rate had increased from $.45 to $.47 per 

euro during this period, an exchange gain would be credited for $40 ($.02 X €2,000). 
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A balance in the exchange loss account at the end of the fiscal period should be reported in the 

Other Expenses section of the income statement. A balance in the exchange gain account should be 

reported in the Other Income section. 

Consolidated Financial Statements with Foreign Subsidiaries 

Before the financial statements of domestic and foreign companies are consolidated, the amounts 

shown on the statements for the foreign companies must be converted to domestic currency. Asset 

and liability amounts are normally converted to domestic currency by using the exchange rates as of 

the balance sheet date. Revenues and expenses are normally converted by using the exchange 

rates that were in effect when those transactions were executed. (For practical purposes, a weighted 

average rate for the period is generally used.) The adjustments (gains or losses) resulting from the 

conversion are reported as a separate item in the stockholders' equity section of the balance sheets 

of the foreign companies. 

After the foreign company statements have been converted to domestic currency, the financial 

statements of domestic and foreign subsidiaries are consolidated in the normal manner. For more 

information, see Consolidation Overview. 

Revaluing Assets and Liabilities for the Euro 

If you work with customers and/or vendors that use a Part of Euro currency, but you have not 

converted your domestic currency to the euro, you must revalue your outstanding assets and 

liabilities. Perform this procedure on or after 1/1/1999. 

CAUTION: If your company is situated in a euro-participating country, euro regulations require you 

to revalue asset and liability transactions using this exchange rate. If you are not situated in a euro-

participating country, this revaluation is optional. 

To revalue assets and liabilities: 

1 Run the Currency Revaluation Report for all Part of Euro currency codes. 

2 Select the Realize Gain/Loss check box. 

3 Run the Bank Account Revaluation utility for all bank codes that use a Part of Euro currency 

code. 

4 Open the Euro Exchange Rate Revaluation utility.  

5 In the Starting and Ending Currency Code fields, select the range of all Part of Euro currency 

codes in your system.  

For each outstanding asset and liability transaction that contains a currency code in this range, 

the system updates the exchange rate to the appropriate national currency-to-euro exchange 

rate (which is fixed as of 1/1/1999). This exchange rate is used in all triangulation conversions 

between Part of Euro currencies during the euro interim period. 

6 To review a list of the conversions, select Preview then click Process. 
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7 To start the conversion, select Commit and then click Process. 

Running the Currency Revaluation Report 

Use the Currency Revaluation Utility to generate realized and unrealized currency gains and 

losses that occur because of currency rate changes. 

You can run this utility with or without posting to the respective A/P, PO, or A/R distribution journals. 

When generating realized gains and losses, the utility includes gain/loss amounts previously posted 

to the A/P and A/R journals. 

Posting realized gains and losses rewrites historical rates in the open transactions. Posting 

unrealized gains and losses creates the journal entries as reversing entries. 

To run the utility: 

1 Select the accounts to process:  

 Receivables 

 Payables 

 Vouchers Payable 

2 Specify this information:  

Starting/Ending Currency 

Select the range of currency codes to include in the process. 

Transaction Date 

The current date is displayed. Optionally, select a different date as the transaction date. 

Increment Date 

Select the check box to automatically re-run the report. 

Realize Gain/Loss 

Select this check box to use the Realized accounts that are tied to each currency and to update 

the historical rates stored on each record. 

Clear this check box to use the Realized accounts that are tied to each currency, but leave 

unchanged the historical rates stored on each record. 

3 Select Preview and click Process to view the results without saving. 

4 Select Commit and click Process to run the utility and save the results. 

5 The Inventory Adjustment Offset field is enabled only if Use Analytical Ledger is selected on 

the General Parameters form. Select the number of the Inventory Adjustment Offset account for 

which entries will be made to the General Journal. This account must be a non-analytical 

account. 

6 The results grid shows this information:  
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Customer 

The customer number is displayed. 

Customer Name 

The name of the customer is displayed. 

Invoice 

The invoice number is displayed. 

Vendor 

The vendor number is displayed. 

Vendor Name 

The name of the vendor is displayed. 

Currency 

The currency code is displayed. 

PO 

The purchase order number is displayed. 

Invoice/Voucher 

The invoice/voucher number is displayed. 

Detail Description 

A description of the journal entry is displayed. 

Exchange Rate 

The exchange rate currently on the journal entry is displayed. 

Foreign Total Amount 

The total transaction amount is displayed in the foreign currency. 

Old Amount 

The domestic currency amount converted from the Foreign Total Amount is displayed using the 

old exchange rate. 

New Amount 

The domestic currency amount converted from the Foreign Total Amount is displayed using the 

revalued exchange rate. 

Cost of Revaluation 

The gain or loss amount associated with the transaction is displayed. 

Gain or Loss Amount 

The currency gain/loss amount generated for the invoice or voucher is displayed. 

Account number 



Currency 

155 

The account number is displayed. 

Account Unit 1-4 Reporting Units 

The unit codes used for detailed reporting and analysis are displayed. 

Domestic Total Amount Debit 1-2 

If the journal entry is a debit, the amounts debited are displayed. 

Domestic Total Amount Credit 1-2 

If the journal entry is a credit, the amounts credited are displayed. 

Net Loss 

The amount lost due to the change in exchange rate is displayed. 

Net Gain 

The amount gained due to the change in exchange rate is displayed. 

Variance Account number 

The account number used when posting the gain or loss or displayed. 

Variance Account 1-4 

The unit codes associated with the variance account number for the posted gain or loss are 

displayed. 

Description 

A description of the account number is displayed. 
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External Financial Interface 

Setting Up an External Financial Interface 

Infor CloudSuite provides an XML-based interface that can be used with an external financial system 

such as Infor SunSystems or SAP. Also, Infor CloudSuite provides a direct data access interface for 

Infor Global Financials (IGF). You can choose which types of financial information to export or import 

between Infor CloudSuite and the other system. 

NOTES:  

 If you are setting up the Infor CloudSuite Industrial Enterprise Financials (SunSystems 

interface) package, see the  Infor CloudSuite Industrial Enterprise Financials Installation and 

Implementation Guide instead of using these steps. 

 If you are setting up integration with IGF, see the Infor CloudSuite Industrial Integration Guide 

for Infor Global Financials instead of using these steps. 

 If you are using any other financial package, follow the steps below. 

This topic includes the following subtopics: 

 Setting Up an External Financial Interface (Infor CloudSuite to External Financial System) 

 Setting Up An Incoming Financial Interface (External System to Infor CloudSuite) 

Setting Up an External Financial Interface (Infor CloudSuite to External 
Financial System) 

When setting up the interface, use the following information and instructions: 

Concepts 

1 Since the external financial interface uses non-transactional replication as its method of 

transferring data, be sure you understand how replication works.  

For more information, see the Replication Reference Guide, available from our support site. 

2 Make sure you understand the distinction between data flow (transaction records being passed 

from Infor CloudSuite to the external system) and data maintenance (the updating of "code" 

records such as customer codes, terms codes, or exchange rates that might be passed from 

Infor CloudSuite to the external system, or vice versa). Decide which system will be the "master" 

for accounts payable and accounts receivable tasks. 
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3 Become familiar with both the Infor CloudSuite database structure and that of the external 

financial application. Map the financial data that needs to flow between the systems, noting the 

system in which the data should be maintained.  

The Infor CloudSuite DataMap's Schema-Properties spreadsheet, which lists Infor CloudSuite 

database tables and columns, could provide a good starting point for a mapping plan. 

4 Become familiar with the syntax of the XML request documents used to pass data to and from 

Infor CloudSuite.  

For more information, see the document Integrating IDOs with External Applications (especially 

the chapter on XML IDO request and response documents), which is available from our support 

site. 

Site/Intranet Preparation 

5 In the System Types form, create a new system type for the external financial application.  

This system type is used when defining the target site for the external financial application in the 

Sites/Entities form. 

Make sure that an additional system type is defined for your Infor CloudSuite application. 

The source and target system types are used in the names of XSL stylesheets that can be used 

to transform the XML data. For more information, see the System Types Help topic. 

6 In the Intranets form, define a separate intranet to be used only for data requests to and from 

the external financial application. Name this intranet something unique, such as EXTFIN, and 

select the External check box.  

For this intranet, specify the URL to which the financial XML request/response documents will be 

posted. This URL should be entered in the URL field on the Intranets form. This URL could be 

an ASP page on the external financial system that receives and processes the XML from the 

Infor CloudSuite message queue. The processing done at this URL is up to you. For example, 

an ASP page might map the data into the proper format for the external system, or it might write 

the XML documents to a location on its server for later processing. 

7 On the Sites/Entities form, define a source site from which system data will be exported:  

 On the System Info tab, select the Infor CloudSuite application's system type (defined 

earlier) and time zone. 

 Set the Intranet Name to the default intranet. 

 In the Database Name field, specify the application database name. 

8 On the Sites/Entities form, define a target site for the external financial interface.  

NOTE: This site must not be used for any other purpose. To avoid confusion, we suggest you 

name the site EXTFIN. 

 On the System Info tab: 

 Select the external financial application's system type (defined earlier) and the time zone. 

 Set the site's Intranet Name to the intranet created in the previous step. 

 Set the Database Name field to the external financial application's database. 
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9 On the Site User Map tab:  

 In the From Site field, specify the Infor CloudSuite site that will send data to EXTFIN. 

 In the User Name field, specify a local user on that site. 

For more information about setup requirements for this user, see the online help for this tab and 

field. 

Interface Parameters 

10 Decide whether you want to export invoices, debit memos, and credit memos, and/or vouchers 

and adjustments, to the external financial system. Use the fields on the External Financial 

Interface Parameters form in Infor CloudSuite to specify this information:  

 If you select Use External Financial Interface, Infor CloudSuite exports all posted General 

Ledger (G/L) transactions to the external system. This assumes that all customer and vendor 

records will be created and updated in Infor CloudSuite and that the records will be exported 

to the external system. Choosing this option also enables the External Financial Interface 

Data Request Utility. 

 If you want to use an external financial system for A/P, also select Use External A/P 

System. This tells Infor CloudSuite to export all posted A/P voucher and adjustment 

transactions to the external system. 

 If you want to use an external financial system for A/R, also select Use External A/R 

System. This tells Infor CloudSuite to export all posted A/R invoice, credit, and debit memo 

transactions to the external system. Selecting this option also enables the Customer Posted 

Balance tab on the External Financial Interface Data Request Utility. 

 For both the A/P and A/R options, you can determine the maximum batch size to include in a 

single XML document. Keep in mind that larger XML documents take longer to process. 

 For the Site field, specify the site you defined in step 8. 

11 Decide whether you want to modify the standard Infor CloudSuite processing for Due Date 

Calculation, Tax Calculation, or Currency Conversion. On the External Financial Interface 

Parameters form, you can choose to use external processing for any or all of these. If you select 

external processing, you will need to modify one or more of these "stub" stored procedures to do 

what you want:  

 ExtFinCurrCnvtCalcSp (Currency Conversion) 

 ExtFinDueDateCalcSp (Due Date Calculation) 

 ExtFinTaxCalcSp (Tax Calculation) 

12 Decide how you want to handle customer credit checking.  

When Infor CloudSuite performs a credit check for a customer, it needs the customer's current 

posted balance. If Infor CloudSuite is used for A/R functions, it has all the information it needs to 

calculate and store posted balance amounts. However, if the external financial system is used 

for A/R functions, then Infor CloudSuite must get the posted balance from the external system. 

There are two ways to do this: 
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 To request the posted balance at the time of the credit check (that is, synchronously), set up 

the system to call a stub stored procedure that obtains the customer's posted balance from 

the external system.  

To set this up, select the Use External Customer Posted Balance for Credit Check field 

on the External Financial Interface Parameters form. Then update the stub stored 

procedure named ExtFinGetExternalPostedBalSp so that it returns the posted balance from 

the external system. 

 To use a posted balance that was retrieved previously (that is, asynchronously), set up the 

request information on the Customer Posted Balance tab of the External Financial 

Interface Data Request Utility.  

Whenever that utility is run, Infor CloudSuite updates its posted balance information for all 

customers in the range. A credit check then uses the latest stored data. 

Replication Setup 

13 Look at the default external financial (EXTFIN) categories in the Replication Categories form, 

and decide if you need to add any new categories.  

For instance, is there data in other Infor CloudSuite tables that your external financial system will 

need? We recommend that you leave the default categories as is, and create new ones as 

needed. The default EXTFIN categories are listed here: 

NOTE: A table name can be represented by the name of a view over the table. This section uses 

view names in place of table names, where appropriate. 

 EXTFIN: Used for exporting Infor CloudSuite A/R, A/P, and G/L transactions to the external 

financial system, and also for exporting requests for updates to Infor CloudSuite tables  by 

the external financial system. This category includes the functions and XML documents 

required to export financial information:  

 ExtFinAPVoucherPosting: Exports data from the Infor CloudSuite export_aptrx and 

export_aptrxd tables, which are holding tables for data collected from various A/P tables. 

 ExtFinARInvoicePosting: Exports data from the Infor CloudSuite export_arinv and 

export_arinvd tables, which are holding tables for data collected from various A/R tables. 

 ExtFinAnaLedgerPosting: Exports data from the Infor CloudSuite ana_ledger table. 

 ExtFinLedgerPosting: Exports data from the Infor CloudSuite ledger table. 

 ExtFinRequest: Exports a request to the external financial application for updates to a 

specific Infor CloudSuite table. For more information, see the help for the External 

Financial Interface Data Request Utility. 

 EXTFIN Customer: Used for exporting Infor CloudSuite customer information. This category 

includes the sibling database tables custaddr and customer. 

 EXTFIN Vendor:- Used for exporting Infor CloudSuite vendor information. This category 

includes the sibling database tables vendaddr and vendor. 

Processing note for customer and vendor records: When a new customer or vendor record is 

added in Infor CloudSuite, the information is sent to the external financial system as a single 

XML document combining the information from the sibling tables, customer/custaddr or 

vendor/vendaddr, respectively. The information for custaddr or vendaddr in the single XML 
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just contains the specified key values and default values for the table's columns. The user-

specified values will be included as part of an update that follows the insert. However, for 

updates to existing customer or vendor records, the XML document pulls records only from 

the table that changed. 

14 Create one replication rule for each EXTFIN category, using the Replication Rules form.  

This must be done for each Infor CloudSuite site where you will be exporting data to the EXTFIN 

site. If you created additional categories for your external financial system in the previous step, 

set up rules for the new categories, too. 

A sample rule would include information such as the following: 

Source Site: OH (the site from which data will be extracted) 

 

Target Site: EXTFIN 

 

Category: EXTFIN Vendor 

 

Description: Pass vendor info to EXTFIN 

 

Interval Type: Immediate (anything but Transactional will work here) 

 

Interval: (Blank if Interval Type is Immediate; some interval value otherwise) 

 

Start Interval at: (Blank if Interval Type is Immediate; a time value otherwise) 

 

Disable Replication: (Cleared - EXTFIN uses replication) 

 

Update All Columns: (Cleared) 

15 On the Replication Management form, click the Regenerate Replication Triggers button to 

rebuild the database table triggers based on the rules you created in the previous step. 

16 Stop and start the replication services on the Infor CloudSuite utility server. 

XML Document Creation 

Again, in these examples, we use view names in place of actual table names. 

17 Set up the URL (which was specified in Step 6) on your external financial system to retrieve and 

process the XML documents mentioned in Step 12.  

 The EXTFIN XML "update collection" documents are used to specify information from Infor 

CloudSuite that should be updated in the external financial system. They start with a set of 

tags similar to the following:  

<IDORequest>  

 <RequestHeader Type="UpdateCollection">  

  <RequestData>  

   <UpdateCollection Name="EXTFIN.xml_doc_name.table">  

For example: <UpdateCollection Name="EXTFIN.ExtFinLedgerPosting.ledger"> 
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The external financial system is expected to respond to "update collection" requests by 

updating the data in the external financial application. 

 The EXTFIN XML "load collection" documents are used to request information from the 

external financial system that needs to be updated in Infor CloudSuite. They start with a set 

of tags similar to the following:  

<IDORequest>  

 <RequestHeader Type="LoadCollection">  

  <RequestData>  

   <LoadCollection Name="EXTFIN.xml_doc_name.table">  

For example: <LoadCollection Name="EXTFIN.ExtFinRequestChart.chart">  

The exception is the Customer Posted Balance request, which uses an "invoke method" 

request: 

<Invoke="EXTFIN.ExtFinRequestCustomerPostedBalance">  

The external financial application is expected to respond to "load collection" and "invoke 

method" requests by returning to Infor CloudSuite an "update collection" response that 

includes the requested data. 

For more information, see Example: Requesting Data from an External Financial Application. 

 The EXTFIN Customer and EXTFIN Vendor XML documents contain a tag similar to the 

following: 

<UpdateCollectionName="Table!replication_category_to_object_name">  

For example: <UpdateCollectionName="Table!Customer">  

The external financial system is expected to respond to these "update collection" requests by 

updating the data in the external financial application. 

Your external financial system should use the information in these tags to determine how to process 

and map the data in each XML document. The import process on the external system must also 

handle the batch_seq information in the XML document. 

For information about the syntax and tags used in the XML documents, see the document 

Integrating IDOs with External Applications, especially the chapter on XML IDO request and 

response documents. 

Samples of the outbound XML documents that may be generated from Infor CloudSuite are 

available in ZIP files from our support site. 

Setting Up an Incoming Financial Interface (External System to Infor 
CloudSuite) 

To set up an interface that updates the Infor CloudSuite database with financial data from the 

external system, create XML documents that access the Infor CloudSuite IDO collections. The 

process and syntax of using XML documents for data transfer to Infor CloudSuite is described in the 

document Integrating IDOs with External Applications available from our support site. 
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Then set up your external system to post the XML documents to the Infor CloudSuite mailbox, using 

the HTTP POST protocol. 

The Infor CloudSuite External Financial Interface Data Request Utility can be set up to request 

updates to specific Infor CloudSuite database tables from the external financial application. 

Depending on your external financial application's requirements, you may be able to use this utility 

as a starting point for setting up your application. For more information, see Updating Infor 

CloudSuite Data from Data in an External Financial Application. 

NOTE: For Infor Global Financials (IGF) integration, only Chart of Accounts, Currency Codes, and 

Currency Rates can be selected on the Table tab. All fields are available for use on the Customer 

Posted Balance tab. The IGF integration uses direct data access with this utility to retrieve data for 

Infor CloudSuite. 

Updating Infor CloudSuite Data from Data in an External Financial 

Application 

NOTES:  

 This utility is not used when running the Infor CloudSuite Enterprise Financials package that 

works with Infor SunSystems. 

 For Infor Global Financials (IGF) integration, only Chart of Accounts, Currency Codes, and 

Currency Rates can be selected on the Table tab. All fields are available for use on the 

Customer Posted Balance tab. The IGF integration uses direct data access with this utility to 

retrieve data for Infor CloudSuite. 

The External Financial Interface Data Request Utility can be set up to request updates to specific 

Infor CloudSuite database tables from the external financial application. This utility works as follows: 

1 When the utility's Process button is clicked, the system submits background tasks to TaskMan. 

The number of tasks submitted is dependent upon the number of check boxes selected. 

2 When the task is processed, it constructs an XML LoadCollection request (or XML Invoke 

method request for the Customer Posted Balance check box). 

3 The XML request is submitted to the replication tables to be picked up by the Infor Framework 

Replicator service and placed within the appropriate queue (in this case, the Outbound Queue), 

based upon the Replication Rules. 

4 The Replication Listener then posts it to the designated URL for the external financial 

application. 

5 The external financial system translates the XML into a request that its financial application can 

understand. The application responds to the request by returning a set of updated data.  

NOTE: This step and the following step are not part of the Infor CloudSuite system and must be 

set up according to the needs of the external financial system. 

6 The external financial system translates the set of data into an XML "load collection" request and 

places the request in the system mailbox. 
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7 Infor CloudSuite picks up the XML request and processes it, validating the request and updating 

the proper table. 

For more information, see Example: Requesting Data from an External Financial Application. 
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Financial Statements 

Financial Statement Setup 

You can define your own financial statements that best suit your reporting needs. To specify the 

content and format of a statement, use the Financial Statement Definition form, along with the 

Financial Statement Definition Columns form and the Financial Statement Line Definition form. 

NOTE:You can now use Microsoft Excel to retrieve and format Infor CloudSuite GL data. You can 

create a fully interactive and data-bound workbook to produce various reports such as Balance 

Sheet, Profit/Loss Statement, chart, and dashboard or pivot table without requiring any 

development knowledge or knowing the complexity of data access. For information on how to 

install and use this addition to Microsoft Excel, see the Infor CloudSuite Industrial Microsoft Ofice 

Integration Guide.  

Designing Your Financial Statement 

Financial statement design consists of two major sections: 

 Report Columns 

 Report Totals 

To design the statements, you use four major functions: 

 Copying sections of reports 

 Resequencing lines 

 Automatically generating accounts 

 Automatically setting ratio and subtotal levels 

You must enter information for the report, such as: 

 Headers and titles 

 The columns in which to calculate and/or print amounts 

 The account numbers for which amounts will be printed 

 Descriptive text 

You also must decide: 

 Whether to print ratios, and if so, where 

 When to print totals 



Infor CloudSuite Industrial Financials User Guide 

166 

It is best to lay out the reports on paper before attempting to define them. Remember to leave 

enough room to print all the desired amount and ratio columns, because the system does not 

perform this task automatically. 

Creating Your Financial Statement 

To create the financial statement: 

1 Find one of the demo reports (.RDL) provided with Infor CloudSuite that is most like your current 

financial statement. 

2 Make a copy of the .RDL with a new name. 

3 In Visual Studio 2008, modify the new report as needed.  

NOTE: The financial statement templates included with Infor CloudSuite include several 

suppressed fields and objects. Ensure that the data you wish to display is unsuppressed. For 

more information about suppression, see the Visual Studio online help. 

4 In Infor CloudSuite, add a Background Task Definition to point to this new .RDL. 

5 Open the Financial Statement Definition form. 

6 Specify information in these required fields:  

 Report ID: Enter a unique name for your report. This value can be up to 10 characters. 

 Analytical: Select this field if this report should be pulled from a separate analytical ledger. 

 Task Name: Fill in the task name of the background task you defined in Step 4, above. 

7 Click the Columns button. 

8 Complete the header definition on the Financial Statement Definition Columns form. 

9 After you have defined the header and columns, save and return to the Financial Statement 

Definition form. 

10 To open the Financial Statement Line Definition form, click Lines. 

11 Define the statement lines. 

12 After you have defined a statement, you can print it by specifying the Report ID in the Financial 

Statement Output form. 

About Dates in Financial Statements 

The period start date and period end date used when printing the Financial Statement are 

determined in the following way: 
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If Then 

The report column definition has a 

date, 

That date is used. 

The Year Start in the column 

definition is blank, 

The dates from the Financial Statement Output form are 

used. 

The period on the column definition 

is greater than zero, 

The dates for the period from the Account Period for the 

Fiscal Year corresponding to the column's Year Start 

are used. 

The period on the Financial 

Statement Output form is greater 

than zero, 

The dates for the period from the Account Period for the 

Fiscal Year corresponding the column's Year Start are 

used. 

The Financial Statement Output 

form has a date, 

That date is used. 

Printing a Financial Statement 

NOTE: Before you can print a financial statement, you must have first set up it up and defined its 

columns and lines. For more information, see the Financial Statement Setup Help topic. 

1 Open the Financial Statement Output form. 

2 Perform one of the following actions:  

 To produce a single report, in the Report ID field, select the ID of the report you want to 

print. 

 To produce a group of reports, select Actions > Get Group, select the group number of the 

reports, and click OK. 

The system updates the Financial Statement Output form with all the reports in that group, and 

you can define each one's output parameters. 

3 Select the check box for each type of detail you want to include in the financial statement. 

4 In the Report Type drop-down list, select the type of report you want to run. 

5 In the Currency drop-down list, select the currency to use. By default, the system produces the 

report in your domestic currency, but you can change it to a different currency. 

6 In the Current Date field, select the effective date for the report. By default, the system uses the 

current system date, but you can change it to a different date. 
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7 In the Site Group field, select the site you want to produce the report for, or, to produce the 

report for all sites, select All. 

8 From the Line Summary Level drop-down list, select the desired level of output detail for the 

report:  

 Direct Reports: Displays one line for each account and for each site. If the direct report is an 

entity, it reports to the current entity and then summarizes all sites for that entity into a single 

line. 

 Site: Displays one line for each account and for each site. 

 Summary: Displays and summarizes all sites into a single line for each account. Your 

selection in the Site Group field determines which sites to include. If this is an entity, the 

report displays all sites that report to the entity. 

9 You can overwrite the following report definition settings for the purpose of this print run:  

 Year Start 

 Period 

 Period Start and Period End 

 From Unit Code 1-4 and To Unit Code 1-4 

 Sort Order 

10 Click Print. 

Troubleshooting Financial Statements 

You may encounter the following problems with financial statements. 

Net Income Not Correct 

Net Income appears on both the Balance Sheet and Income Statement. Make sure you know which 

report the user is looking at. 

 Net Income is not calculated in the same way on both statements. Net Income on the Income 

Statement is a subtotal of all accounts on the Income Statement. Net Income on the Balance 

Sheet is calculated by taking the difference between the total activity of all Revenue and 

Expense accounts between the fiscal year start date and the period end date (when the range is 

"B"). 

 Check to make sure all the Revenue and Expense accounts defined in the Chart of Accounts are 

on the Income Statement. If there was a revenue and expense account that had activity that was 

not on the Income Statement, its value would not be included in the Income Statement net 

income, but would be in the Balance Sheet net income figure. 

 Net Income will also be off if there was a balance in a revenue and expense account from prior 

years. Run the Trial Balance Report for each prior year using the year-end date as the As of 

Date. If there is a balance found, the year-end procedure for G/L will have to be rerun for the 

year the balance(s) is in. 
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Retained Earnings Not Correct 

 Find out when the last year-end closing occurred. 

 Verify the account the user is speaking about is defined as type "Owner's Equity" in the Chart of 

Accounts. 

 Verify the account used as the Income Summary account in the latest year-end closing is one of 

these type "Owner's Equity" accounts on the statement. 

 Verify the latest year-end closing left all revenue and expense accounts with a zero balance by 

running the Trial Balance Report using the As of Date as the last date of the most recent year 

closed. If the balances are not zero, run the Trial Balance Report for the prior year-end dates 

for all revenue and expense accounts to see at the end of what year are the revenue and 

expense accounts balances area zero. Perform a year-end closing for all years necessary. 

 When a year-end closing procedure is run, the entries that are generated will be put in the 

General journal with a transaction date of the fiscal year end date. The reference on the entries 

for revenue and expense accounts will be Income Summary and the one account specified as 

the "Income Summary" account (usually retained earnings) will have a reference of Year 

Closing. General ledger reports will include entries with these references. Financial Statements 

only ignore Income Summary entries. The reason for this is to make it possible to run statements 

for a year after the year-end closing procedure has been performed and to roll the year's net 

income into retained earnings. 

 If a prior year statement shows the net income amount in both retained earnings and net income, 

on the Financial Statement Definition Columns form, the Amount Type field needs to be set to 

Start Bal on the sequence report line for the retained earnings account. This way, it prints the 

start balance for the retained earnings for the year and shows the net income only on the net 

income line. 

Statements are Not Picking Up Correct Amounts 

 Find out what kind of statement the user is working with. 

 Verify the date ranges they are using and where they are controlling that from. The date entered 

on the Financial Statement Output form does not override the dates on the financial statement 

header. If they have entered dates on the header and now want them blank, have them clear the 

date fields. 

 Verify the information on the statements header, type and most importantly the range. Make sure 

the type will give them the type of statement they are looking for. Since a Balance Sheet 

contains asset, liabilities, and owner's equity accounts, the range should usually be S or B. 

Income Statements contain revenue and expense accounts and should be a range of P or Y. 

 Check the information on the financial statements against the general ledger reports. Here are 

some guidelines:  

 If a balance sheet is out of balance, then generate the Trial Balance Report for all accounts 

to see if the entire ledger is out of balance. If not, then compare the balances on this report 

with what is on the Balance Sheet. If there are differences, run the Rebalance Ledger 

Period Totals utility for those accounts. If the ledger is out of balance, run the Rebalance 

Ledger Period Totals then re-run the Trial Balance Report. If the ledger is still out of 

balance, contact Application Support for additional assistance. 
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 If income statement balances are wrong, then run the General Ledger for all Revenue and 

Expense accounts. Compare the period totals on that report with the totals on the Income 

Statement. If there are differences, run the Rebalance Ledger Period Totals utility for those 

accounts. 

 If it seems like accounts are missing on any report, go into sequence report lines then run 

the Financial Report Account Check activity. This activity checks which accounts in the 

Chart of Accounts are missing from the statement. Those accounts will then need to be 

added into the statement. 

Infor Local.ly Reporting Overview 

Infor CloudSuite provides six report forms that are used to export data to be available for reporting 

with Infor Local.ly. 

Those forms are: 

 External Journal Report 

 External Ledger Report 

 External Trial Balance Report 

 External AP VAT Report 

 External AR VAT Report 

 External Tax Delivery Documentation 

Before using these forms, you must provide some information on the Intranets form. See Setup for 

Infor Local.ly Reporting. 

When you provide data on these forms and click Print, a new form opens to display the report 

generated from Infor Local.ly. 

  

Setup for Infor Local.ly Reporting 

Infor CloudSuite allows you to export data so that it is available for reporting by Infor Local.ly. You 

must first do this setup. You must have Infor Local.ly installed and configured before performing 

these steps.  See the Infor CloudSuite Industrial Integration Guide for Infor Local.ly. 

1 Open the Intranets form. 

2 Specify information for these fields in the XML group: Server, File Location, and Dataset 

Server. The Server field should contain the name of your Cognos report server. Use this syntax: 

https://servername. The File Location field is for the location for storing files on the Cognos 

report server. The location might be something like \\servername\wwwroot\InforReportingXML. 

The Dataset Server should contain the name of the dataset server to be used with the server 

name and file location specified in the other two fields. 
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3 Save. Now you can use the reports.  See Infor Local.ly Reporting Overview for a list of those 

reports. 
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Fixed Assets 

Fixed Assets Overview 

What Are Fixed Assets? 

Fixed assets are items a company owns and uses in its operation. Fixed assets do not include 

assets used for resale purposes, such as inventory, and those held on a temporary or short-term 

basis. Examples of fixed assets include: 

 Equipment 

 Furniture and fixtures 

 Buildings 

 Leasehold improvements 

What Is Depreciation? 

You do not usually expense fixed assets during the year you acquire them. Rather, you record their 

value as an asset on the balance sheet and depreciate the value over their useful life. 

Fixed assets can accommodate many types of depreciation methods. Infor CloudSuite provides 

seven predefined depreciation methods and allows you to add additional, custom depreciation 

methods. You can also maintain up to four separate depreciation schedules for each fixed asset. 

This feature allows you to maintain both your book and tax records on one system. 

Several factors influence the method selected for calculating fixed asset depreciation: 

 The expected useful life of the asset 

 The expected salvage value at the end of its useful life 

 Its original cost 

After the system calculates depreciation for a particular accounting period, it records the 

depreciation onto the General Ledger as a debit to the depreciation expense and as a credit to the 

accumulated depreciation. 

Fixed Assets and the General Ledger 

Fixed assets operate with the General Ledger in the following ways: 
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 During Fixed Assets Disposal, the system credits the asset account and debits the Accumulated 

Depreciation account. (You enter any remaining distributions manually.) 

 During Fixed Assets Transfer, when transferring from one class code to another, the system 

transfers the asset from the old asset account (and its accumulated depreciation account) to the 

new asset account and its accumulated depreciation account. 

 During depreciation posting (for the BOOK schedule only), the system posts to the Depreciation 

Expense account and to the Accumulated Depreciation account. 

 When you enter a fixed assets purchase, you must enter an acquisition transaction into the 

General Ledger to debit the Asset account and credit the Cash account. 

 Fixed asset records are created when the fixed asset number is assigned on the purchase order 

line. 

 Any line received with a fixed asset number updates the fixed asset acquired date.  

Fixed Assets Steps 

Fixed assets are items a company owns that could not be easily sold (in contrast to liquid assets). 

Because fixed assets are long-term investments, special accounting rules and some governmental 

regulations allow you to treat expenses for fixed assets differently. Therefore, you can use 

calculations for depreciation or, in other words, measures of the amount of value used up within 

specific accounting periods. 

To set up fixed assets for Infor CloudSuite, perform the following procedure. You must perform these 

steps before performing any routine procedures. 

1 Create General Ledger Accounts 

2 Create Class Codes 

3 Create Depreciation Tables 

4 Create Bonus Depreciation Codes 

5 Create Fixed Assets File  

 Create a Fixed Asset Record 

 Create Fixed Asset Costs 

 Generate a Depreciation Schedule 

6 Post Depreciation 

7 Transfer Assets 

8 Dispose of an Asset 
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About Depreciation 

The traditional approach to depreciation is based upon the fact that when a taxpayer buys a 

business or an investment-related asset that wears out, he or she can spread the costs over the 

period of the asset's useful life rather than entirely at the point at which the cost was incurred. 

Depreciation Rules Prior to ERTA 

Prior to ERTA (1981), the depreciation rules allocated the cost of an asset that has a limited life over 

appropriate accounting periods in order to determine the taxable income during each of these 

periods. In theory, the depreciation deduction equaled the amount of the asset that was "used up" 

during the annual period. This depreciation deduction permitted the taxpayer to recoup annually a 

portion of the cost of these depreciable assets. 

The factors that influenced the depreciation amount were the estimated useful life of the asset and 

the method of depreciation used. This depreciation system was based upon the assumption 

(sometimes fictional) that the asset would be economically productive only for a reasonable period of 

time and at the end of that time there would be a small "salvage value." 

Estimation of an asset's useful life was based upon the particular facts and circumstances of the 

anticipated use. This estimation created numerous controversies and administrative problems. 

Taxpayers generally wanted the shortest possible useful life in order to increase deductions against 

ordinary income. However, the tax service often felt that the "useful life" was much greater than that 

estimated by the taxpayers. 

Over the years, the IRS prepared and disseminated various guidelines to estimate useful lives. The 

Asset Depreciation Range System (ADRS) presented guidelines for the depreciable lives of 

specified classes of assets grouped by industrial classifications and by certain broad general asset 

classifications. 

A taxpayer electing to use the ADRS system could rely on the lives set forth therein as being safe 

from challenge by the IRS. With regard to assets not covered by ADRS, the depreciation period 

(useful life) was based upon actual facts and circumstances of each asset. However, this was 

subject to attack by Internal Revenue in each specific case. 

Depreciation methods were generally grouped into two categories: 

 Straight Line: The taxpayer's depreciation deductions are spaced equally over an asset's useful 

life. 

 Accelerated Depreciation Method: Includes Declining Balance Method, Double Declining 

Balance Method, Sum Of The year's digits, ACRS, MACRS, and other sophisticated methods. 

The purpose of providing for Accelerated Depreciation was twofold: 1) to stimulate capital 

investment, and 2) to encourage risk-taking investment. The accelerated methods permitted 

taxpayers to allot larger depreciation deductions to the earlier years of an asset's life and smaller 

deductions to later years. 

The purpose of accelerating deductions in early years is to allow the taxpayer to pay less in taxes 

during the earlier years of an asset's useful life. The taxpayer thereby gains the benefit of deferring 

his or her tax obligation to a later time. The taxpayer will be able to earn money on the amounts 

which would otherwise have paid taxes in the early years of the asset depreciation schedule. 
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Accelerated Cost Recovery Systems 

In general, the Accelerated Cost Recovery Systems established by ERTA provided for an 

accelerated recovery of the cost of tangible, depreciable property used in a trade or business or held 

for the production of income and placed in service after 1980, but prior to 1987. The cost is 

recovered over a period of 3, 5, 10 and 15 years. ACRS defined easily identifiable classes of assets 

and prescribed standard cost recovery periods for these classes. It divorced the capital recovery 

period from the concept of "useful life." After ACRS, the terms Asset Depreciation Range and "useful 

life" generally no longer apply. 

For personal property, taxpayers have the option to use the Straight Line method over the regular 

recovery. For real property taxpayers have the option to use the Straight Line method over the 

recovery methods described in Code Sections 167 and 168. 

Modified ACRS (MACRS) was introduced in 1986 and provides recovery periods of 3--5--7--10--15--

17.5--20 and 31.5 years. Basically, MACRS took away some of the advantages to the taxpayer 

included in the more rapid ACRS recovery. Technically, ACRS and MACRS are not depreciation 

methods because they are not based upon a "useful life" of property. The deduction is based upon 

an allowed method of cost recovery to the taxpayer. However, they are nevertheless referred to as 

depreciation methods. 

ACRS was designed to spur capital investment and to help businesses to recover their costs faster 

and thereby keep pace with the rate of inflation which was excessive in 1980 and previous years. 

This system was also designed to reduce disputes between taxpayers and the IRS over the useful 

life of assets. MACRS was a step backward from the standpoint of taxpayers. However, it appears 

preferable to the systems of recovery in use prior to 1980. 

As property is depreciated and tax deductions permitted during the depreciation, the basis of the 

property being depreciated changes. Upon a sale or other disposition of the property, the amount of 

gain for which the taxpayer is taxed is the excess of the amount realized upon transfer over the 

adjusted basis of the property disposed of whether by sales, exchanges, or involuntary conversions. 

Deductions are allowed only for business property or property held for the purpose of producing 

income. Such property does not include inventory nor unimproved real estate. 

Goodwill cannot be depreciated, because no useful life can be attributed to it. Therefore, in business 

transactions, what would be classified as goodwill is often treated as a covenant by the Seller not to 

compete. Covenants not to compete can be depreciated on a Straight Line basis over the term of the 

covenant. 

Remember that without depreciation you would, for example, pay $1,000 for a piece of machinery 

and not have any tax break whatsoever. If you held the property for five years and sold it for $800, 

there would be no tax. If you sold it for $1,200, there would be a tax on the $200 gain. Depreciation 

allows you a tax advantage in the years of depreciation, however, if you later sell or dispose of the 

property, this tax advantage is recaptured as taxable income. For example, if the $1,000 piece of 

machinery is depreciated under MACRS for three years, there would be an adjustment to basis for 

the amount allowed during each of those years as a deduction. Assuming the property is in the five 

year class, the MACRS deductions would be $200 for the first year, $320 for the second year, and 

$192 for the third year. The adjusted basis after the three years would be $288. If, at the end of the 

three years, the taxpayer sold the item of equipment for $900, he would have a taxable gain on the 

difference between the depreciated basis and the sale price. 
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Obviously, if the taxpayer is in a high tax bracket, he will derive greatest benefit by using the most 

rapid recovery method possible. If, on the other hand, the taxpayer's marginal tax rate is low, the 

election of a Straight Line method of depreciation and an extended recovery period could prove 

more advantageous, particularly if income is expected to increase in later years. 

The Treasury Department is constantly changing regulations relative to depreciation either to spur 

the economy or increase revenue. 

Depreciation Calculations 

Salvage Value 

If you enter a salvage value on the Fixed Asset Depreciation form, all depreciation schedules 

(columns) for that asset will use that value. This occurs when the system determines the amount of 

depreciation necessary to reduce the carrying value of the asset to the estimated residual value 

(salvage value) during the last year of its useful life. 

After each depreciation method, the following equation occurs: 

If c-amt > t-amt - s-amt - d-amt 

Then c-amt = t-amt - s-amt - d-amt 

where: 

c-amt = Current depreciation 

t-amt = Total value of the asset 

s-amt = Salvage value 

d-amt = Accumulated depreciation + bonus depreciation 

The methods are correct, but you should have the option not to calculate salvage value into all of the 

schedules for each asset. 

Salvage Value - Bonus Depreciation 

For Fixed Asset Depreciation Table methods, if you are considering salvage value, you must enter it 

in the Bonus Depr field of the depreciation schedule (column) using that method. You only use the 

amount in the Salvage Value field for calculating the depreciation amount during the last year of the 

asset's useful life. 

The equation is: 

c-amt = (t-amt - facepr.bonus-depr-$)*fadeptab.percent-yr[k]*.01 

where: 

c-amt = Current depreciation 

t-amt = Total value of the asset 

fadepr.bonus-depr-$ = Bonus depreciation amount 
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fadeptab.percent-yr[k] = The percent of the asset value to be depreciated in year 'k' 

This equation had contained salvage value instead of bonus depreciation amount, but was changed 

to use bonus depreciation correctly and to allow the user the option to include or exclude salvage 

value on a particular schedule. 

Bonus Depreciation 

To use bonus depreciation correctly, you must use a Depreciation Table method. Most methods do 

not consider bonus depreciation until the equation: 

If c-amt > t-amt - s-amt - d-amt 

Then c-amt = t-amt - s-amt - d-amt 

where: 

c-amt = Current depreciation 

t-amt = Total value of the asset 

s-amt = Salvage value 

d-amt = Accumulated depreciation + bonus depreciation 

You must subtract bonus depreciation from the total value of the asset before calculating the current 

depreciation amount. As in this equation: 

c-amt = (t-amt - fadepr.bonus-depr-$) * fadeptab.percent-yr[k] * .01. 

where: 

c-amt = Current depreciation 

t-amt = Total value of the asset 

fadepr.bonus-depr-$ = Bonus depreciation amount 

fadeptab.percent-yr[k] = The percent of the asset value to be depreciated in year 'k' 

Another problem for bonus depreciation is the equation: 

If c-amt > t-amt - s-amt - d-amt 

Then c-amt = t-amt - s-amt - d-amt 

where: 

c-amt = Current depreciation 

t-amt = Total value of the asset 

s-amt = Salvage value 

d-amt = Accumulated depreciation + bonus depreciation 

By having d-amt = accumulated depreciation plus bonus depreciation, this equation assumes that 

you have not incorporated the bonus depreciation into the accumulated depreciation amount. 

To solve the above problems: 
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1 Add a field to each depreciation schedule (column) for salvage value. 

2 For each depreciation method, include the following statement in the equation: 

(t-amt - fadepr.xxx - fadepr.bonus-depr-$) 

where: 

t-amt = Total value of the asset 

fadepr.xxx = The salvage value for a specific schedule 

fadepr.bonus-depr-$ = The bonus depreciation for a specific schedule 

3 Remove bonus depreciation from the following: 

d-amt = accumulated depreciation and bonus depreciation. 

Sum of the Year's Digits 

When using the Sum-of-the-Year's Digits depreciation method, the system uses the following 

equation: 

c-amt = (t-amt - s-amt) * k / sum-of-yrs. 

where: 

c-amt = Current depreciation 

t-amt = Total value of the asset 

s-amt = Salvage value 

sum-of-yrs = Sum of the year's digits 

k = The current year's digit 

SYD is not supposed to consider salvage value until the following equation: 

If c-amt > t-amt - s-amt - d-amt 

Then c-amt = t-amt - s-amt - d-amt 

where: 

c-amt = Current depreciation 

t-amt = Total value of the asset 

s-amt = Salvage value 

d-amt = Accumulated depreciation + bonus depreciation 

Period Basis Using Declining Balance 

When depreciating on a period basis using the Declining Balance methods, the system uses the 

following equation: 

c-amt = (t-amt - d-amt) * p-amt * (1 / (t-units / perds)) / perds 
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where: 

c-amt = Current depreciation 

t-amt = Total value of the asset 

d-amt = Accumulated depreciation + bonus depreciation 

p-amt = Percent amount (calculated) 

t-units = Total life units 

perds = Number of accounting periods 

The depreciation amount for each period of a given year will not be equal. 

Partial Depreciation 

You can also schedule a partial year depreciation when an asset is placed in service at some time 

during the calendar or fiscal year. For more information, see About Partial Depreciation. 

About Partial Depreciation 

Infor CloudSuite provides seven standard and user-defined depreciation methods. The user-defined 

methods have different depreciation rates based on year. For example, if Number of Periods is set to 

12 for a year and it has 36 units to depreciate, the custom rate is: 

Year Rate % 

1 30 

2 50 

3 20 

The asset detail is: 

Asset Name AS_1 

Start to Depr Date Apr 2012 

Cost 7200 

# Units to Depr 36 (12 Periods * 3 Years) 
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It will depreciate for twelve periods for a single year from the start date. 

Date Units to depreciate Rate % Period Depreciation 

04/2012 - 03/2013 12 30 180 = 7200 * 30% / 12 

04/2013 - 03/2014 12 50 300 = 7200 * 50% / 12 

04/2014 - 03/2015 12 20 120 = 7200 * 20% / 12 

For partial depreciation, when an asset is placed in service at some time in the year, part of the full-

year depreciation is required in the first year, while the remaining balance is deducted in the final 

year of the depreciation. The year for partial has three types: 

1 Calendar Year: Period from January 1 to December 31. It depreciates starting on the date it is 

placed in service to December 31.  

2 Fiscal Year: Period used for calculating annual financial statements in businesses. It depreciates 

from the date is placed in service date to the end of the fiscal year. The US fiscal year is October 

1 to September 30.  

3 None: No partial depreciation is taken. 

For example, below is a three year property partial depreciation rate: 

Year Rate % 

1 30 

2 40 

3 20 

4 10 

For the calendar year, depreciation rates would be as follows: 

Date Units to depreciate Rate % Period Depreciation 

04/2012 - 12/2012 9 30 240 = 7200 * 30% / 9 

01/2013 - 12/2013 12 40 240 = 7200 * 40% / 12 

01/2014 - 12/2014 12 20 120 = 7200 *20% / 12 
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01/2015 - 03/2015 3 10 240 = 7200 * 10% / 3 

For the fiscal year, depreciation would be as follows: 

Date Units to depreciate Rate % Period Depreciation 

04/2012 - 09/2012 6 30 360 = 7200 * 30% / 6 

10/2012 - 09/2013 12 40 240 = 7200 * 40% / 12 

10/2013 - 09/2014 12 20 120 = 7200 * 20% / 12 

10/2015 - 03/2016 6 10 120 = 7200 * 10% / 6 

Follow the steps in Generating a Depreciation Schedule to set up a fixed asset depreciation.  

Additional Notes 

Using Dates in the Past 

You can specify any date as the date to start depreciation. If you specify a date in the past, 

depreciation will start from that month.  

For posting to Fiscal Periods, you can specify a transaction date when posting. This date is used to 

determine Fiscal Periods. If you specify a date in the past, depreciation is calculated for all previous 

months. 

Using a Date in the Middle of the Month 

If you start depreciation in the middle of the month, depreciation will start from the first of that month. 

There is no partial month depreciation. 

Creating a Fixed Assets Master File 

The fixed assets file contains all identifying and descriptive information unique to an asset. 

To create a fixed assets file: 

1 Create a fixed asset record using the Fixed Assets form. 

2 Create and maintain asset costs using the Fixed Asset Costs form. 

3 Establish an asset depreciation method for each depreciation schedule on the Fixed Asset 

Depreciation form.  
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See Generating a Depreciation Schedule for the steps to set up a depreciation schedule.  

Creating Fixed Assets General Ledger Accounts 

Enter new Fixed Assets General Ledger accounts using the Chart of Accounts form. 

These accounts should include all asset accounts, all accumulated depreciation accounts, and all 

expense accounts. 

Posting Depreciation to the General Ledger 

1 When you open the Fixed Asset Depreciation Posting form, the grid displays the assets that 

contain errors that will prevent them from posting. You should correct these errors before 

proceeding. Assets appear in the error grid when either of these conditions is true:  

 There is no depreciation record for the asset (you must create the depreciation record on the 

Fixed Asset Depreciation form). 

 The # Units to Depr value is greater than or equal to the Units Depreciated value AND the 

Curr Period Depr value is 0 (these values are all defined on the Fixed Asset Depreciation 

form). 

2 Click the Process button. The message "F/A Depreciation(s) will be printed before posting" 

displays. 

3 Click OK. The Fixed Asset Current Depreciation Report (Modal) form displays. 

4 Click the Print button. The report prints to the printer you specified on the Report Options form. 

Use this report to verify that the depreciation information is correct prior to posting. 

5 After you verify the information is correct, click the X button in the top-right corner of the report 

window to close the report form. The message "Do you want to return an OK response to form 

Fixed Asset Depreciation Posting?" displays. 

6 Click Yes. The message "[Fixed Asset Depreciation Posting] will be performed" displays. 

7 Click OK. The message "x F/A Depreciation(s) were posted" displays." This message also alerts 

you about the number of assets that did not post because of errors. 

NOTE: Depreciation Schedules are user-defined in the Fixed Asset Parameters form. You can 

have up to four different ways of depreciating an asset, one for each of the defined schedules. 

Generating a Depreciation Schedule 

The third step in creating a Fixed Asset file is to generate a depreciation schedule. To generate a 

depreciation schedule: 



Infor CloudSuite Industrial Financials User Guide 

184 

1 On the Fixed Assets form, specify the Useful Life and Date to Start Depreciation for the 

asset. 

2 Open the Fixed Asset Depreciation form. 

3 Select Actions > New. 

4 In the Asset Number field, select an asset. 

5 The Class Code field is read-only and shows the class code for the asset.  

6 Select the Depreciation Code:  

 BOOK  

 TAX01  

 TAX02  

 VALUE  

7 In the Depr Method field, select the desired method of depreciation:  

 sl = Straight line 

 syd = Sum-of-the-years' digits 

 usage = Production or use method 

 125db = 125% declining balance 

 150db = 150% declining balance 

 175db = 175% declining balance 

 200db = Double declining balance 

For details about calculations performed for these depreciation methods, see About 

Depreciation. 

NOTE: To use a custom depreciation method that you defined, you must first define it using the 

Fixed Asset Depreciation Tables form. 

8 In the Depr Frequency field, select the frequency for calculating depreciation (Year or Period).  

The system depreciates the asset when the Generate Depreciation activity is finished. There is 

no special setting for depreciating an asset for part of a year or part of a month. 

For example, if an asset was purchased in July, and you want to accumulate 1/2 year of 

depreciation, run the Generate Depreciation utility for the months of July through December, 

assuming periods equal calendar months. The number of times the utility has been run is the 

number of months the asset is depreciated. 

9 To switch to the straight-line method, when the straight-line method results in a greater 

depreciation deduction than the user-defined or declining balance methods, select the Auto 

Crossover check box.  

During depreciation generation, if a switch to the straight-line method has occurred, the Auto 

Crossover field is selected. 

10 Enter appropriate information in the optional fields as desired, or accept the default values and 

settings.  
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 Bonus Depr: Select for additional, special expensing, or depreciation of an asset less the 

depreciable basis. You must enter it manually and post it to the General Ledger. 

 Bonus Depr Code: Enter the code that explains the bonus you chose in Bonus Depr field.  

NOTE: For additional, special expensing or depreciation of an asset during its first year, 

enter both the Bonus Depr and Bonus Depr Code. 

 # Units to Depr: Enter the number of units to depreciate. You can enter this field in two 

ways:  

 For assets that use the usage depreciation method, enter the number of units in the 

asset's life. 

 For assets that do not use the usage depreciation method and use a depreciation 

frequency of Period, enter the number of accounting periods over which to depreciate the 

asset.  

 This field is linked to the Useful Life field on the Fixed Assets form.  

NOTE: The system calculates the default amount by accessing the useful life and the 

number of accounting periods from the General Ledger. This value does not decrease. 

NOTE: If you are assigned a Thailand Localization license, the number of units to 

depreciate is incremented by one when the depreciation method is not USAGE and the 

acquisition date falls between the start and end of the specified accounting period. For 

example, if the depreciation frequency is set to Period (usually 12 in one year) and the 

acquisition date is 10-Jan-2013, then for a "Useful Life" of 5 years the number of units to 

depreciate is about 61 (12*5 + 1) instead of 60 (12*5). Similarly, if the acquisition date is 

specified to the beginning of the month (1-Jan-2013) then the number of units to 

depreciate is 60 (12*5). 

 Units Depreciated: Enter the number of units that have already depreciated. This number 

cannot exceed the number of units to be depreciated. 

 Accum Depr: This field displays the accumulated amount of depreciation for this asset.  

NOTE: You must include the bonus amount in the Accum Depr and YTD Depreciation 

fields before generating depreciation. You must post the bonus amount manually to the 

General Ledger. 

 YTD Depreciation: This field displays the amount of depreciation year-to-date. 

 Curr Period Depr: Enter the asset's depreciation amount for the current accounting period. 

It is calculated when depreciation is generated. If this value is 0, the asset will not post.  

This field is linked to the Date to Start Depreciation field on the Fixed Assets form.  

 Last Post Date: This field displays the last date depreciation was posted for an asset.  

NOTE: If you want a salvage value, enter the estimated value of an asset at the end of its 

useful life. The system does not depreciate an asset below its salvage value. 

11 Select Actions > Save. 
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Journals 

About Journal Entries 

Entering Journal Transactions 

Two or more transactions are typically entered to create a balanced entry, with one transaction 

entered as a debit (such as receiving a cash payment), and the second entered as a credit (such as 

recording miscellaneous income). The sum of the debit transactions equals the sum of the credit 

transactions. If each group of transactions is assigned the same reference, it is easily recognizable 

later that these transactions were entered at the same time. 

Transactions must be entered into the journal as the first step in changing an account's balance. The 

next step is to post the journal to the ledger, at which time the account balances are updated. After a 

transaction has been posted to the ledger, you cannot change it. The only way to correct an 

incorrect entry is by entering a reversing entry. 

You cannot directly delete a ledger transaction; however, you can enter a journal transaction for an 

opposite amount (and the same date as the original transaction), and then post that transaction to 

the ledger to cancel out the previous transaction. 

System Journals 

Infor CloudSuite initially creates the following system journals, which you cannot delete: 

 AP Dist: Accounts Payable Ledger Distribution 

 AR Dist: Accounts Receivable Ledger Distribution 

 BNK Dist: Banking Distribution 

 CO Dist: Order Entry Ledger Distribution 

 FA Dist: Fixed Assets Ledger Distribution 

 FS Dist: Service Distribution 

 General: General Journal 

 IC Distribution: Inventory Control Ledger Distribution 

 INV Dist: Inventory Ledger Distribution 

 Multi-Site: Multi-Site Journal 

 PC Dist: Project Control Ledger Distribution 

 PO Dist: Purchasing Ledger Distribution 

 PR Dist: Payroll Ledger Distribution 
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 SF Dist: Shop Floor Control Ledger Distribution 

 WC Dist: Work Center Ledger Distribution 

NOTES:  

 The BNK Dist journal is created for all databases, although it is populated only by running the 

Currency Revaluation Report. 

 The INV Dist journal is available in Infor CloudSuite only for backward compatibility, and to 

support any code modifications that post to the journal. This journal was replaced by the CO 

Distribution, IC Distribution, PO Distribution, and SF Distribution journals. Infor has no plans 

for future use of this journal. 

 If you have deleted material transactions, any ledger or journal records that reference them 

will have their references cleared. If you try to view detail on a ledger or journal and the 

specific material transaction has been deleted, you will receive a message that the record is 

not available. 

Read-Only Journals 

Except for unit codes, the distribution journals are read-only. The General Journal and any user-

defined journals are considered "writeable". Transactions for the distribution journals are entered 

from the appropriate Infor CloudSuite function. 

EXAMPLE: After a payment is entered and posted through Accounts Payable, the transaction 

appears in the A/P Dist Journal. Transactions for the General Journal are entered through the 

General Ledger. 

Functions that are performed on read-only journals: 

 Enter text (to be associated with each transaction) 

 Compress journal by account & date 

 Post to General Ledger 

 Sequence reset (resequence transaction numbers) 

You can also update unit codes for a journal transaction residing in a read-only journal. 

Functions that cannot be performed on read-only journals: 

 Add transactions 

 Delete transactions 

 Update transactions 

 Perform year end closing 

 Update journal title 
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Standard Journals 

A standard journal may be set up for recurring transactions (such as rent, mortgage, payroll, or loan 

payments). When transactions are posted from the General or standard journals, there is an option 

available to delete all entries in the journal. 

Do not delete recurring entries in the standard journals. The transactions are needed for the next 

period's posting. Recurring entries are usually the only entries in user-defined journals you would not 

delete. 

The entries in the General Journal change from period to period and need to be deleted. 

Accounting References and Distribution Journal Entries 

Entries for distribution journals originate in the corresponding application (such as A/R for the A/R 

Ledger Distribution journal, A/P for the A/P Ledger Distribution journal, and so on), as described in 

the following linked topics. 

Accounts Payable Ledger Distribution Journal 

 AP Compresses AP Journal Transactions 

 APA # Adjustment Transaction and Voucher Number 

 APP # Payment Transaction and Voucher Report 

 APRV # Recurring Voucher Transaction and Voucher Number 

 APV # Voucher Transaction and Voucher Number 

 APX Multi-Currency Gain/Loss Transaction 

Accounts Receivable Ledger Distribution Journal 

 AR Compressed AR Journal Transactions 

 ARC # Credit Memo Transaction and Invoice Number 

 ARC FIN CHG Credit Memo to Finance Charge Transaction 

 ARC OPEN Open Credit Memo Transaction 

 ARD # Debit Memo Transaction and Invoice Number 

 ARD FIN CHG Debit Memo to Finance Charge Transaction 

 ARD OPEN Open Debit Memo Transaction 

 ARI # Invoice Transaction and Invoice Number 

 ARF # Finance Charge Transaction and Customer Number3 

 ARP # Payment Transaction and Check Number 

 ARPR AR Payment Reapplication 

 ARX Multi-Currency Gain/Loss Transaction 

Banking Distribution Journal 

 REVALUATION ADJUSTMENT Multi-currency Revaluation Transaction 

Field Service Ledger Distribution Journal 
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 ACM ACM Posting 

 APV Expense Reconciliation and Partner Reimbursement Voucher 

 SROINV SRO WIP Relief Due to Invoicing 

 SROC SRO Credit Memo 

 SROI SRO Invoicing 

 SRO Labor Labor Transaction Posting 

 SRO Matl Material Transaction Posting 

 SRO Misc Miscellaneous Transaction Posting 

 SRO CLOZ SRO Close Utility WIP Relief 

 SRO OP M CL SRO Operation Manual Close WIP Relief 

 SRO MANUAL CLOSE SRO Line Manual Close WIP Relief 

 SRO Matl InvAdj Inventory Adjustment Due to Transaction Posting 

 CONI Contract Invoice 

 ARC Partner Reimbursement Credit Memo 

 ARI Partner Reimbursement Invoice 

Fixed Assets Ledger Distribution Journal 

 FA Compressed FA Journal Transactions 

 FADEP # Depreciation Transaction and Asset Number 

 FADSP # Asset Disposal Transaction and Asset Number 

 FAT # Asset Transfer Transaction and Asset Number 

General Journal 

 Income Summary GL Year End Closing Expense/Revenue Transaction 

 Year Closing GL Year End Closing Income Summary Transaction 

 Site Move To Change Reports To Entity beginning balance 

 Site Move Away Change Reports To Entity closing balance 

General Ledger 

 Date Summary Compressed GL Transactions by Date 

 Period Summary Compressed GL Transactions by Period 

 Allocation Summary Accounts used as Allocation Type 

Inventory Control Ledger Distribution Journal 

 IC Compressed IC Journal Transactions 

 INV ACTC Inventory Update 

 INV ADJ Inventory Adjustment 

 INV CC-A Cycle Count Adjustment 

 INV CHGM Change Item Cost Method 

 INV DMOV Multi-Site Transfer Order (when posting method is Inter-Entity) 

 INV MISU Inventory Miscellaneous Issue 
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 INV MOVE Inventory Move  

 INV MRCP Inventory Miscellaneous Receipt 

 INV PI-A Physical Inventory Adjustment 

 INV SADJ Stack Adjustment 

 INV SMOV Multi-Site Transfer Order (when posting method is Intra-Entity) 

 INV STDC Inventory Roll Current to Standard Cost 

 INV TADJ Multi-Warehouse Transfer Loss 

 INV TMOV Multi-Warehouse Transfer between Warehouses 

Multi-Site Journal 

 MSJE + site Multi-site journal transactions from Journal Builder 

Order Entry Ledger Distribution Journal 

 CO Compressed CO Journal Transactions 

 INV CRT # Customer Order Return and Order/Line Number 

 INV CSH # Customer Order Shipment and Order/Line Number 

Payroll Ledger Distribution Journal 

 PR Compressed PR Journal Transactions 

 PR # PR Number 

 PR [DIST DATE] Payroll Transaction and Date 

Shop Floor Control Ledger Distribution Journal 

 SF Compressed SF Journal Transactions 

 INV JADJ # Job BOM Cost Roll Up and Job Order Number 

 INV JBF # Job Order Back Flush and Job Order Number 

 INV JCLS # Job Order Other WIP Variance and Job Order Number 

 INV JFIN # Job Order Finish and Job Order Number 

 INV JFMO # Job Order Fixed Material Overhead and Job Order Number 

 INV JMOV # Job Order Overhead Variance and Job Order Number 

 INV JMUV # Job Order Material Usage Variance and Job Order Number 

 INV JOB # Job Order Other Issue and Job Order Number 

 INV JOI # Job Order Material, Tool, Fixture, Issue and Job Order No. 

 INV JOL # Job Order Labor and Job Order Number 

 INV JRWK # Job Order Return for Rework and Job Order Number 

 INV JVMO # Job Order Variable Material Overhead and Job Order No. 

 INV JWIP # Job Order WIP Account Change and Job Order Number 

Project Control Ledger Distribution Journal 

 PRJ MTL Project Resource Transaction 

 PRJ ADJ Project Adjustment Transaction 
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 PRJ LBR Project Labor Transaction 

 JCLS PRJ Project's Job Order Other WIP Variances 

 JFIN PRJ Project's Job Order Finish 

 JOL PRJ Project's Job Order Labor 

 JOM PRJ Project's Job Order Material 

 JMUV PRJ Project's Job Order Material Usage Variances 

 JFMO PRJ Project's Job Order Fixed Material Overhead Variances 

 JVMO PRJ Project's Job Order Variable Material Overhead Variances 

Purchasing Ledger Distribution Journal 

 PO Compressed PO Journal Transactions 

 INV P-CL # Purchase Order Status Change and PO/Line Number 

 INV PIV # Replaces INV P-CL # 

 INV PNI # Purchase Order for Non-Inventory Item and PO/Line No. 

 INV PRCV # Purchase Order Receipt and PO/Line Number 

 INV PRTN # Purchase Order Return and PO/Line Number 

Work Center Ledger Distribution Journal 

 WCM # Work Center Material 

 WCL # Work Center Labor 

 WCFO # Work Center Fixed Overhead 

 WCVO # Work Center Variable Overhead 

 WCO # Work Center Outside Labor 

 WCI # Work Center Inventory 

 WFIN # Work Center Finished Goods 

  

Creating a User-Defined Journal 

1 Access the Journals form. 

2 Select Actions > New. 

3 Enter a unique journal ID of up to 10 alphanumeric characters. 

4 Enter a description of the journal. This description displays for the journal in selection lists. 

5 To create a journal that will post to:  

 The Analytical Ledger, select the Analytical Ledger check box. 

 The General Ledger, clear the Analytical Ledger check box. 

NOTE: The Analytical Ledger check box is available only if the Use Analytical Ledger check 

box is selected on the General Parameters form. 
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6 Select Actions > Save. 

After you have created a user-defined journal, you can enter transactions for it using the Journal 

Entries form. 

Creating and Posting Recurring Journal Entries 

NOTE: Recurring journal entries can be created in only standard or user-defined journals. 

To create a recurring journal record: 

1 Open the Journals form and find or create a user-defined journal.  

2 Select Recurring Journal. 

3 Save the record.  

To post recurring journal entries:  

1 Do one of the following: 

 If you are still on the Journals form and you have just saved the recurring journal record, 

click Journal Entries. The Journal Entries form is displayed. 

 If you need to post entries for another recurring journal, use the Explorer to open the Journal 

Entries form and then find the recurring journal.  

2 Fill in the appropriate fields for your recurring transaction. For a new recurring journal, you’ll need 

to specify all transaction entries. For an existing recurring journal, you may only need to change 

the transaction dates.  

NOTE: Transaction dates can be changed one-by-one on the Journal Entries form, or you can 

change them all at once using the Ledger Posting form, which is opened in the next step. On 

the Ledger Posting form, select Single Date To All Entries and specify the date in Date For 

All Transactions. 

3 Select Actions > Post Journal. The Ledger Posting form is displayed. 

4 Print and post the ledger. 

5 Review the Journal Transaction report to check for any inaccuracies. 

6 Post the journal.  

7 If the journal was posted before in the same period, you will be prompted to confirm. Click Yes to 

post. 

After successful completion of the post, a success message is displayed and the system returns to 

the Ledger Posting form. 
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Creating Auto-Reversing Transactions 

Auto-reversing transactions are transactions that are to be reversed in the next accounting period or 

fiscal year. A reversing transaction is normally used when entering an accrual type of transaction. 

1 To create the transactions, follow the steps for creating user-defined journal entries. 

2 On the Journal Entries form, when creating the transactions, to indicate that this entry is a 

reversing transaction, select the Reversing check box. 

The system creates the reversing transactions when you post the journal. 

The reversing transactions total is displayed at the bottom of the Journal Account Summary form 

with the other totals. 

Creating Journal Entries 

To create journal entries only for the General Journal and for user-defined journals, use the Journal 

Entries form. You cannot use this form to create journal entries for the distribution journals. Entries 

for the distribution journals originate in the corresponding module (such as A/R for the A/R Dist 

journal, A/P for the A/P Dist journal, and so on). 

1 Open the Journal Entries form. 

2 In the Journal field, select General Journal or the user-defined journal you want to add an entry 

to. 

3 Click the filter-in-place button. 

4 Select Actions > New. 

5 Specify information in these fields:  

 Sequence: The system automatically assigns a sequential number to uniquely identify each 

transaction, but you can change it. 

 Date: This field displays today's date, but you can change it to the date that this transaction 

is to be posted to the ledger. When you post journal entries, you do so for a range of dates. 

 Account: Select the number of the account that the transaction amount will be posted to. 

The account description automatically displays as reference. 

 Control Number: You can update the control number prefix or the control number 

sequence. 

 Ref Control Number: If you need to reference a control number or a transaction posted to 

the ledger, enter the information in these fields. 

 (Unit Code 1-4): For each segment that is available, you can select the unit code that the 

transaction applies to. 

 Currency: This field displays the domestic currency, but you can select a different currency 

for the transaction. The currency must be the same as the currency of the bank that this 

transaction affects. If a non-domestic currency is specified, you can enter debit or credit 
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amounts in either the Domestic or Foreign Debit/Credit fields. Note that if a bank code is 

specified, that bank's currency is displayed in this field, and you cannot change it. 

 Bank Code: Select the bank code of the bank account to which this transaction will be 

posted. If you are posting to a cash account that is tied to a bank code, that bank code is 

specified by default. The system automatically updates the Currency and Exchange Rate 

fields to reflect the values associated with the selected bank code. 

 Domestic Debit/Credit: Enter the debit or credit amount of the transaction in the domestic 

currency. The Exchange Rate field is set to one by default and the Foreign Debit/Credit 

fields cannot be used. 

 Foreign Debit/Credit: These fields are enabled if a non-domestic currency is specified in the 

Currency field, so you can enter the debit or credit amount of the transaction in the foreign 

currency, if you prefer. The system automatically calculates the corresponding domestic 

debit/credit amount based on the default exchange rate.  

If the domestic currency amount is specified, and the corresponding foreign debit/credit is 

0.00, then the system automatically calculates the foreign debit/credit amount based on the 

default exchange rate between the two currencies. If the domestic currency amount is 

specified, and the corresponding foreign debit/credit is not 0.00, then the system 

automatically recalculates the exchange rate based on the domestic debit/credit amount and 

the corresponding foreign debit/credit amount. 

 Exchange Rate: This field displays today's exchange rate between the domestic and foreign 

currencies. You can change it only if you selected a value in the Bank Code field. 

 Reference: Enter a brief description of the transaction. The reference can be used to group 

transactions. This field is part of the selection criteria for the Journal Transaction Report. 

You can list all transactions with a particular reference. Note that all the debits and credits for 

the same reference should equal 0 (zero). 

 Cust/Vendor: The number of the customer or vendor associated with the transaction is 

displayed. 

 Name: The name associated with the customer or vendor number is displayed.  

 Reversing: Select this check box if you are entering a reversing transaction. 

6 Select Actions > Save. 

7 To continue entering transactions until the debit balance equals the credit balance, repeat steps 

2 - 6. 

Deleting a User-Defined Journal 

To delete a user-defined journal: 

1 On the Journals form, in the grid, select the line for the journal you want to delete. 

2 Select Actions > Delete.  

The system presents a message informing you that the journal will be permanently deleted when 

you save your changes. 
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3 Click OK.  

The system presents another message informing you that all the journal's transactions will also 

be deleted. 

4 Click OK. 

5 To permanently delete the journal and its transactions, select Actions > Save. 

Importing Journal Entries from External Sources 

To import journal entries from CSV or XML files, or to copy and paste journal entry data for import, 

use the Import Journal Entries form.  

For importing, before you begin, make sure you have formatted CSV and XML files according to 

these guidelines: 

CSV files must use this format: Date,Account,Unit Code 1,Unit Code 2,Unit Code 3,Unit Code 

4,Debit,Credit,Reference,AnalysisAttribute01…AnalysisAttribute15 

For XML files, each journal entry must start with a journal_entry tag and use date, account, unit 

codes, debit, Credit, reference, and analysis attribute 01 - 15 tags for grid fields, as shown in the 

following example.  

NOTE: For this example, analysis attributes 1 - 5 were defined as Employee Name, Customer 

Number, Hotel Name, Room Type, and City. Analysis attributes that are not defined can be left blank 

or removed from the XML. 

<?xml version="1.0" encoding="UTF-8" ?>  
<Journal_Entries><Journal_Entry>  
<Date>05/15/2014</Date>  
<Account>10000</Account>  
<UnitCode1></UnitCode1>  
<UnitCode2></UnitCode2>  
<UnitCode3></UnitCode3>  
<UnitCode4></UnitCode4>  
<Debit>1000.00000000</Debit>  
<Credit>0.00000000</Credit>  
<Ref>CP  1330</Ref>  
<AnalysisAttribute01>Mark White</AnalysisAttribute01>  
<AnalysisAttribute02>00001</AnalysisAttribute02>  
<AnalysisAttribute03>Grand Hyatt</AnalysisAttribute03>  
<AnalysisAttribute04>Grand Room - King Bed</AnalysisAttribute04>  
<AnalysisAttribute05>New York</AnalysisAttribute05>  
<AnalysisAttribute06></AnalysisAttribute06>  
<AnalysisAttribute07></AnalysisAttribute07>  
<AnalysisAttribute08></AnalysisAttribute08>  
<AnalysisAttribute09></AnalysisAttribute09>  
<AnalysisAttribute10></AnalysisAttribute10>  
<AnalysisAttribute11></AnalysisAttribute11>  
<AnalysisAttribute12></AnalysisAttribute12>  
<AnalysisAttribute13></AnalysisAttribute13>  
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<AnalysisAttribute14></AnalysisAttribute14>  
<AnalysisAttribute15></AnalysisAttribute15>  
</Journal_Entry>  
<Journal_Entry>  
<date>05/15/2014</date>  
<account>10000</account>  
<UnitCode1></UnitCode1>  
<UnitCode2>0007</UnitCode2>  
<UnitCode3></UnitCode3>  
<UnitCode4>01</UnitCode4>  
<Debit>0.00000000</Debit>  
<Credit>1000.00000000</Credit>  
<Ref>CP  1330</Ref>  
<AnalysisAttribute01>Mark White</AnalysisAttribute01>  
<AnalysisAttribute02>00001</AnalysisAttribute02>  
<AnalysisAttribute03>Grand Hyatt</AnalysisAttribute03>  
<AnalysisAttribute04>Grand Room - King Bed</AnalysisAttribute04>  
<AnalysisAttribute05>New York</AnalysisAttribute05>    
<AnalysisAttribute06></AnalysisAttribute06>  
<AnalysisAttribute07></AnalysisAttribute07>  
<AnalysisAttribute08></AnalysisAttribute08>  
<AnalysisAttribute09></AnalysisAttribute09>  
<AnalysisAttribute10></AnalysisAttribute10>  
<AnalysisAttribute11></AnalysisAttribute11>  
<AnalysisAttribute12></AnalysisAttribute12>  
<AnalysisAttribute13></AnalysisAttribute13>  
<AnalysisAttribute14></AnalysisAttribute14>  
<AnalysisAttribute15></AnalysisAttribute15>  
</Journal_Entry></Journal_Entries>  

Dates must use the standard format: mm/dd/yyyy. 

Reference information can be up to 30 characters in length. 

For rules regarding unit codes, refer to the field topic: Unit Code (1-4). 

For rules regarding analysis attributes, refer to the field topic: Analysis Attribute (1-15). 

To import journal entries: 

1 Open the Import Journal Entries form. 

2 Perform one of these tasks:  

 If you are importing data from a CSV or an XML file, select the file type and then click Load 

Journal Entries. 

 If you are importing data by copying and pasting it from a spreadsheet, open the 

spreadsheet to work with and paste the needed data into the grid. See Pasting the Contents 

of a Single Cell from a Spreadsheet and Pasting Selected Records (Rows) from a 

Spreadsheet. 

3 Select the journal in which to enter the grid data. 

4 Perform one of these tasks:  
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 To edit the date, account, or reference information for individual grid entries, click in the grid 

cells and make changes as necessary. 

 To change the date and/or reference information and apply it to all grid entries, specify the 

date and/or reference at the bottom of the form. 

5 Click Process. The data is validated and, if accurate, saved to the selected journal. If errors are 

found, the data remains in the grid so you can make necessary changes.  

Identifying Missing Information in a Journal 

The Journal Transaction Utility searches through the journal for missing information within the 

transactions. This utility sets missing dates, accounts, and amounts. 

CAUTION:  

 If you cancel or abort the posting, all changes are undone. 

 If this is a read-only journal, you cannot update this information again using this utility. 

1 Open the Journal Transaction Utility form. 

2 In the Journal field, select a journal to process. 

3 Click Process. 

Posting a Journal 

The posting process commits your transactions to the ledger. The ledger is not impacted by changes 

that affect General Ledger (G/L) accounts until the transactions are posted. 

NOTE: If you use a second, separate Analytical Ledger (as is traditional in some European 

countries), the journal posting process is significantly different. For more information, see About 

Analytical Accounting. 

Before posting, you should print the Journal Transaction Report. This report provides a listing of 

the transactions associated with the journal you are going to post. 

1 Open the Journal Entries form. 

2 Select the journal having transactions you want to post. 

3 Select Actions > Filter > Execute in Place. 

4 Select Action > Post Journal.  

The system displays the Ledger Posting for Journal form. 

5 To compress the journal before posting it, select the Compress Journal Before Post check 

box, and then select the Compression Level (Reporting Unit or Account).  
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CAUTION: If you select this check box, the journal entries will be combined by account 

and then totaled. The detail will be deleted prior to posting. You will also lose any journal 

control number information. 

6 To have the system delete the transactions from the journal after they have been posted, select 

the Delete Transactions After Post check box.  

NOTE: If you are posting a distribution journal, you must select this check box. 

7 In the Reversing Transaction Date field, select the date to assign to reversing transactions, or 

accept the default value, which is the current date. 

8 To assign the same date to all the posted transactions, select the Single Date To All Entries 

check box. Then, in the Date For All Transactions field, enter the date to assign to them. 

9 In the Post Through field, enter the date through which to post transactions.  

The Print option is automatically selected. You must first print the posting report before you can 

actually post the transactions. 

10 To print the report, click Process. 

11 After viewing and verifying the report, to post the journal, select the Commit option and then 

click Process.  

NOTE: If you use the External Financial Interface, additional processing occurs during journal 

posting. For more information, see Setting Up an External Financial Interface. 

Purging a Journal 

To delete journal transaction records, use the Purge Journals utility. 

1 Enter information in these fields:  

 Journal: Select the journal you want to purge. 

 Cutoff Date: Enter the last date of transactions you want to include in the purging action. 

NOTE: You can purge only one journal at a time. 

2 Select Process. 

Using the Journal Builder to Enter Site-Specific Journal 

Transactions 

Use the Journal Builder form to enter site-specific pending journal transactions, which are then 

validated and created in the Multi-Site journal at the specified site. 

1 Set up Replication Rules for the Journal Builder category:  

 From the Journal Builder site to all remote sites into which pending Multi-Site journal 

transactions will be inserted. 
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 From those remote sites back to the Journal Builder site. 

2 Log into the site where pending Multi-Site journal transactions will be entered and open the 

Journal Builder form. 

3 Enter a transaction date that is valid for the local site. 

4 Enter site-specific journal transactions. 

5 When all the transactions are entered and the amounts in the Debit and Credit total fields in the 

header are balanced, click Process.  

If validation is successful, a success message displays, which contains the control number 

generated by the Journal Builder utility. The pending journal transactions are then inserted in the 

Multi-Site Journal in the specified site(s) and a success message displays . The transactions have a 

batch control number that includes the site ID of the Journal Builder site, for audit purposes. 

If validation is not successful: 

 If the To Site is the local site, or if replication is transactional from the local site to the remote 

site, the system returns an error and no transactions are processed. 

 If the To Site is not the local site AND if replication is non-transactional, failures must be handled 

at the remote site. The local site will be unaware that an error occurred. For more information, 

see the note below about non-transactional replication. 

Notes 

 Journal Builder use at an entity, or to enter transactions to be inserted at an entity, is not 

supported. 

 Transactions can be entered only for sites that use the same domestic currency as the local 

Journal Builder site. 

 When you close the Journal Builder form, any unprocessed rows are removed. 

 The control number is based on the site where the pending journal entries are entered through 

the Journal Builder, so all the transactions in one batch have the same control number. 

 Non-transactional replication: If processing is non-transactional and fails for some reason at a 

remote site, the entire transaction will not be backed out. Successful journal entries will be 

inserted and reside in the Multi-Site journal. Unsuccessful journal entries wil be handled in the 

same way as any other "failed" process for non-transactional setups. This could result in a Multi-

Site journal with transactions where the Total Debits do not equal the Total Credits until the error 

is resolved. 

Recalculating Journal Balances 

The Recalculate Journal Balances utility recalculates the accumulated debit and credit balances of 

all transactions for a specific journal and date range. If an imbalance exists, the system generates a 

new transaction to bring the journal back into balance. 
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NOTES: 

 After running this utility, you must run the Journal Transactions utility to complete the 

transactions that were created to balance the journals. 

 You can recalculate only one journal at a time. 

1 Enter information in the following fields:  

 Journal ID: Enter the journal ID you want to recalculate. 

 Starting and Ending Transaction Date: Enter the range of dates for which you want to 

recalculate transactions. 

 Transaction Date: (Optional) Enter the date you want to use for any transactions that are 

created by this utility. Note that if you do not enter a date, you will be prompted to enter one 

when you use the Journal Transactions utility to update the transactions. 

2 To process your selections, click Process. 

At most, the system creates one transaction. 

Reversing a Set of Related Journal or Ledger Entries 

To reverse a set of related journal or ledger entries all at one time, use the Reverse Transaction 

form. You can reverse entries from the General Journal or a user-defined journal, and the entries 

must have a shared control number. They must all be part of the same business transaction. 

1 Open the appropriate form and search for the entries to reverse. You can use the Journal 

Entries, G/L Posted Transactions, or A/L Posted Transactions forms. 

2 Select an entry from the business transaction and then click Reverse Transaction. The 

Reverse Transaction form is displayed. 

3 Click Process. A set of reversing entries is automatically created in the originating journal, but 

the entries are not posted. 

4 Post the reversing entries. If necessary, you must also create and post corrected entries to 

replace the reversed entries. 
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Ledgers 

General Ledger Overview 

The General Ledger tracks financial expenditures within the company and generates financial 

statements and reports for management, auditors, and investors. The General Ledger is tied to other 

parts of the system through the Chart of Accounts and the distribution journals. 

Some European countries add a separate Analytical Accounting system to track revenue and 

expense accounts. 

The Chart of Accounts form defines account numbers used throughout the system to record, track, 

and report costs. An account in the General Ledger tracks domestic currency spent or earned by 

business activities, such as paying bills, receiving payments, cutting payroll checks, purchasing and 

receiving supplies from vendors, paying rent, and material and job transactions. 

Financial information collected during day-to-day operations is posted frequently to distribution 

journals. Once their accuracy can be verified, the transactions are posted to the General Ledger at 

regular intervals. These are the distribution journals: 

 Accounts Receivable 

 Accounts Payable 

 Fixed Assets 

 Inventory 

 Multi-Site 

 Payroll 

 Purchasing 

 Order Entry 

 Shop Floor Control 

 Work Center 

 Currency Banking Journal 

 Project Control. 

In addition to the distribution journals, there is a General journal that you can use to hold closeout 

and summary entries for year-end procedures. 

You can also create user-defined journals - custom journals to store, retrieve, and track entries 

specific to your business. Examples include Accruals, Reversing Entries, Adjusting Entries, 

Intercompany Eliminations, Banking Transfers, Charges, and Credit. 

Four unit codes can be activated for each account in the Chart of Accounts, to collect key 

management data. You can define unit codes to track those costs important to your business, such 
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as sales territory, individual sales representative, product or product family, location of manufacture, 

work center, cost center, and department. 

Benefits of the General Ledger include: 

 Provides detailed financial statements/reports. 

 Maintains complete journal and ledger transaction details. 

 Allows detailed or summarized account information. 

 Provides a bank reconciliation feature. 

 Maintains all journal transactions in edit list form prior to posting to General Ledger. 

 Provides the ability to report prior or future years with budgeting and planning comparisons for 

current year. 

 Provides complete support for multi-site financial reporting, including financial consolidations. 

 Distributes an expense among more than one account according to allocation rules. For 

example, you can divide a monthly office lease payment among the departments sharing the 

building quarters. For more information, see Setting up Account Allocations. 

 Automates the process of storing and posting recurring entries by using recurring journals. 

Simply create an entry once for each recurring expense, and the system automatically enters the 

transaction into the general ledger each period. 

 Provides flexibility so you can decide when and how to handle month-end closes. And you can 

begin entering next month's business transactions even before the current month has completely 

closed. 

 Calculates retained earnings for the fiscal year at year-end closing. 

 Provides statistical accounts in financial statements to compare important non-financial data to 

related financial data for measuring such things as productivity and controlling costs. 

 Offers a financial statement capability, which presents financial information from the General 

Ledger in a variety of formats to meet requirements of auditors, investors, and managers. 

General Ledger Setup 

Before you can begin processing in the General Ledger (G/L), you must set up some basic 

information. This includes: 

 Setting Up Accounting Periods 

 Setting Up the Chart of Accounts 

 Setting Up Beginning Account Balances 

Setting Up Accounting Periods 

Set up and maintain the accounting periods that are used by General Ledger for a particular fiscal 

year using the Accounting Periods form. Accounting periods are used only to visually group 

transactions. 
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NOTES:  

 You must set up these accounting periods before transactions can be posted. 

 You cannot delete an accounting period if ledger transactions exist for that period in the fiscal 

year. 

To set up accounting periods: 

1 Open the Accounting Periods form. 

2 In the Fiscal Year field, enter the year for which you want to add or change periods. 

3 Click the Filter-in-Place button. 

4 If the fiscal year is closed, select the Closed check box.  

NOTES:  

 The system does not treat a closed year as a hard close; transactions can still be posted 

to a closed year. 

 If a fiscal year is flagged as closed, none of its periods are considered to be open. For this 

reason, at least one year should be defined as open. 

5 Select the desired period (from 1-13) in the fiscal year. 

6 (Optional) Set the fiscal year start date.  

NOTE: By default, the Start Date field for the first period is set to the first day of the fiscal year, 

but you can change it. 

7 Do one of the following:  

 To have the system create the accounting periods in monthly increments, select the Monthly 

option and then click Generate Period. The system automatically updates the period starting 

and ending dates. 

 To have the system create the accounting periods in quarterly increments, select the 

Quarterly option and then click Generate Period. The system automatically updates the 

period starting and ending dates. Each period is three months long. 

 To create custom periods, manually enter the starting and ending dates of each accounting 

period in the fiscal year. 

8 Select Actions > Save. 

To generate the control number sequence by period or by year, use the Accounting Period 

Control Number Sequences form. 

Setting Up the Chart of Accounts 

To set up and maintain all the accounts that are used throughout the system, use the Chart of 

Accounts form. 
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Before setting up the Chart of Accounts, you need to define the structure of the accounts, grouped 

by account type (asset, liability, expense, and so on), and assign logical account numbers to them. 

For more information, see About Accounts. 

To add an account: 

1 Open the Chart of Accounts form. 

2 Select Actions > New. 

3 In the Account field, enter the account identifier for the account you are adding. 

4 In the field to the right of the Account field, enter the description of the account for reference. 

5 From the Account Type drop-down list, select the account type.  

NOTE: If you select Allocation, you must also enter an allocation for it on the Chart of Account 

Allocations form. 

6 In the Effective Date field, select the date you want the account to become active. 

7 If you no longer want to use the account after a particular date, select that date in the Obsolete 

Date field. Otherwise, leave this field blank. 

8 In the Unit Code 1-4 fields, select one of these options:  

 No Access: The reporting unit field will not be accessible for this account. The system also 

disables the corresponding Unit Code tab on the form. 

 Accessible: The reporting unit field will be accessible for this account. 

 Required: The reporting unit field is required for this account. 

9 If the financial entity reports to another financial entity, select either Buying or Selling as the 

Exchange Rate Type. Then, select the number of the account to which this account reports in 

the other financial entity, and the currency translation method. 

10 To save the account, select Actions > Save. 

Setting Up Beginning Account Balances 

When applicable, enter the beginning balances for your accounts. To enter beginning balances for 

accounts: 

1 Open the Journal Entries form. 

2 In the Journal field, select General. 

3 Click the filter-in-place button. 

4 Select Actions > New. 

5 Create an entry for the first account's beginning balance. In the Reference field, enter 

Beginning Balance. 

6 Repeat steps 4 and 5 for each account for which you need to enter a beginning balance. 

NOTE: You cannot post unless the debit amount equals the credit amount for each period. 
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General Ledger Steps 

NOTE: Before any General Ledger processing can be performed, you must set up the Chart of 

Accounts, enter beginning account balances, and define your accounting periods. For more 

information, see the General Ledger Setup Help topic. 

 Closing the Year for General Ledger 

 Copying Ledger Balances into Budgets/Plans 

 Creating and Maintaining Budgets and Plans 

 Setting up Account Allocations 

 Creating and Posting Recurring Journal Entries 

 Creating a User-Defined Journal 

 Creating Auto-Reversing Transactions 

 Creating Journal Entries for a User-Defined Journal 

 Deleting a User-Defined Journal 

 Identifying Missing Information in a Journal 

 Monitor financial data on the Controller Home form 

 Posting a Journal 

 Preparing a Bank Reconciliation 

 Printing a Financial Statement 

 Creating Statistical Accounts 

NOTE: Before printing a financial statement, you must have already defined its header, columns 

and lines, as applicable. For more information, see the Financial Statement Setup Help topic. 

 Purging a Journal 

 Recalculating Journal Balances 

 Using the Journal Builder to Enter Site-Specific Journal Transactions 

NOTE: If you use a second, separate Analytical Ledger (as is traditional in some European 

countries), see About Analytical Accounting for more information. 

About Accounting Periods 

While General Ledger does not post summarized information to the financial period buckets, 

complete detail of the transactions is maintained. Accounting periods are for visually grouping 

transactions only, and must be set up on the Accounting Periods form before transaction posting is 

processed. 

The accounting periods are used to group the following financial data by date: 

 Budgets & Plans 

 G/L Transactions 

 Journal Transactions 
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 G/L Compression 

 G/L Posting 

 Financial Statement Reports 

 Account Balances 

Various General Ledger functions access the accounting period dates. In these functions, either the 

system prompts for the dates or the system uses current period's dates. You are responsible for 

maintaining the current period number. 

NOTE: The period record does not need to exist in the subordinate site for updates to take place in a 

financial entity. This is because both sites and financial entities are allowed to delete periods, and 

the financial entity may have a period record that one of its subordinate sites does not. 

Sites that report to financial entities cannot add or do the Monthly Update or Quarterly Update 

activities. They can only update the current period, delete the period record, or do the Current 

Period Update activity. 

About Analytical Accounting 

When you activate Analytical Accounting by selecting the Use Analytical Ledger check box on the 

General Parameters form, the system changes its journal posting and reporting mechanisms in 

important ways to support the second accounting system. 

Posting 

These read-only journals always post to the General Ledger: 

 AP Dist - Accounts Payable Ledger Distribution 

 AR Dist - Accounts Receivable Ledger Distribution 

 BNK Dist - Banking Distribution 

 FA Dist - Fixed Assets Ledger Distribution 

 FS Dist - Service Distribution 

 PR Dist - Payroll Ledger Distribution 

These read-only journals always post to the Analytical Ledger: 

 CO Dist - Order Entry Ledger Distribution 

 IC Dist - Inventory Control Ledger Distribution 

 PC Dist - Project Control Ledger Distribution 

 PO Dist - Purchasing Ledger Distribution 

 SF Dist - Shop Floor Control Ledger Distribution 

 WC Dist - Work Center Ledger Distribution 

User-defined journals post to the Analytical Ledger if the Analytical Ledger field is selected. If this 

check box is cleared, they post to the General Ledger. 
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You can display transactions posted to the Analytical Ledger using the A/L Posted Transactions 

form. You can obtain more detailed information by framing searches using the A/L Posted 

Transactions Query utility. 

CAUTION: The system does not post an analytical account or journal to the General Ledger and 

does not post a non-analytical account or journal to the Analytical Ledger. It is important that you 

carefully define all default accounts so that analytical accounts do not post to journals that will later 

post to the General Ledger, and non-analytical accounts do not post to journals that will later post to 

the Analytical Ledger. For more information, see Analytical Ledger Setup. 

Reporting 

Several General Ledger reports have been modified so that they can track information from the 

Analytical Ledger when you select the Analytical Ledger field. They are: 

 Trial Balance 

 General Ledger 

 General Ledger Check Information Report 

 General Ledger Transaction Report 

Printing Financial Statements 

Use the Financial Statement Definition form to print all financial statements. If you want the 

statement to reflect data in the Analytical Ledger, select the Analytical check box. 

Other 

The following system functions support the Analytical Ledger: 

 Compress General Ledger Transactions Utility 

 Chart of Accounts - Budgets and Plan 

 Copy Balances to Budgets 

 Year-End Procedure Utility 

 Rebalance Ledger Period Totals 

Analytical Ledger Setup 

Some European countries traditionally use two accounting systems, one which posts to the General 

Ledger and a second which posts to a separate Analytical Ledger. You can set up an analytical 

accounting system to track expense and revenue accounts. 

To set up an Analytical Ledger: 

1 Open the General Parameters form and:  
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 Select the General tab. 

 Select the Use Analytical Ledger check box. 

 Save the form. 

When you select this field, the system creates a separate Analytical Ledger and changes its 

journal posting and reporting mechanisms in important ways to support the second accounting 

system. 

2 Open the Chart Of Accounts form.  

Select Analytical in the Account Type field for each new account. 

3 For each of the following forms and fields, enter an analytical account:  

NOTE: A labeled account field consists of a drop-down list that allows you to select the desired 

account number. For example, on the Project Parameters form, Default tab, the first labeled 

account field is Material. 

 Project Parameters form, Default tab, all labeled account fields 

 Purchasing Parameters form, Accounts tab, all labeled account fields 

 Product Codes form, all tabs except the General tab, all labeled account fields 

 Distribution Accounts form, all tabs, all labeled account fields 

 End User Types form, Cost Of Goods Sold tab, all labeled account fields 

 Employees form, General tab, Wage Acct field 

 Departments form:  

 Direct Labor Applied Acct field 

 Fixed Ovhd Applied Acct field 

 Var Ovhd Applied Acct field 

 Indirect Labor Codes form, Wage Acct field 

 Work Centers form, Costing tab:  

 Fix Mach Ovhd Applied Acct field 

 Var Mach Ovhd Applied Acct field 

Closing the Year for General Ledger 

CAUTION: This procedure creates debit and credit entries to close out all revenue and expense 

accounts for the date range specified. These entries are placed in the General Journal. You must 

then post the General Journal to the General Ledger. 

NOTES:  

 This procedure should be run only after all entries made to the fiscal year are posted. 

 To close the journal, it must be a writable journal. 

To close the year for the General Ledger: 
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1 On the Year End Closing Journal Entries form, select the general journal to close. 

2 In the Income Summary Account field, select the "Retained Earnings" account for the year end 

closing transaction. The account's type must be set up in the Chart of Accounts as Owner's 

Equity. 

3 (Optional) Change the Fiscal Year Start Date and Fiscal Year End Date. 

4 To have the system first delete all journal entries for this journal before generating the year-end 

transactions, select the Delete Current Journal Entries check box.  

This refers to the existing entries in the General Journal only. Do not change any of the 

references generated by the system on the entries in the General Journal. If this check box is 

selected, all journal transactions along with any associated text are deleted when the 

transactions are generated, prior to creating the closing transactions. 

5 To have the system clear the unit code balances in the revenue and expense accounts as well, 

select the Unit Code Detail check box.  

Clearing this check box leaves the balances in the unit codes, and carries them forward. 

6 Click Process. 

NOTE: You can close fiscal years an unlimited number of times. If you have closed the fiscal year 

and need to enter transactions for that year, you can post the transactions and then run the year-end 

close again. 

Example: G/L Year End Closing 

Suppose the following entries were the financial activity for a company for the fiscal year of 

01/01/2002 to 12/31/2002 using the following accounts: 

Account     Description 

10000 Assets 

20000 Liabilities 

30000 Owner's equity 

40000 Revenue 

50000 Expense 

Example of Ending Balances (12/31/2002) 
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Account     Balance 

10000 100,000.00 

20000 (64,500.00) 

30000 (20,000.00) 

40000 (23,500.00) 

50000 8,000.00 

Example of Year End Entries 

Account     Balance 

30000 15,500.00 

40000 23,500.00 

50000 (8,000.00) 

Example of Ending Balance (12/31/2002) after Year End Balance 

Account     Balance 

10000 100,000.00 

20000 (64,500.00) 

30000 (35,500.00) 

40000 00 

50000 00 

NOTE: No entries were generated for Accounts Receivable of Cash, because they are asset 

accounts. Only revenue and expense accounts are closed out. 



Ledgers 

213 

Copying Ledger Balances into Budgets/Plans 

You can copy ledger balances to account budget or plan amounts of another fiscal year, using the 

Copy Balances to Budgets or Multi-FSB Copy Balances to Budgets activity. You can then view 

the results with the Chart of Accounts Budget and Plan or Multi-FSB Chart of Accounts Budget 

and Plan form. 

1 Open the Copy Balances to Budgets form. 

2 In the Account Types group box, select the check box of each type of account of the balances 

you want to copy. Options include:  

 Asset 

 Liability 

 Owner's Equity 

 Revenue 

 Expense 

 Analytical 

NOTE: The Analytical check box is available for standard GL ledger balances only if the Use 

Analytical Ledger check box is selected on the General Parameters form. It is not available for 

multi-FSB ledger balances. 

3 In the Fiscal Year From field, the prior fiscal year displays by default, but you can select a 

different year from which to copy the budget/plan information. 

4 In the Fiscal Year To field, the current fiscal year displays by default, but you can select a 

different year to which to copy the budget/plan information. 

5 Select the type of information you want to copy to: Budget or Plan. 

6 In the Starting and Ending Account fields, select the range of accounts for the budget/plan 

information you want to copy, or leave both fields blank to copy the information of all accounts for 

the selected account types. 

7 In the Starting and Ending Unit 1-4 fields, select the range of reporting units you want to 

include in the activity. 

8 Click Process. 

FASB 52 Overview 

NOTE: This adjustment is necessary only when all of these conditions are true:  

 The ledger is consolidated in a multi-site setup with an entity's domestic currency different 

from the parent entity's domestic currency. 

 Different account types are posted with different translation methods. 

 The exchange rates vary. 
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This process automatically adjusts for the Financial Accounting Standards Board 52 (FASB 52) 

requirement after the Ledger has been consolidated. Adjustments occur to: 

 All accounts that use the currency translation method of End. 

 Expense/Revenue accounts. 

 An out-of-balance ledger due to different account types having different currency translation 

methods. 

Throughout the year, asset and liability accounts are posted to the ledger based on the End currency 

translation method. As the currency rates fluctuate, the totals for the balance sheet accounts should 

also fluctuate. The system creates a new ledger entry to the balance sheet accounts to manage 

these fluctuations. The system also creates a new ledger entry to the CTA account to ensure the 

ledger balances. 

Expense and revenue accounts use the Average currency translation method. Due to this, the same 

amount in a balanced site journal can be rolled up to two different amounts. So, a new ledger entry 

is created to balance out the "Corp" entity ledger. 

On the Ledger Consolidation form, if the Year End check box is selected, the system posts 

expense and revenue accounts to the ledger based on the Average currency translation method at 

the time of the posting. As the currency rates fluctuate, these accounts' totals should also fluctuate. 

The system creates new ledger entries to the following accounts: 

 Asset and liability accounts, to adjust for the fluctuation. 

 The CTA account, to ensure the ledger balances. 

Order of Events: 

1 Post the journal. 

2 Run Ledger Consolidation. 

3 Run Year-End Closing Journal Entries. 

4 Post the journal. 

5 Run Ledger Consolidation. 

Posting to General Ledger - Actual Costing 

This topic describes in detail the posting of inventory transactions to the General Ledger (GL) 

module. All transactions processed in the Customer, Material, Vendor, and Production modules that 

affect the value of inventory are posted to the appropriate inventory distribution journal (CO Dist, IC 

Dist, PO Dist, and SF Dist, respectively) using account numbers that can be found in the Product 

Codes, Departments, Purchasing Parameters, and Distribution Accounts forms. 

Because the costs and account numbers used for the journal posting are quite different if using 

standard costing or one of the four actual cost flow methods, the transactions generated are 
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explained for both standard and actual. If the system should not automatically generate these 

transactions, clear the General Parameters form's Post to Journal check box. 

Actual Costing - Post to Journals 

The system uses the same GL account numbers when posting to the appropriate inventory 

distribution journal, no matter which of the four actual cost flow methods is in use (Average, LIFO, 

FIFO, Specific). For this reason, the transactions outlined below are for actual costing in general. 

The phrase issue cost is used several times in this topic to refer to the cost at which an item is being 

issued from inventory. The issue cost value varies depending on the cost flow method in use. 

General Ledger Account Numbers Used 

Before processing any transactions in the manufacturing modules, the GL account numbers which 

are used for posting to the GL inventory distribution journals must be set up. The key accounts are 

stored at the Product Code level, so that different account numbers may be assigned to different 

classifications of items and also allow for the tracking of cost details of a unit cost. 

Maintaining individual accounts for the various cost details allows visibility of these costs through 

work in process, inventory and cost of goods sold and more accurately determines the exposure 

relating to material, labor, fixed overhead, variable overhead and outside service costs. It is also 

possible to use one account number for all the cost detail components of an item if this cost detail 

visibility is not desired. 

Example - Maintaining Individual Account Numbers for Each Cost Detail Component 

A finished goods inventory account number and a raw materials inventory account number may be 

used rather than having all items posted to the same inventory account. 

Finished Goods Account Account Number 

FG INV Material Cost 1001 

FG INV Labor Cost 1002 

FG INV Fixed Overhead Cost 1003 

FG INV Variable Overhead Cost 1004 

FG INV Outside Service Cost 1005 
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Raw Materials Account Account Number 

RM INV Material Cost 2001 

RM INV Labor Cost 2002 

RM INV Fixed Overhead Cost 2003 

RM INV Variable Overhead Cost 2004 

RM INV Outside Service Cost 2005 

These accounts may be used rather than having all items posted to the same inventory account. 

Example - Maintaining One Account Number for All Cost Detail Components of Finished 

Goods Inventory and Raw Materials Inventory 

Finished Goods Inventory Account Account Number 

FG INV Material Cost 1001 

Labor Fixed Overhead Cost 1001 

Variable FG INV Outside Service Cost 1001 

Raw Materials Inventory Account Account Number 

RM INV Material Cost 2001 

Labor Cost 2001 

Fixed Overhead Cost 2001 

Variable RM INV Outside Service Cost 2001 

Accounts List 

The following lists identify the accounts found in the Product Codes, Departments, Purchasing 

Parameters, Work Centers, and Distribution Accounts forms. 



Ledgers 

217 

Product Codes 

Inventory Adjustment 

Material Fixed Overhead Applied 

Material Variable Overhead Applied 

NOTE: The Material Fixed Overhead Applied and the Material Variable Overhead Applied accounts 

are required only when basing overhead on job material issues. 

Purchasing Parameters 

Vouchers Payable Account 

Department 

Direct Labor Applied Account 

Fixed Overhead Applied Account 

Variable Overhead Applied Account 

Although these rates default from this location, they are also maintainable on the Current 

Operations, Job Operations, and Estimate Operations forms. 

Work Center - Costing 

Fixed Machine Overhead Applied Account 

Variable Machine Overhead Applied Account 

Although these rates default from this location, they are also maintainable at the Current 

Operations, Job Operations, and Estimate Operation forms. 

Distribution Accounts - Inventory 

Inventory Material 

Inventory Labor 

Inventory Fixed Overhead 

Inventory Variable Overhead 

Inventory Outside 

Distribution Accounts - Sales/Cost of Goods Sold 

COGS Material 

COGS Labor 

COGS Fixed Overhead 

COGS Variable Overhead 
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COGS Outside 

Distribution Accounts - In-Transit 

In-Transit Material 

In-Transit Labor 

In-Transit Fixed Overhead 

In-Transit Variable Overhead 

In-Transit Outside 

NOTE: You can delete any distribution account record, including the default distribution account, 

with a blank warehouse and blank product code. 

The inventory account numbers used for journal transactions do not come directly from the Product 

Codes form. Rather, the inventory accounts used come from the stock location being accessed 

when the transaction is performed. (When a stock location is added for an item in the Inventory 

module, inventory accounts are entered for the location, using the Item Stockroom Location form.) 

The default for this field is the inventory account numbers in the Distribution Account file to which the 

item belongs. 

To locate the inventory account numbers: 

1 The system searches for an exact match for both the warehouse and the product code. 

2 If that fails, the system searches for a match for the product code and a blank warehouse. 

3 If that fails, the system searches for a match for the warehouse and a blank product code. 

If any of the account numbers the system is attempting to use have not been set up, the system 

does not post to the GL inventory distribution journals. 

Reversing a Set of Related Journal or Ledger Entries 

To reverse a set of related journal or ledger entries all at one time, use the Reverse Transaction 

form. You can reverse entries from the General Journal or a user-defined journal, and the entries 

must have a shared control number. They must all be part of the same business transaction. 

1. Open the appropriate form and search for the entries to reverse. You can use the Journal 
Entries, G/L Posted Transactions, or A/L Posted Transactions forms. 

2. Select an entry from the business transaction and then click Reverse Transaction. The 
Reverse Transaction form is displayed. 

3. Click Process. A set of reversing entries is automatically created in the originating journal, 
but the entries are not posted. 

4. Post the reversing entries. If necessary, you must also create and post corrected entries to 
replace the reversed entries. 
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Setting Up a Consolidation Reporting Structure 

The system allows you to set up or modify the hierarchical structure of your entities and sites. We 

recommend that you carefully plan the relationship between entities and sites before using the 

system. We suggest that you contact our Consulting Services group to help with your 

implementation. 

NOTE: Appropriate replication rules must be set up between the sites and entities.  

Sites must have the same base (domestic) currency as the entity they will report to. If a chart of 

accounts or accounting periods have been set up at the site, they must match those established 

for the entity. 

Setting or Changing the Reports To Entity 

If you modify an existing consolidation reporting structure, historic data will not change. For 

additional information, see the Consolidation Overview. 

Following is the typical process: 

1 Log in to each site whose Reports To entity will be set or changed. 

2 If general ledger activity has been performed at the site, do the following. (If this is a new site 

with no activity, skip to the next step.)  

 Post all journals and consolidate the ledger for transactions in the current site. Run the 

Ledger Consolidation activity at each site to calculate the ending balances for every 

account number at the site and consolidate them up through the old entity hierarchy. 

 Since the full account balances will be closed out and moved, any balances that are to 

remain in the old structure must be manually transferred to other sites by journal entries in 

both sites. Those journal entries must be posted and consolidated. 

3 Run the Change Reports To Entity utility at each site that you are changing to report to a new 

entity.  

 If this utility is run at a site, you can only change Reports To Entity to a financial entity that 

has the same base (domestic) currency, chart of accounts and accounting periods. Also, the 

system verifies that all accounts defined at the site already exist at the financial entity. If this 

validation fails, the change is not allowed and a report is created detailing the failures. 

 If chart records exist at the site that do not exist at the entity, you can use the Multi-Site 

Chart Copy Utility to copy the site's Chart of Accounts to the financial entity. 

If no chart of accounts or accounting periods have been set up yet at the site, this Change 

Reports To Entity utility will copy them from the entity to the site. 

4 If this utility is being run at a financial entity at any level, the closing balances for each account at 

every site beneath the financial entity are calculated and consolidated all the way up the 

hierarchy. Then the Reports-To value is changed. All the Reports To account mappings for the 

entity's Chart of Accounts must be corrected to map to the chart of accounts of the new Reports-

To financial entity. 
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5 Run Ledger Consolidation (again) at each site/entity in the new structure. This consolidates the 

beginning balances for each account up through the new financial entity hierarchy. 

6 The G/L Ledger references created when the process is complete are:  

 SITE MOVE AWAY, which holds the closing balance. 

 SITE MOVE TO, which is the beginning balance for the new Reports-To entity. 

NOTE: No financial reporting should be run between steps 3 and 4, because the books will be 

temporarily out of balance. 

Changing Currency Replication Rules 

If the Change Reports To Entity utility is performed at a site (not an entity), and that site includes a 

replication rule for shared currency to and from the entity that it was previously reporting to, that 

replication rule should be deleted. Then a new replication rule for shared currency should be set up 

between that site and the new entity. Regenerate replication triggers and run manual replication of 

the Shared Currency category. 

This ensures that users at the site will be viewing the currency records of their new financial entity 

instead of their old one. 

Removing a Site from the Hierarchy 

The Change Reports To Entity utility can also be run if a site is sold and needs to be removed from 

the financial consolidation structure. In this case you would run the utility with the Reports To field 

blank. 

Reconsolidation 

The Set Ledger Consolidated Flag utility rebuilds an entity. Use it to reconsolidate entities whose 

data was lost, corrupted or discarded due to a complete change in corporate structure. 

After running this utility, you should then run the Change Reports To Entity utility to correct the 

current site structure, using the option to not post the closing balances. You can then run the Ledger 

Consolidation activity to consolidate into the new structure. In this case, it is assumed that the 

entities into which you are consolidating are new and thus empty of ledger records. 

Allocating and Distributing Expenses 

Setting up Account Allocations and Distributions 

You can routinely distribute an expense among more than one account, according to rules that you 

define. First, you set up an Allocation Account. Any charges you enter to that account trickle down to 

the other accounts that you specify on the Chart of Account Allocations form. Each of these other 
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accounts is charged with an amount or percentage of the total. This process occurs during posting to 

the General Ledger. 

1 In the Chart of Accounts form, set up an account with a description that explains how the 

allocation account is used, for example, Supplies Expense Distribution. Specify this 

information:  

Account Type 

Specify Allocation.  

Unit Code 1-4 

Set the appropriate unit code fields to Accessible.  

For more information, see Unit Codes (1-4). 

2 In the Chart of Account Allocations form, only accounts of type Allocation are displayed. 

Select the allocation account and specify this information:  

Sequence 

This field determines the order in which the allocation is made. For example, you might have 4 

allocation sequences in a rule, and the first sequence allocates a fixed amount of $75 to a 

distribution account. If the current expense is $75 or less, the other allocation sequences are 

ignored. 

Allocation Basis Type 

Specify the basis used to create the distribution journal entries for this sequence. Different 

sequence numbers in the same allocation rule can use different basis types.  

 If the sequence distributes a percentage of the total amount, specify Percentage. 

 If the sequence distributes an exact amount to this account, specify Amount. 

 If the sequence distributes whatever is remaining after the other sequences are completed, 

specify Remainder. This option can only be used for the last sequence number in the rule. 

Allocation Basis Rate 

Specify the decimal percentage or the  amount used to create the distribution journal entries for 

this sequence For example, specify 25.000 for 25%.  If Allocation Basis Type is Remainder, 

this value is zero and the field is disabled. 

Distribution Account, Description and Account Type 

Select the account to which you want to distribute the expense. The account description and 

type are displayed.. 

Unit Codes 

The unit code fields are enabled for any accessible unit codes. Select the appropriate codes. For 

example, if Unit Code 1 is accessible, select a department to which the expense will be 

allocated. 

Allocate by Statistical Account 
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If this sequence allocates expenses using variable percentages that are based on the 

information in a statistical account, select this field. 

For more information, see Example: Allocating Expenses with Variable Percentages based on 

YTD Amounts from Statistical Accounts. 

Statistical Account 

If you selected Allocate by Statistical Account, specify the statistical account number. 

3 Repeat step 2 to add sequences until the rule is complete and the expense amount is completely 

allocated.  

Example: Allocating Expenses with Percentages 

This example shows how percentages can be used to distribute an expense to different accounts. 

Chart of Accounts 

You could set up an allocation account 99870 where unit code 1 is accessible and holds the 

department numbers for your company.  

Chart of Account Allocations 

You can then use the Chart of Account Allocations form to allocate the expense to different 

departments, based on percentages that you define. You would set up the Chart of Account 

Allocations form to contain these sequences and values for account 99870, unit code 1: 

Allocation Account 99870 

Sequence Basis Type Basis Rate Distribution Account Unit Code 1 

1 Percentage 25.000 51551 100 

2 Percentage 50.000 51551 300 

3 Percentage 25.000 51551 500 

In this rule, sequence 1 distributes 25% of the expense to department 100, using the distribution 

account 51551. Sequence 2 distributes 50% to department 300, and sequence 3 distributes 25% of 

to department 500. 

Journal Entries 

This is the original journal entry for the expense: 
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Account Debit Credit Comment 

99870 10,000.00   Initial entry to 

allocation account 

   2000   10,000.00   

This is the allocation entry that is generated during ledger posting: 

Account Unit Code 1 Debit Credit Comment 

99870     10,000 Offset to initial 

entry 

   51551 100 2,500.00     

   51551 300 5,000.00     

   51551 500 2,500.00     

  

Example: Multi-level Allocations 

On the Chart of Account Allocations form, you set up a multi-level allocation when you specify an 

account number with an Allocation account type in the Distribution Account field.  

NOTE: Do not structure an allocation to itself, that is, specify the same allocation account in the 

header and in the Distribution Account field. An allocation cannot be infinitely recursive. If you try 

to allocate a portion of an account to itself, an error message is displayed when you post the 

journals. 

First Level 

For example, your company divides rent between manufacturing and operations. You can set up a 

rent allocation account 99000 to distribute the expense.  

In the Chart of Accounts form, set account 99000 as an allocation account.  

On the Chart of Account Allocations form, divide rent between operations and manufacturing as 

shown in this table: 

Allocation Account 99000: 
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Allocation 

Basis Type 

Allocation 

Basis Amount Account Description Account Type 

Percent 60 60000 Rent - 

Operations 

Regular 

Percent 40 98000 Rent - 

Manufacturing 

Allocation 

Second Level 

However, the manufacturing area also wants to divide the rent charged to account 98000 among its 

four departments, based on the percentage of floor space each uses in the manufacturing area.  

To allow for this, in the Chart of Accounts form, set up account 98000 as an allocation account 

type. Then on the Chart of Account Allocations form, you can divide rent among the 

manufacturing departments as follows: 

Allocation Account 98000: 

Allocation 

Basis Type 

Allocation 

Basis Amount Account Description Account Type 

Percent 20 61000 Rent - Grinding Regular 

Percent 10 62000 Rent - 

Manufacturing 

Regular 

Percent 25 63000 Rent - Painting Regular 

Percent 45 64000 Rent - 

Assembly 

Regular 

The rent initially charged to account 99000 then trickles down as shown in this diagram: 
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Journal Entries 

If rent is $10,000.00, then these amounts would be posted for the rent expense: 

 60% Operations $6000.00 

 40% Manufacturing $4000.00 

 20% Grinding $800.00 

 10% Plating $400.00 

 25% Painting $1000.00 

 45% Assembly $1800.00 

Example: Allocating Expenses Using Fixed Amounts and Remainders 

This example shows how fixed amounts and remianders can be used to distribute an expense to 

different accounts. 

Chart of Accounts 

You could set up an allocation account 99870 where unit code 1 is accessible and holds the 

department numbers for your company.  

Chart of Account Allocations 

You can then use the Chart of Account Allocations form to allocate the expense of the electric bill 

by department, based on amounts that you define. You would set up the Chart of Account 

Allocations form to contain these sequences and values for account 99870, unit code 1:  

Allocation Account 99870 
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Sequence Basis 
Type 

Basis 
Rate 

Distribution Account Unit Code 1 

1 Amount 100.00 51551 100 

2 Amount 200.00 51551 300 

3 Remainder 0 51551 500 

In this rule, sequence 1 distributes the first $100 of the expense to department 100, using the 

distribution account 51551. Sequence 2 distributes the next $200 to department 300, and sequence 

3 distributes whatever remains of the expense to department 500. I 

Journal Entries 

This is the original journal entry for the expense: 

Account Debit Credit Comment 

99870 600.00   Initial entry to 

allocation account 

   2000   600.00   

This is the allocation entry that is generated during ledger posting: 

Account Unit Code 1 Debit Credit Comment 

99870     600.00 Offset to initial 

entry 

   51551 100 100.00     

   51551 300 200.00     

   51551 500 300.00     

If the original journal entry was for $500, the first two distributions would be the same, but 

Department 500 would be allocated the remainder of $200. 

If the original journal entry was for $50, Department 100 would be allocated all of the $50 expense.  
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Example: Allocating Expenses with Variable Percentages based on YTD 
Amounts from Statistical Accounts 

Prerequisites 

 The appropriate allocation and statistical accounts must exist in the Chart of Accounts form.  

 Unit code combinations that are assigned to a statistical account must also be assigned to any 

distribution accounts that are associated with the statistical account through a Chart of Accounts 

Allocation sequence.  

Chart of Accounts 

You could set up a statistical account 7777777 in the Chart of Accounts form, where unit code 1 

holds the department numbers for your company.  

You could also set up an allocation account 99870 that has the unit codes assigned the same way 

they are assigned in account 7777777.  

Chart of Accounts Budget and Plan 

In the Chart of Accounts Budget and Plan form, for account 777777, specify a department number 

in the Unit Code 1 field, and then specify a starting number of employees for that department in the 

Actual Change field. Add the same information for the rest of your departments.  

Then use the Actual Change field to keep track of the growth or reduction of people in each 

department from month to month. As the department YTD personnel change each month, the 

department’s percentage of the whole company’s YTD personnel also varies, as shown in this chart:  

Statistical Account 777777  

Unit code 

(department) Period Actual change YTD total 

Percentage of 

all depts 

100 1 50 50 50/100=50% 

100 2 4 54 54/124 = 44% 

100 3 0 54 54/129 = 42%  

100 4 -2 52 52/149 = 35%  

100 5 0 52 52/149 = 35% 

100 6 -10 42 42/159 = 26% 
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Unit code 

(department) Period Actual change YTD total 

Percentage of 

all depts 

200 1 30 30 30/100 = 30% 

200 2 20 50 50/124 = 40% 

200 3 0 50 50/129 = 39% 

200 4 22 72 72/149 = 48% 

200 5 0 72 72/149 = 48% 

200 6 -20 52 52/159 = 33% 

Unit code 

(department) Period Actual change YTD total 

Percentage of 

all depts 

300 1 20 20 20/100 = 20% 

300 2 0 20 20/124 = 16% 

300 3 5 25 25/129 = 19% 

300 4 0 25 25/149 = 17% 

300 5 0 25 25/149 = 17% 

300 6 40 65 65/159 = 41% 

Chart of Account Allocations 

You can then, for example, use the Chart of Account Allocations form to allocate the monthly cost 

of protective clothing, based on the variable percentage of people in each department every month. 

You would set up the Chart of Account Allocations form using values like these:  

Allocation Account 99870 
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Sequence Basis Type 

Basis 

Rate Unit 1 

Allocate by 

Statistical Account 

Statistical 

Account 

1 Percentage 100   Yes 7777777 

In this case, the allocation account would use the current YTD percentages from the statistical 

account to distribute the expense across the departments. In Period 2, the allocation would be like 

this:  

 Dept 100 44%  

 Dept 200 40%  

 Dept 300 16%  

But with some movement of personnel every month, the allocations are automatically changed 

without you having to create new rules. By Period 6, the allocations have changed quite a bit:  

 Dept 100 26%  

 Dept 200 33%  

 Dept 300 41%  

You could use the statistical account values as only part of the allocation rule. For example, you 

might want to allocate the first $75 of each month’s bill to department 400, but divide the rest among 

the other departments. In that case, your Chart of Account Allocations rule would look like this:  

Sequence Basis Type 

Basis 

Rate Unit 1 

Allocate by 

Statistical Account 

Statistical 

Account 

1 Amount $75 400 No   

2 Percentage 100   Yes 7777777 

  

Extended Analysis with Dimensions and Attributes 

Chart of Accounts Object 

Specifying Dimensions and Attributes for G/L Accounts 

If you assign dimensions to accounts, your G/L data becomes multi-dimensional. For example, not 

only can you drill down to detail about an account, but you can also drill across to details about the 

customer or the item involved in a particular A/R transaction posted to that account.  
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To support this, predefined dimensions related to Customer, Item and Vendor information are 

included in the Infor CloudSuite initialized data and can be attached to an account. Each dimension 

has a predefined set of attributes. (Your system administrator can modify or add dimensions and 

attributes, and set up additional joins between database tables, to meet your company’s needs. For 

more information, see Creating Dimensions and Attributes for Extended Data Analysis.)  

Process Overview 

Typically, the process includes these steps: 

1 You tell the system administrator how you want to analyze the Chart of Accounts and posted 

ledger transactions. Be specific about the information you need to see, including any functions or 

calculations.  

For example, for an account related to employees, you might want to see employee-specific 

information. The system administrator can join the employee database table in the dimension, so 

that employee-related fields are made available for your reports. You do not need to see all of 

the fields in the employee table, so unwanted fields can be hidden. You might also want to see 

some fields from other tables. The number of possible joins and dimensions that are applicable 

to an account is unlimited; the predefined data only includes a small sample.  

2 The system administrator finds the appropriate information in the database and builds any 

additional calculations based on that data, creating dimension attributes. For more information, 

see Creating Dimensions and Attributes for Extended Data Analysis. The system administrator 

then makes the attributes available to you through the Chart of Accounts Dimensions and 

Ledger Dimensions forms.   

3 Use the Dimensions tab on the Chart of Accounts form to assign one or more dimensions to 

an account. The same dimension can be added to any or all G/L Accounts. Do one of the 

following: 

 For Ledger object analysis, select a dimension in the Ledger Dimension drop-down list to 

assign it to the account. 

 For Chart of Accounts object analysis, select one or more dimensions in the grid to assign 

them to the account. You can then click the Dimensions button to open the Chart of 

Accounts Dimensions form, where you can perform these actions on the listed dimension 

attributes:  

 View the name and description of the attribute.  

 View the underlying database schema and/or calculation used to produce the output 

data.  

 See if the attribute is hidden in the output and if a mask is used to display the data (for 

example, display a date as MM/DD/YY or DD/MM/YYYY). If you have the appropriate 

permissions, you can modify these options for an attribute.  

 Re-sequence the attribute display order. To do this, change the numbers in the 

Sequence column and click Resequence.  

You can then click the Details button to open the Chart of Accounts Dimension Details 

form, where you can view the actual output data for the dimension and export the grid to 

Excel for further analysis and reporting.  
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Example: Chart of Accounts Dimensions and Attributes 

This diagram shows an example of how the Chart of Accounts object can have multiple dimensions 

and attributes: 
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In the diagram, the example shows the predefined object Chart, which is used for Chart of Accounts 

analysis.  The Chart object has three predefined dimensions. Each of the dimensions have 

predefined attributes that can include fields (properties), or calculated values. For more information 
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about how to use dimensions and attributes with the Chart of Accounts, see Specifying Dimensions 

and Attributes for G/L Accounts. 

The system administrator can create additional dimensions. The number of dimensions for an object 

is unlimited.  The administrator also can create additional attributes.  For more information, see 

Creating Dimensions and Attributes for Extended Data Analysis. 

Note: A maximum of 100 attributes of any data type per dimension can be displayed on certain 

forms. 

Ledger Object 

About Dimension Analysis Attributes 

Dimension analysis attributes for the Ledger dimension object are 15 pre-defined attributes that 

administrators can configure for use on the Journal Entries, Import Journal Entries, and G/L 

Posted Transactions forms. Infor CloudSuite users can then specify values in these analysis 

attributes fields as they enter transactions. The fields may or may not be required, depending on 

how the administrator sets them up. The attributes store values for a specific journal transaction 

based on the transaction account. The values are then transferred to the posted ledger transaction 

and stored in association with the ledger transaction similar to the way documents or notes are 

stored. 

Setup 

There are two methods for configuring the analysis attributes: quick setup using the Ledger 

Dimension Analysis Attributes form and regular setup using the Dimension Attributes and 

Ledger Dimensions forms. Quick setup is best when you do not need to build new tables, create 

table joins, or assign IDO information for the analysis attributes. Regular setup allows for the more 

complex configurations.  

These are the general steps for quick setup:  

1 Administrators gather analysis requirements from the finance department.  

2 Based on requirements, administrators use the Ledger Dimension Analysis Attributes form to 

configure one or more of the 15 available analysis attributes. For each analysis attribute, 

administrators can set properties, specify the attribute value, create a hard-coded values list, and 

assign the attribute to selected Ledger dimensions. See Quick Configuration - Dimension 

Analysis Attributes.  

3 Administrators use the Chart of Accounts form to assign a Ledger dimension to specific 

accounts. The assigned dimension determines which analysis attributes are displayed for use on 

the Journal Entries, Import Journal Entries, and G/L Posted Transactions forms, for related 

journal/ledger transactions. It also determines what dimension attributes are associated with 

ledger transactions. (Both dimension attributes and dimension analysis attributes can be 

assigned to a Ledger dimension.) See Specifying Dimensions and Attributes for G/L Accounts.  

These are the general steps for regular setup:  

1 Administrators gather analysis requirements from the finance department.  
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2 If new tables are needed to meet requirements, administrators use the Dimension Table Joins 

form to define the base table for the Ledger object and to link the appropriate primary and 

secondary tables to the base table.  

3 Administrators use the Dimension Attributes form to configure one or more of the 15 analysis 

attributes. For each analysis attribute, administrators can set properties, specify the attribute 

value or build a value expression, and add domain IDO information or create a hard-coded 

values list. See Creating Dimensions and Attributes for Extended Data Analysis and Regular 

Configuration – Dimension Analysis Attributes for more information.  

4 If new Ledger dimensions are needed before assigning the analysis attributes, administrators 

can use the Ledger Dimensions form to create them.  

5 Administrators use the Ledger Dimensions form to assign attributes, including analysis 

attributes, to selected dimensions.  

6 Administrators use the Chart of Accounts form to assign a Ledger dimension to specific 

accounts.  

Maintenance 

To use and maintain the dimension analysis attributes, these are the general steps:  

1 With analysis attributes already configured, users can enter values for analysis on journal 

transactions:  

a If transactions are to be imported, users must prepare the XML or CSV file and then use the 

Import Journal Entries form. On this form, users can import or copy and paste values for 

the 15 dimension analysis attributes, as defined by the Ledger dimension specified for each 

account. If corrections are needed after values are loaded, users can also modify values on 

this form. For requirements, see Importing Journal Entries from External Sources.  

b On the Journal Entries form, users can specify values for one or more of the analysis 

attributes for journal transactions within system journals, the General journal, and user-

defined journals. Some analysis attributes may be required for the General journal and user-

defined journals before a transaction can be saved, depending on how the administrator has 

configured them. 

NOTE: Dimension analysis attributes are not populated when system journal rows are 

generated, because the system journal rows are generated by Infor CloudSuite core functions. 

Analysis attributes cannot be populated at that time.  

2 Users post journal transactions to the ledger. When a journal is posted to the ledger, all analysis 

attribute values are carried forward, unless the user selects Compress Journal Before Post on 

the Ledger Posting for Journal form. In that case, related dimension analysis attribute values 

are lost.  

3 Users update ledger attribute values using the General Ledger Attributes Update utility. See 

Updating Ledger Dimension Attribute Values. If journals are compressed before posting, 

attributes of related ledger transactions cannot be populated by running this utility. 

4 On the G/L Posted Transactions form, users can view and modify one or more of the analysis 

attribute values in the ledger transactions.   
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Analysis 

The Ledger Dimension Details form is used to view and export the dimension attribute values of 

ledger rows for a specified Ledger dimension. Users can filter ledger rows by transaction date and 

account. Also, users can display the details of a ledger row in addition to just the ledger dimension 

attributes/analysis attributes. 

For more powerful data analysis, you have these options: 

 If Infor BI is installed, you can export ledger transactions to BI, along with all dimension analysis 

attributes. BI users can use cubes to perform their own analysis of this data.  

 If Infor Query & Analysis is installed, you can extract ledger transactions, along with all 

dimension analysis attributes. Data analysis can then be done with Infor Q & A or Microsoft 

Excel.  

Example: Ledger Dimensions and Attributes 

This diagram shows an example of how the Ledger object can have multiple dimensions and 

attributes: 
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In the diagram, the example shows the predefined object Ledger, which is used for Ledger 

transaction analysis. The Ledger object has three predefined dimensions. Each of the dimensions 

have predefined attributes that can include fields (properties) or calculated values, and predefined 

analysis attributes that can be configured for use on journal transaction forms. For more information, 

see About Dimension Analysis Attributes.  
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The system administrator can create additional dimensions. The number of dimensions for an object 

is unlimited. The administrator also can create additional attributes (but not analysis attributes). For 

more information, see Creating Dimensions and Attributes for Extended Data Analysis.  

NOTE: A maximum of 100 attributes of any data type per dimension can be displayed on certain 

forms.  

Quick Configuration - Dimension Analysis Attributes 

Quick configuration can be used to set up a simple Ledger dimension analysis attribute—which does 

not need table joins, domain IDOs, or a complex value expression—and assign it to a new or an 

existing Ledger dimension.  

1 On the Ledger Dimension Analysis Attributes form, click Filter-In-Place and then select a pre-

defined analysis attribute to configure.  

2 Specify this information:  

Value  

Specify the attribute value.  

Description  

Specify a description for the attribute. This description is displayed as the field label on the 

Journal Entries, Import Journal Entries, and G/L Posted Transactions forms. If no 

description is specified here, then the attribute name (AnalysisAttribute01) is displayed on the 

forms.  

Required  

Indicate whether the attribute is required when transactions for the associated account are 

entered. If it is required, then users cannot save a transaction until a value is entered. This 

setting is applicable for entries in the General or user-defined journals.  

NOTE: The Required option does not apply to system journals because they are generated by 

Infor CloudSuite core functions.  

Inline List  

To provide a drop-down list of hard-coded values from which the user can select a value, click 

Add Row and then enter the first value in the list. Repeat for all values to include in the list. See 

Example: Configuring and Applying an Analysis Attribute.  

Apply to Dimensions  

Specify the dimension(s) to which to apply this analysis attribute. Dimensions created on the 

Ledger Dimensions form are listed. 

You can add new dimensions in the grid, and then select the Select check box. This applies the 

attribute, and the Ledger Dimensions form is updated with the dimension and attribute.   

3 Save the record.  

4 On the Chart of Accounts form, select an account and then on the Dimensions tab, select a 

Ledger dimension with the configured analysis attribute. This assigns the dimension to the 
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account. When transactions are entered for this account, the analysis attributes will be included 

for data entry on the journal transaction forms. You can add one Ledger dimension for an 

account. You can also add multiple Chart of Account dimensions for the account if needed.  

Regular Configuration - Dimension Analysis Attributes 

Regular configuration must be used to set up a Ledger dimension analysis attribute that needs table 

joins or domain IDOs or for which you must build a value expression.  

1 Optionally, use the Dimension Table Joins form to prepare tables for the Ledger object. See 

Creating Dimensions and Attributes for Extended Data Analysis.  

2 On the Dimension Attributes form, specify Ledger in the Object Name field and then click Filter-

In-Place. Select a pre-defined analysis attribute to configure.  

3 Specify this information:  

Description  

Next to the attribute name, specify a description for the attribute. This description is displayed as 

the field label on the Journal Entries, Import Journal Entries, and G/L Posted Transactions forms. 

If no description is specified here, the attribute name (AnalysisAttribute01) is displayed on the 

forms.  

Value  

Specify the attribute value. You can type directly in the Value text box or use the right pane to 

build the value expression. See Creating Dimensions and Attributes for Extended Data Analysis.  

Masking  

For numeric or date fields, you can specify an appropriate mask here. For example, a date field 

might be masked as ##/##/##.  

Hidden  

Optionally, to hide the selected attribute in the analysis results, select this option.  

Required  

Indicate whether the attribute is required when transactions for the associated account are 

entered. If it is required, then users cannot save a transaction until a value is entered. This 

setting is applicable for entries in the General or user-defined journals.  

NOTE: The Required option does not apply to system journals because they are generated by 

Infor CloudSuite core functions.  

Domain IDO  

If the property to be used for the attribute is a foreign key, you can specify the domain IDO of the 

property; that is, the other IDO where the property is defined.    

Domain Property  

Specify the domain IDO property to be used for the attribute.  

Domain List Property  
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Specify the property that will contain a value to display along with the Domain Property value. 

For example, Description with Item.  

Inline List  

To provide a drop-down list of hard-coded values from which the user can select a value, click 

Add Row and then enter the first value in the list. Repeat for all values to include in the list. See 

Example: Configuring and Applying an Analysis Attribute. This option can be used only if you do 

not specify domain IDO information.  

4 Save the record.  

5 On the Ledger Dimensions form, create a new dimension or select an existing dimension and 

then in the grid, add the configured analysis attribute. You can modify Masking, Hidden, and 

Required settings for the attribute if necessary. You can add up to 15 analysis attributes for the 

dimension. You can also add other Ledger attributes if needed. If you add more than one 

attribute, you can update the sequence. Change the sequence numbers and then click 

Resequence.  

6 On the Chart of Accounts form, select an account and then on the Dimensions tab, select a 

Ledger dimension with the configured analysis attribute. This assigns the dimension to the 

account, so when transactions are entered for this account, the analysis attribute fields are 

included for data entry on the journal transaction forms. You can add one Ledger dimension for 

an account. You can also add multiple Chart of Account dimensions for the account if needed.   

Example: Configuring and Applying an Analysis Attribute 

This example shows creation of the Cash dimension and the Expense Type dimension attribute for 

the Ledger object, with initialized dimension attributes for Customer Number and Vendor Number. 

The Cash dimension is bound to Account 10000.  

1 On the Ledger Dimension Analysis Attributes form, filter and select AnalysisAttribute01. In the 

Value list, select Customer Number.  

2 In the Apply to Dimensions grid, specify Cash in the Dimension Name and Description 

columns and click the Select field. Click Save.  

3 Select AnalysisAttribute02. In the Value list, select Vendor Number. In the Apply to 

Dimensions grid, click the Select field for Cash. Click Save.  

4 Select AnalysisAttribute04. Leave the Value field empty. In the Description field, specify 

Expense Type. In the Inline List grid, specify three Value/Description entries: Traffic 

Fee/Traffic Fee Expense, Meal Fee/Meal Fee Expense, and Lodging Fee/Lodging Fee Expense. 

In the Apply to Dimensions grid, click the Select field for Cash. Click Save.  

5 On the Chart of Accounts form, filter and select Account 10000. On the Dimensions tab, in the 

Ledger Dimension field, select Cash. Click Save.  

6 On the Journal Entries form:  

a Filter on the General journal.  

b In the grid, add a new row.  

c In Account, select 10000 and in Credit, specify 10.00.  
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d On the Dimensions tab, see that the three defined analysis attributes are enabled. In 

Expense Type, select Meal Fee.  

e Add another new row to balance the journal and then click Save.  

f Add another new row.  

g In Account, select 10000 and in Credit, specify 1000.00.  

h On the Dimensions tab, in Customer Number, specify 1. 

i Add another new transaction row to make an advanced payment to balance the journal and 

then click Save.  

Updating Ledger Dimension Attribute Values 

After journal transactions are posted to the ledger, the General Ledger Attributes Update form is 

used to update dimension attribute values for ledger transactions. You can choose to include 

analysis attribute values in the update. You can also choose to overwrite existing data, so stored 

attribute values are updated, if necessary. 

Normally, the General Ledger Attributes Update utility is run as a background task; however, if you 

make an attribute change, for example to a company name, you can run the utility manually.  

Also, the G/L Posted Transactions form can be used to update just dimension analysis attribute 

values.   

Modifying Dimension Analysis Attributes 

After dimension analysis attributes have been configured, administrators can modify them on the 

Ledger Dimension Analysis Attributes, Dimension Attributes, or Ledger Dimensions forms. If 

there are existing journal or ledger transactions with associated analysis attribute values, this data is 

not removed or changed when dimension analysis attributes are reconfigured.    

Also, when you delete a value from the Inline List of an analysis attribute, and if the value has been 

used by a ledger transaction row, you are prompted to confirm your action.  

In either case, stored data is changed only if you run the General Ledger Attributes Update utility 

with Update Analysis Attributes and Overwrite Existing Data selected. 
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Multiple Financial Sets of Books (Multi-FSB) 

Multiple Financial Sets of Books Overview 

Infor CloudSuite provides Multi-Financial Sets of Books (FSB) functionality for businesses that 

require reporting for one or more ledgers in addition to the General Ledger. Each new ledger can 

contain any combination of a fiscal calendar, chart of accounts, and currency that are different from 

those used for the standard General Ledger. Each combination creates a separate financial set of 

books, and you can set up as many as you need.  

A setting on the General Parameters form is used to enable multi-FSB functionality. With this option 

selected, you can define and activate multiple financial sets of books using the Infor CloudSuite 

multi-FSB forms. Many of the forms function similarly to the standard General Ledger forms.  

This table lists all Multi-FSB forms and the related standard GL forms, if applicable:  

Multi-FSB Forms Related Standard General Ledger Forms 

Multi-FSB Accounting Periods Accounting Periods 

Multi-FSB Charts N/A 

Multi-FSB Chart of Accounts Chart of Accounts 

Multi-Financial Sets of Books N/A 

Multi-FSB Chart of Accounts Budget and Plan Chart of Accounts Budget and Plan 

Multi-FSB Journal Entries Journal Entries 

Multi-FSB Ledger Posting for Journal Ledger Posting for Journal 

Multi-FSB Copy Balances to Budgets Copy Balances to Budgets 

Multi-FSB Copy Chart of Accounts N/A 

Multi-FSB Chart of Accounts Mapping Report N/A 
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Multi-FSB General Ledger General Ledger 

Multi-FSB General Ledger Check Information 

Report 

General Ledger Check Information Report 

Multi-FSB General Ledger Transaction Report General Ledger Transaction Report 

Multi-FSB General Ledger Worksheet Report General Ledger Worksheet Report 

Multi-FSB Journal Account Summary Journal Account Summary 

Multi-FSB Journal Transaction Report Journal Transaction Report 

Multi-FSB Trial Balance Trial Balance 

Compress Multi-FSB Ledger Transactions Compress General Ledger Transactions 

Multi-FSB Rebalance Ledger Period Totals Rebalance Ledger Period Totals 

Multi-FSB Refresh Account/Unit Combinations Refresh Account/Unit Combinations 

Multi-FSB Year End Closing Journal Entries Year End Closing Journal Entries 

Multi-FSB Accounting Periods Query Accounting Periods Query 

Multi-FSB Charts Query N/A 

Multi-FSB Chart of Accounts Query Chart of Accounts Query 

Multi-Financial Sets of Books Query  N/A 

Multi-FSB Chart of Accounts Budget and Plan 

Query  

Chart of Accounts Budget and Plan Query 

Multi-FSB Journal Entries Query  Journal Entries Query 

Multi-FSB Accounting Periods 

Multi-FSB accounting periods for each new fiscal calendar must be created using the Multi-FSB 

Accounting Periods form and given a name that differentiates them from all other accounting 
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periods. They must be maintained manually, because period changes and closing are not performed 

by the system, even if the settings match the standard GL accounting periods.  

Multi-FSB Chart of Accounts 

After creating a unique multi-FSB chart of accounts record using the Multi-FSB Charts form, 

accounts typically are added automatically using the Multi-FSB Copy Chart of Accounts form. The 

accounts also can be added manually using the Multi-FSB Chart of Accounts form.  

Accounts added to a multi-FSB chart of accounts can exist only on that chart; they cannot be used 

on other multi-FSB charts. However, the same account numbers can be used on other charts of 

accounts. They are treated as different accounts for each chart.  

Each multi-FSB account can be mapped to one or more accounts in the standard GL Chart of 

Accounts, but they are not required to be mapped. All GL accounts must be mapped to a multi-FSB 

account, except for analytical accounts, which are not mapped. Also, a GL account can be mapped 

to only one account per multi-FSB chart of accounts. You can specify unit codes for multi-FSB 

accounts or inherit them from the mapped GL accounts. A utility can be run to verify that all GL 

accounts are mapped correctly for a selected multi-FSB chart of accounts. The Multi-FSB Chart of 

Accounts Mapping Report is provided for reviewing this mapping.  

This example shows how different accounts can be mapped for multi-FSB charts of accounts:  

The Multi-FSB Chart of Accounts Budget and Plan form also is provided so you can enter budget, 

plan, and actual amounts for each individual account, accounting period, and fiscal year. 
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Multi-FSB Ledger 

The Multi-Financial Sets of Books form is used to name, set up, and activate the combination of a 

multi-FSB fiscal calendar, multi-FSB chart of accounts, and a new or selected currency. If you want 

to use the same chart of accounts or fiscal calendar as that in the standard General Ledger for one 

of your multi-FSBs, you must create that COA or fiscal calendar a second time using the multi-FSB 

forms.  

After activation, the multi-FSB ledger is ready to receive transactions. As records are posted to the 

General Ledger, they are also posted to all active multi-FSB ledgers. Multi-FSB ledgers also can 

receive records that you post using the Multi-FSB Journal Entries form.  

Multi-FSB ledger records use the multi-FSB currency and are recorded to multi-FSB accounts based 

on the mapping of the standard GL accounts.  

Journal entries can be created for any active multi-FSB, but transactions can be entered only into 

the General Journal. No multi-FSB transactions are posted to the General Ledger or to other multi-

FSB ledgers.  

Year-End Journal Entries 

When the General Ledger set of books is closed for the year, it gets posted to all active multi-FSBs 

based on account mappings. However, these transactions are not shown on the multi-FSB ledger 

reports. Also, multi-FSBs are not closed when the GL set of books is closed, even if they have the 

same fiscal calendar. Each active multi-FSB must be closed separately using the Multi-FSB Year 

End Closing Journal Entries utility. The transactions must be posted to complete the year-end 

procedures. Year-end transactions or adjustments made in a multi-FSB are not recorded in any 

other financial set of books. 

Different Fiscal Year Ends 

All year-end transactions are recorded into the accounting period based on the date of the 

transaction. Therefore, as transactions are copied from the GL financial set of books to all active 

multi-FSBs, each transaction is recorded in the accounting period as assigned to its financial set of 

books. This way, a transaction can be recorded into different periods, and even different fiscal years, 

based on the accounting periods of each financial set of books. 

Reporting 

You can run reports on the multi-FSB ledgers to show transactions:  

 In the multi-FSB accounts  

 In the multi-FSB currency  

 In the multi-FSB accounting period  



Multiple Financial Sets of Books (Multi-FSB) 

245 

General Ledger and Trial Balance reports are available, but multi-FSB transactions are not available 

on the financial statements. Ledger entries with the reference of Income Summary or Year Closing 

can be reviewed on the multi-FSB GL reports.  

Limitations 

Infor CloudSuite multi-FSB functionality does not include the following: 

 Mapping of transactions from a multi-FSB with the standard GL FSB, including year-end 

transactions. 

 Mapping of a single GL account to multiple accounts in the same multi-FSB chart of accounts. 

 Multi-FSB support in multi-site/entity configurations.  

 Period sorting for multi-FSBs. Standard GL sorting is used.  

 Ability to copy multi-FSB chart budgets and plans from the standard GL. They must be entered 

manually for the multi-FSB. 

 Ability to create different multi-FSB unit codes. Multi-FSB accounts receive the same unit codes 

as the standard GL accounts they are mapped to. If a multi-FSB account is not mapped to a GL 

account, then unit codes can be specified for the multi-FSB. The unit codes values that can be 

selected for a multi-FSB account come from the Unit Code (number) forms.  

Setting Up Multiple Financial Sets of Books 

To set up a multi-FSB, follow these steps: 

1 On the General Parameters form, select Multiple Financial Sets of Books. 

2 If this set of books will use a currency that is not already set up in Infor CloudSuite, use the 

Currency Codes form to add the new currency. 

3 On the Multi-FSB Accounting Periods form, create a fiscal calendar for the new set of books.  

4 On the Multi-FSB Charts form, specify a name and description for the chart of accounts for this 

set of books.  

5 Save the record. 

6 Add accounts to the new chart of accounts, either automatically or manually. 

a To add accounts automatically, click Copy COA on the Multi-FSB Charts form. This opens 

the Multi-FSB Copy Chart of Accounts form so you can copy the standard GL chart of 

accounts for the new set of books.  

b To add accounts manually, use the Multi-FSB Chart of Accounts form. See Maintaining the 

Multi-FSB Chart of Accounts.  

7 On the Multi-FSB Charts form, click Confirm Mapping to run a check on account mapping. A 

message is displayed to let you know if there are any problems. If successful, the Accounts 

Mapped option is selected automatically. 
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8 On the Multi-Financial Sets of Books form, define the new set of books with this information: 

 FSB: Specify a name and description for the new set of books. 

 FSB COA: Select the chart of accounts created above. 

 Fiscal Calendar: Select the fiscal calendar created above. 

 Currency: Specify the currency to use for this set of books. 

 CTA Account: Select the account to use for recording debits and credits that may occur to 

rebalance the Multi-FSB ledger due to currency conversion during general ledger posting. 

This is necessary only if the selected Currency is not Domestic. 

9 Save the record. 

10 If you need beginning balances for the multi-FSB ledger, use the Multi-FSB Journal Entries 

form to enter them manually and then post them. 

11 To activate the new financial set of books for use, select Active on the Multi-Financial Sets of 

Books form. Once active, the multi-FSB receives all posted GL ledger transactions, regardless 

of the date.  

12 If you select Compress Ledger, ledger records for this set of books are compressed 

automatically by date, account, and unit code. For additional flexibility, you can use the 

Compress Multi-FSB Ledger Transactions utility to set different compression options and 

process the compression. 

Maintaining the Multi-FSB Chart of Accounts 

Use the Multi-FSB Chart of Accounts form to manually set up and maintain mapping of multi-FSB 

accounts with accounts from the standard GL Chart of Accounts.  

NOTE: You can initially map multi-FSB accounts automatically by copying the standard GL Chart of 

Accounts using the Copy COA button on the Multi-FSB Charts form. Then use this form to add, 

remove, or change account mapping.  

To map an account:  

1 Open the Multi-FSB Chart of Accounts form.  

2 Select Actions > New.  

3 In the FSB COA field, select a multi-FSB chart of accounts to work with. 

4 In the FSB Account field, specify an identifier for the multi-FSB account.  

5 In the field to the right of the FSB Account field, specify a description of the account for 

reference.  

6 In the FSB Account Type field, select the account type.  

7 Optionally, you can specify a FSB Account Class for financial reporting.  

8 Do one of the following:  
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 To map to an existing account from the standard GL Chart of Accounts, select the account 

on the GL Accounts tab. 

 For an unmapped account, specify unit code requirements for the account. In each of the 

Unit Code 1-4 fields, select one of these options: 

 No Access: The reporting unit field will not be accessible for this account. The system 

also disables the corresponding Unit Code tab on the form.  

 Accessible: The reporting unit field will be accessible for this account.  

 Required: The reporting unit field is required for this account.  

On the associated Unit Code tabs, you can add or remove unit codes. 

9   To save the account mapping, select Actions > Save. 

Deleting Multi-FSB Records 

You can use the Delete button on the toolbar to delete a selected multi-FSB record on the Multi-

Financial Sets of Books form. When a multi-FSB record is deleted, all FSB ledger records and 

associated data are deleted as well.  

About the Multi-FSB Year-End Closing Process 

The Multi-FSB Year-End Closing Journal Entries form generates multi-FSB fiscal year-end journal 

transactions to close out all revenue and expense accounts into an income summary account. A 

journal transaction that shows the net income, or sum of all year-end transactions, is also created. 

The transactions are generated to the journal only and not posted to the ledger. The transactions 

may be further modified and must be posted to complete the year-end procedures.  

Generally you perform the multi-FSB year-end closing at the end of the company's FSB fiscal year, 

but it can be performed at any time by specifying the fiscal start and end date without regard to the 

defined accounting periods. The fiscal calendar and subsequent periods are defined on the Multi-

FSB Accounting Periods form.  

Before running the multi-FSB year-end closing function, you should verify that all outstanding journal 

transactions for the fiscal calendar are entered and posted to the ledger. This function generates 

journal transactions that set all revenue and expense account balances to zero. If all journal 

transactions are not posted to the ledger, the transactions created may not actually set all revenue 

and expense account balances to zero.  

Only one user at a time can have the ledger open. Therefore, if someone is running a financial report 

or performing year-end closing, this function cannot be performed until the original process is 

complete.  
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Closing the Year for Multi-FSB General Ledger 

CAUTION: This procedure creates debit and credit entries to close out all revenue and expense 

accounts for the date range specified. These entries are placed in the Multi-FSB General Journal. 

You must then post the Multi-FSB General Journal to the Multi-FSB General Ledger. 

NOTE: This procedure should be run only after all entries made to the fiscal year are posted. Also, to 

close the journal, it must be writable. 

To close the year for the Multi-FSB General Ledger: 

1 Open the Multi-FSB Year End Closing Journal Entries form. 

2 Specify this information:  

Fiscal Year 

Select the fiscal year for which to close a financial set of books. The default value is the current 

fiscal year from General Parameters. 

FSB 

Select the financial set of books to close. Only those FSBs active for the specified fiscal year are 

shown. 

Fiscal Year Start Date 

The default value for this field is the specified fiscal year start date, taken from the Mulit-FSB 

Accounting Periods form. Optionally, you can change this date. This generates year-end 

transactions for transactions occurring on or after this date.  

Fiscal Year End Date 

The default value for this field is the specified Fiscal Year end date, taken from the Mulit-FSB 

Accounting Periods form. Optionally, you can change this date. This generates year end 

transactions for transactions occurring up to this date.  

Income Summary Account 

Select the "Retained Earnings" account for the year-end closing transaction. The account's type 

must be set up in the Multi-FSB Chart of Accounts as Owner's Equity. 

Delete Current Journal Entries 

To delete all journal entries for this journal before generating the year-end transactions, select 

this check box. This refers to the existing entries in the Multi-FSB General Journal only. Do not 

change any of the references generated by the system on the entries in the Multi-FSB General 

Journal. If this check box is selected, all journal transactions along with any associated text are 

deleted when the transactions are generated, prior to creating the closing transactions. 

Unit Code Detail 

To clear unit code balances in the revenue and expense accounts, leave the Unit Code Detail 

check box selected. If this check box is cleared, balances are left in the unit codes and carried 

forward. 

3 Click Process. 
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NOTE: You can close multi-FSB fiscal years an unlimited number of times. If you have closed the 

fiscal year and need to enter transactions for that year, you can post the transactions and then run 

the year-end close again. 

Example: G/L Year End Closing 

Suppose the following entries were the financial activity for a company for the fiscal year of 

01/01/2013 to 12/31/2013 using the following accounts: 

Account     Description 

10000 Assets 

20000 Liabilities 

30000 Owner's equity 

40000 Revenue 

50000 Expense 

Example of Ending Balances (12/31/2013) 

Account     Balance 

10000 100,000.00 

20000 (64,500.00) 

30000 (20,000.00) 

40000 (23,500.00) 

50000 8,000.00 

Example of Year End Entries 

Account     Balance 

30000 15,500.00 
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40000 23,500.00 

50000 (8,000.00) 

Example of Ending Balance (12/31/2013) after Year End Balance 

Account     Balance 

10000 100,000.00 

20000 (64,500.00) 

30000 (35,500.00) 

40000 00 

50000 00 

NOTE: No entries were generated for Accounts Receivable of Cash, because they are asset 

accounts. Only revenue and expense accounts are closed out. 
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Unit Codes 

About Unit Code Reporting 

These are the basic assumptions of unit code reporting throughout the system. 

Account Structure 

The account structure in the system is: 

 Account - Main account 

 Unit Code 1 is predefined as tied to the department code. Payroll and Shop Floor Control use 

this field when reporting hours. If Unit Code 1 is defined, it must be tied to a valid department 

number. To make this connection on the Departments form, fill in the Unit Code 1 value for 

each department you want. 

 Unit Code 2 represents the product code, and, if defined, must be tied to a valid product code. 

As inventory related transactions are produced, the transactions are automatically updated with 

the value that appears in Unit Code 2 on the Product Codes form for that item. 

 Unit Code 3 and Unit Code 4 are user-defined. They can carry any valid unit code that has 

been defined on the appropriate Unit Code form. For example, you could use them for work 

centers or for a cost center that is grouped differently than what is defined as Department in Unit 

Code 1. You could use these for reporting on different currency codes, vendor statistics or 

customer statistics.  

Account is part of the account template, unit codes are not. Any unit code can be tied to a main 

account, provided the Chart of Accounts setup allows that chart record access to that unit code. 

You can use the same unit code for more than one reporting unit, although the codes would not 

necessarily mean the same thing. For example, a unit code value of ABCD could be set up for both 

Unit Code 3 and Unit Code 4, because each unit code is a separate table. 

Chart of Accounts 

On the Chart of Accounts, you can set each unit code with one of these attributes: 

 Not Accessible: The reporting unit field is not accessible for this account in the application. If 

this option is selected, the unit code will not be posted. The corresponding Unit Code tab on the 

Chart of Accounts form is disabled. 

 Accessible: The reporting unit field is accessible for this account everywhere in the application If 

this option is selected, you can specify that unit code for the associated account, but it is not 

mandatory. 
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 Required: The reporting unit field is required for this account everywhere in the system. If this 

option is selected, you are required to enter the unit code for the associated account. An error 

occurs if you leave the unit code blank when one is required. If no unit code is entered, posting 

will fail. 

Areas of the system that provide default account numbers also allow the entry of reporting units to 

be used as defaults. In places where the default account numbers can be overwritten, so can the 

reporting units. 

Inventory Transactions 

For transactions involving inventory distribution accounts, the system pulls unit codes from Item 

Stockroom Locations. 

Job Transactions 

WIP transactions pull Acct, Unit Code 1, Unit Code 3, and Unit Code 4 from the Product Codes - 

WIP tab. Unit Code 2 comes from the Product Codes - General tab. 

For example, a job is created for Item A. Item B is the material issued to that job. Unit Codes 1, 3 

and 4 are defined on the Product Codes - WIP tab. For a job material issue, the following accounts 

and unit codes are used. 

  Acct UC 1 UC 2 UC 3 UC 4 

(Debits) 

from Job 

Header WIP 

Accounts 

(Cost Detail 

          

WIP 

Material 

XXXX XXX XXX XXX XXX 

WIP Labor XXXX XXX XXX XXX XXX 

WIP Fixed 

Overhead 

XXXX XXX XXX XXX XXX 

WIP 

Variable 

Overhead 

XXXX XXX XXX XXX XXX 

WIP Outside XXXX XXX XXX XXX XXX 
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Services 

Credits 

(from Item 

Stockroom 

Locations) 

          

Inventory 

Material 

XXXX   XXX     

Inventory 

Labor 

XXXX   XXX     

Inventory 

Fixed 

Overhead 

XXXX   XXX     

Inventory 

Variable 

Overhead 

XXXX   XXX     

Inventory 

Outside 

Services 

XXXX   XXX     

  

Labor Posting 

  Acct UC1 UC2 UC3 UC4 

(Debits) From Job Header WIP 

Accounts (Cost Detail) 

          

WIP Material XXXX XXX XXX XXX XXX 

WIP Labor XXXX XXX XXX XXX XXX 

WIP Fixed Overhead XXXX XXX XXX XXX XXX 

WIP Variable Overhead XXXX XXX XXX XXX XXX 
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WIP Outside Services XXXX XXX XXX XXX XXX 

(Credits) From Work Center of 

Operation (Dept. of WC) Departments 

record 

          

Direct Labor Expense XXXX XXX XXX XXX XXX 

Fixed Labor Overhead Applied XXXX XXX XXX XXX XXX 

Variable Labor Applied XXXX XXX XXX XXX XXX 

In standard costing, variance transactions use Unit Code 2 from the Product Codes - General tab. 

For labor rate variance, it also uses Unit Code 1 from the Departments form. Other unit codes are 

pulled from the Product Codes - Variance tab. 

CO Shipping Transactions 

Customer order unit codes can be handled in one of two ways. On the Customers form there is an 

End User Type field. End User Type accounts can then be set up on the End User Types form. 

The accounts defined here are Sales, Sales Discount, Accounts Receivable, Cost of Goods Sold 

Material, Cost of Goods Sold Labor, Cost of Goods Sold Fixed Overhead, Cost of Goods Sold 

Variable Overhead, and Cost of Goods Sold Outside. If End User Type is defined on the Customers 

form, that type is pulled into the order and the default values for Acct, Unit Code 1, Unit Code 2, Unit 

Code 3, and Unit Code 4 are used from the End User Types form. If there is no Unit Code 2 on the 

End User Type form, it is pulled from the Product Codes - General tab. 

If End User Type is not used, the system pulls the Acct, Unit Code 1, Unit Code 2, Unit Code 3, and 

Unit Code 4 from the Sales/COGS tab on the Distribution Accounts form for all accounts listed 

above except Accounts Receivable. If there is no Unit Code 2 on the Sales/COGS tab of the 

Distribution Accounts form, it is pulled from the Product Codes - General tab. Accounts 

Receivable is pulled from the Accounts Receivable Parameters form and uses all Acct, and all 

Unit Codes. 

NOTE: See Where Unit Codes Come From for a table illustrating how unit codes are applied by 

activity performed. 

Where Unit Codes Come From 

Use this table to see where unit codes come from when performing certain activities. For example, in 

the table you see that when performing an RMA Return Transaction with No End User Type, the 

Credit Cost Of Goods Sold unit codes come from Product Code Distribution Accounts. 
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Activity Account Where unit codes come from 

Customer Payments DR Cash Bank Rec of Bank Code 

  CR Accounts Receivable Unit Code designated on 

artran record for type 

"Invoice" 

  CR Unit Code designated on A/R 

Payment Distributions form 

for type "Open Credit", 

"Finance Charge" and "Non-

A/R". The Unit Code defaults 

from Accounts Receivable 

Parameters form, but can be 

overwritten at A/R Payment 

Distribution level. 

Customer Shipment - No End 

User Type 

CR Inv. Item Stockroom Locations 

  DR COGS Product Code Distribution 

Accounts 

Customer Shipment - With 

End User Type 

CR Inv. Item Stockroom Locations 

  DR COGS End User Type, then Product 

Codes (Unit Code 2 only) 

Cycle Count and Physical 

Inventory 

DR or CR Inv. Item Stockroom Locations 

  DR or CR Inv. Adj. Product Codes Misc, tab then 

Product Codes General Tab 

(Unit Code 2 only) 

Invoicing (with End User 

Type) 

DR Accounts Payable Unit Code 1,3,4 from End 

User Type, Unit Code 2 from 

Product Code General 

  CR Sales Unit Code 1,3,4 from End 

User Types form, and Unit 
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Code 2 from General tab on 

Product Codes form 

Invoicing (without End User 

Type) 

DR Accounts Receivable Unit Code from Accounts 

Receivable Parameters form, 

and Unit Code 2 from 

Product Codes form 

  CR Sales Unit Code from Product Code 

Distribution Account, then 

General tab on Product 

Codes form 

JIT Transactions DR Inv. Item Stockroom Locations 

  CR WIP Work Center WIP Accts, then 

Product Codes (Unit Code 2 

only) 

Job Close DR or CR WIP Job Orders 

  DR or CR Inv. Adj. Or 

Routing Variance 

Product Codes Variance tab 

for Standard Cost item or 

Product Codes Misc tab for 

Actual Cost item, then 

Product Codes General tab 

(Unit Code 2 only) 

Job Labor Transactions DR WIP Job Orders Cost Detail tab 

  CR Exp. Unit Code 1 from Dept. UC 

field, all other codes from 

Dept. DL & OH applied 

defaults, then Product Codes 

(Unit Code 2 only) 

Job Material Issues DR WIP Job Orders 

  CR Inv. Item Stockroom Locations 

Job Move to Inventory 

(includes Job Receipt 

DR Inv. Item Stockroom Locations 
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  CR WIP Job Orders 

Manual LIFO/FIFO 

Adjustment Utility 

DR or CR Inv. Item Stockroom Locations 

  DR or CR Inv. Adj. Product Codes Misc, tab then 

Product Codes General Tab 

(Unit Code 2 only) 

Miscellaneous Issue CR Inv. Item Stockroom Locations 

  DR Misc. Product Code Misc. tab 

Inventory Adjustment 

account 

Miscellaneous Receipt DR Inv. Item Stockroom Locations for 

existing locations; Inventory 

Distribution Accounts for new 

locations 

  CR Misc. Product Code Misc. tab 

Inventory Adjustment 

account 

Payroll Transactions DR Labor Exp. Wage account on Employee 

General, then Departments 

(Unit Code 1 only), then 

Payroll Parameters for Unit 

Codes 2, 3, and 4 

  DR All Other Exp. Unit Code 1 from Employee 

Dept. UC Field, all other 

codes from Payroll 

Parameters and PR Tax 

Tables 

  CR Tax Payable Unit Code 1 from Employee 

Dept. UC Field, all other 

codes from Payroll 

Parameters and PR Tax 

Tables 

  CR Cash Unit Code 1 from Employee 
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Dept. UC Field, all other 

codes from Payroll 

Parameters and PR Tax 

Tables 

Project Labor Transactions DR Proj Labor All unit codes from Product 

Codes form, Project tab 

  DR Proj Overhead All unit codes from Product 

Codes form, Project tab 

  DR Proj G & A All unit codes from Product 

Codes form, Project tab 

  CR Labor Exp.  Unit Code 1 from Employee 

Dept., all other codes from the 

Accounts on the Employee 

Dept. 

  CR Applied Ovhd Unit Code 1 from Employee 

Dept., all other codes from 

the Accounts on the 

Employee Dept. 

  CR Applied G & A Unit Code 1 from Employee 

Dept., all other codes from 

the Accounts on the 

Employee Dept. 

Project Resource 

Transactions 

DR WIP Unit Code on Project Header 

(Defaults from Product Code 

associated with Project) 

  CR Inv. Unit Code from Stockroom 

Location of item being issued 

  CR Unit Code entered during 

Resource Transaction for 

"Non-Item Master" issues 

PS Complete Transactions DR Inv. Item Stockroom Locations 

  CR WIP Work Center WIP Accts, then 
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Product Codes (Unit Code 2 

only) 

PS Scrap Transactions DR Scrap Exp. Product Codes Misc tab, then 

Product Codes General Tab 

(Unit Code 2 only) 

  CR WIP Work Center WIP Accts, then 

Product Codes (Unit Code 2 

only) 

Purchase Order Receiving DR Inv. Item Stockroom Locations 

  CR Vouchers Payable Purchasing Parameters, then 

Product Codes (Unit Code 2 

only) 

Purchase Order Variance DR or CR Vouchers Payable Purchasing Parameters, then 

Product Codes (Unit Code 2 

only) 

  DR or CR Inv. Adj. or PPV Product Codes Variance tab 

for Standard Cost item or 

Product Codes Misc tab for 

Actual Cost item, then 

Product Codes General tab 

(Unit Code 2 only) 

Quantity Adjustment 

Transactions 

DR or CR Inv. Item Stockroom Locations 

  DR or CR Inv Adj Product Codes Misc, tab then 

Product Codes General Tab 

(Unit Code 2 only) 

RMA Return Transaction - 

No End User Type 

DR Inv. Item Stockroom Locations 

  CR COGS Product Code Distribution 

Accounts 

RMA Return Transaction - 

With End User Type 

DR Inv. Item Stockroom Locations 



Infor CloudSuite Industrial Financials User Guide 

260 

  CR COGS End User Type, then Product 

Codes (Unit Code 2 only) 

Transfer Orders (Single Site) 

Quantity Move 

DR To Loc Transit account, then Item 

Stockroom Locations for 

existing locations; Inventory 

Distribution Accounts for new 

locations, then Product 

Codes (Unit Code 2 only) 

  CR From Loc Transit account, then Item 

Stockroom Locations for 

existing locations; Inventory 

Distribution Accounts for new 

locations, then Product 

Codes (Unit Code 2 only) 

Transfer Orders (Multi-Site, 

Inter-Entity), MS Quantity 

Move 

(From Site) CR Inv. Item Stockroom Locations 

  (From Site) DR I/E A/R Intersite Parameters, then 

Product Codes (Unit Code 2 

only) 

  (From Site) DR I/E COGS Intersite Parameters, then 

Product Codes (Unit Code 2 

only) 

  (From Site) CR I/E Sales Intersite Parameters, then 

Product Codes (Unit Code 2 

only) 

  (From Site) CR I/E Profit Intersite Parameters, then 

Product Codes (Unit Code 2 

only) 

  (To Site) DR Inv. Item Stockroom Locations 

  (To Site) CR I/E A/P Intersite Parameters, then 

Product Codes (Unit Code 2 

only) 
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Transfer Orders (Multi-Site, 

Intra Entity 

(From Site) CR Inv. Item Stockroom Locations 

  (From Site) DR I/E Clear 

Ship 

Intersite Parameters, then 

Product Codes (Unit Code 2 

only) 

  (To Site) DR Inv. Item Stockroom Locations 

  (To Site) CR I/E A/P Intersite Parameters, then 

Product Codes (Unit Code 2 

only) 

Vendor Payments CR Cash Bank Rec of Bank Code 

  DR Accounts Payable Unit Code designated on 

aptrxp record for type 

"Voucher" 

  DR Unit Code designated on A/P 

Payment Distributions form 

for type "Open Payment", 

"Commission" and "Non-

A/P". The Unit Code defaults 

from Accounts Payable 

Parmeters form, but can be 

overwriteen at A/P Payment 

Distribution level. 

Voucher (with Vendor 

Category) 

DR Vouchers Payable Purchasing Parameters form, 

then Unit Code 2 from 

General tab on Product 

Codes form 

  CR Accounts Payable Vendor Categories form 

Voucher (without Vendor 

Category) 

DR Vouchers Payable Purchasing Parameters form, 

then Unit Code 2 from 

General tab on Product 

Codes form 

  CR Accounts Payable Purchasing Parameters form 
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WC Labor Transactions DR WIP Work Center WIP Accts 

  CR Labor Exp. Unit Code 1 from Dept. UC 

field, all other codes from 

Dept. DL & OH applied 

defaults 

WC Material Transactions CR Inv. Item Stockroom Locations 

  DR WIP Work Center WIP Accts, then 

Product Codes (Unit Code 2 

only) 

 

 


